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Introduction

Introduction

Thank you for purchasing an NA-series Programmable Terminal.

This manual contains information that is necessary to use the NA-series Programmable Terminal.
Please read this manual and make sure you understand the functionality and performance of the
NA-series Programmable Terminal before you attempt to use it in a control system.

Keep this manual in a safe place where it will be available for reference during operation.

Intended Audience

This manual is intended for the following personnel, who must also have knowledge of electrical sys-
tems (an electrical engineer or the equivalent).

» Personnel in charge of introducing FA systems.

» Personnel in charge of designing FA systems.

» Personnel in charge of installing and maintaining FA systems.
» Personnel in charge of managing FA systems and facilities.

Applicable Products

This manual covers the following products.

* NA-series Programmable Terminals ™’

*1. Unless otherwise specified, the descriptions for the NA5-CICOWOO OO apply to the NAS-OOJUOOOO as
well.
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Relevant Manuals

Relevant Manuals

The basic information required to use an NA-series PT is provided in the following four manuals.
» NA-series Programmable Terminal Hardware User’s Manual (Cat. No. V117)

» NA-series Programmable Terminal Hardware(-V1) User’s Manual (Cat. No. V125)

» NA-series Programmable Terminal Software User’s Manual (Cat. No. V118)

» NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119)

» NA-series Programmable Terminal Soft-NA User’s Manual (Cat. No. V126)

Operations are performed from the Sysmac Studio Automation Software.

Refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for information on the Sys-
mac Studio.

Other manuals are necessary for specific system configurations and applications.

The following manual is also available to walk you through installations and operations up to starting
actual operation using simple examples.

Refer to it as required.
» NA-series Programmable Terminal Startup Guide Manual (Cat. No. V120)
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Manual Structure

Page Structure

and Markings

The following page structure is used in this manual.

Level 2 heading —

Level 3 heading

A step in a procedure —
Indicates a procedure.

Special information —]

Icons indicate precautions,
additional information, or
reference information.

kT i =

- 3-3 Installing NA-series PTs

—— 3-3-1 Installation in a Control Panel

I Installation in a Control Panel

3 Installation and Wiring

The NA-series PT is installed by embedding it in a control panel. Panel Mounting Brackets and a Phillips screwdriver are
required to mount the NA-series PT. The required number of Panel Mounting Brackets are included with the NA-series PT.

= ©

Panel Mounting Bracket  Phillips screwdriver
Use the following installation procedure.

1 Open a hole in which to embed the NA-series PT with the following dimensions and insert the
NA-series PT from the front side of the panel.
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Manual Structure

—— Level 1 heading

Level 2 heading
~ Level 3 heading

Give the current
headings.

— Page tab
Gives the number
of the main section.
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Recommended panel thickness: 1.6 to 6.0 mm

Model

Dimensions

NAS-15WOO00

392 *10 x 268 *10 mm (horizontal x vertical)

NA5-12WwO000

310 *10 x 221 *10 mm (horizontal x vertical)

NAS-owWOO00

261 *10 x 166 *10 mm (horizontal  vertical)

NAS-7WOO00

197 * 050 x 141 *0-5:0 mm (horizontal  vertical)

a Additional Information

You can use an NS-USBEXT-1M USB Relay Cable to extend the USB slave connector on the
back panel of the NA-series PT to the front surface of a control panel. If you use the USB Relay
Cable, open a hole with the following dimensions and install the Cable.

2 Attach the panel mounting brackets from the back of the panel as shown in the following figure.

The number of mounting brackets depends on the size of the NA-series PT, as shown in the following
table. Refer to Bracket Mounting Locations for Different NA-series PT Sizes on page 3-8, below.

Model Number of Panel Mounting Brackets
NA5-15WO000 8 locations
NA5-12wO000 6 locations
NA5-OWOOO0 4 locations
NA5-7WOO0O0 4 locations

Catch the brackets in the mounting holes in the NA-series PT, pull forward lightly, and then use
a Phillips screwdriver to tighten the screws and secure the NA-series PT to the panel, which will
be held between the mounting brackets and the NA-series PT.

Manual name

NA Series Terminal Hardware User's Manual (V117) 3-5

Note This illustration is provided only as a sample. It may not literally appear in this manual.
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Manual Structure

Special Information

Special information in this manual is classified as follows:

Precautions for Safe Use

Precautions on what to do and what not to do to ensure safe usage of the product.

|E| Precautions for Correct Use

Indicates precautions on what to do and what not to do to ensure proper operation and perfor-
mance.

@ Additional Information

Additional information to read as required.

This information is provided to increase understanding or make operation easier.

L~ Version Information

Information on differences in specifications and functionality with different versions is given.
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Sections in this Manual

Sections in this Manual

Introduction to the NA-series
Programmable Terminals

Connecting to HMIs
from External Devices

Basic Sysmac Studio

Operations Other Functions

HMI Configuration

SN\

and Setup Appendices
Creating the HMI nd
Application ex
Objects

Connecting to the HMI

Debugging

Synchronizing Projects

Reusing Objects
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Terms and Conditions Agreement

Terms and Conditions Agreement

Warranty, Limitations of Liability

I Warranties

® Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and workman-
ship for a period of twelve months from the date of sale by Omron (or such other period expressed in
writing by Omron). Omron disclaims all other warranties, express or implied.

® Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, ABOUT
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF
THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED THAT THE
PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses based
on infringement by the Products or otherwise of any intellectual property right.

® Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form originally
shipped with Buyer responsible for labor charges for removal or replacement thereof) the non-com-
plying Product, (ii) repair the non-complying Product, or (iii) repay or credit Buyer an amount equal
to the purchase price of the non-complying Product; provided that in no event shall Omron be
responsible for warranty, repair, indemnity or any other claims or expenses regarding the Products
unless Omron’s analysis confirms that the Products were properly handled, stored, installed and
maintained and not subject to contamination, abuse, misuse or inappropriate modification. Return of
any Products by Buyer must be approved in writing by Omron before shipment. Omron Companies
shall not be liable for the suitability or unsuitability or the results from the use of Products in combi-
nation with any electrical or electronic components, circuits, system assemblies or any other materi-
als or substances or environments. Any advice, recommendations or information given orally or in
writing, are not to be construed as an amendment or addition to the above warranty.

See http://www.omron.com/global/ or contact your Omron representative for published information.

I Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL, OR CON-
SEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN ANY
WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED IN CONTRACT,
WARRANTY, NEGLIGENCE OR STRICT LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the Product on
which liability is asserted.
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Terms and Conditions Agreement

Application Considerations

| suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or regulations
which apply to the combination of the Product in the Buyer’s application or use of the Product. At
Buyer’s request, Omron will provide applicable third party certification documents identifying ratings
and limitations of use which apply to the Product. This information by itself is not sufficient for a com-
plete determination of the suitability of the Product in combination with the end product, machine, sys-
tem, or other application or use. Buyer shall be solely responsible for determining appropriateness of
the particular Product with respect to Buyer’s application, product or system. Buyer shall take applica-
tion responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR
PROPERTY OR IN LARGE QUANTITIES WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE
HAS BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIP-
MENT OR SYSTEM.

I Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable Product, or
any consequence thereof.

Disclaimers

I Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a guide for
the user in determining suitability and does not constitute a warranty. It may represent the result of
Omron’s test conditions, and the user must correlate it to actual application requirements. Actual perfor-
mance is subject to the Omron’s Warranty and Limitations of Liability.

I Change in Specifications

Product specifications and accessories may be changed at any time based on improvements and other
reasons. It is our practice to change part numbers when published ratings or features are changed, or
when significant construction changes are made. However, some specifications of the Product may be
changed without any notice. When in doubt, special part numbers may be assigned to fix or establish
key specifications for your application. Please consult with your Omron’s representative at any time to
confirm actual specifications of purchased Product.

I Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be accurate; how-
ever, no responsibility is assumed for clerical, typographical or proofreading errors or omissions.
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Safety Precautions

Safety Precautions

Definition of Precautionary Information

The following notation is used in this manual to provide precautions required to ensure safe usage of
the NA-series Programmable Terminal. The safety precautions that are provided are extremely impor-
tant to safety. Always read and heed the information provided in all safety precautions.

The following notation is used.

Indicates a potentially hazardous situation which, if

WAR N I N G not avoided, could result in mild or moderate injury or
at the worst, serious injury or death. Additionally,

there may be severe property damage.

Indicates a potentially hazardous situation which, if not

A C a u t i o n avoided, may result in minor or moderate injury, or

property damage.

Precautions for Safe Use

Indicates precautions on what to do and what not to do to ensure safe usage of the product.

LI Precautions for Correct Use
Indicates precautions on what to do and what not to do to ensure proper operation and performance.

Symbols

The triangle symbol indicates precautions (including warnings).

The circle and slash symbol indicates operations that you must not do.
® The specific operation is shown in the circle and explained in text.
This example indicates prohibiting disassembly.
A The specific operation is shown in the triangle and explained in text.

This example indicates a general precaution.
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Safety Precautions

Warnings

/\ WARNING

Do not attempt to take the NA Unit apart and do not touch the product inside while the
power is being supplied. Otherwise it may result in electric shock.

Always ensure that the personnel in charge confirm that installation, inspection, and
maintenance were properly performed for the NA Unit. “Personnel in charge” refers to
individuals qualified and responsible for ensuring safety during machine design,
installation, operation, maintenance, and disposal.

Ensure that installation and post-installation checks are performed by personnel in charge
who possess a thorough understanding of the machinery to be installed.

Do not use the input functions such as the touch panel or function keys of the NA Unit, in
applications that involve human life, in applications that may result in serious injury, or for
emergency stop switches.

Do not attempt to disassemble, repair, or modify the NA Unit. It may cause NA Unit to lose
its safety function.

Never press two points or more on the touch panel of the NA Unit at a time. Touching two
points or more interrupts normal touch panel operations.

To conform to UL Type 4X standards, always use the NAS-CIOOWOOOO (-V1) with a
High-pressure Waterproof Attachment (PWA). If you do not use a PWA, there is a risk of
water entry, which may cause severe equipment damage.

Always pay attention to the inside dimensions when you mount a PWA on the
NA5-CJOwWOOOO (-V1). If you do not mount the PWA correctly, there is a risk of water
entry, which may cause severe equipment damage.

>P>0> P>
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Safety Precautions

Precaution
/\ WARNING
I Wiring

Observe the following precautions when wiring the NA5-CJCOOWOOOO-VA.

The internal power supply in the NA5-CJOWOOOO-V1 is a non-isolated DC power supply. Never
ground the 24 V side. If the 24 V power supply to the NA is grounded positively, a short circuit will
occur as shown below and may result in damage to the device.

24 V Grounding Power Supply
NA5-OOWOOOO-V1

Power External
Supply non-isolated
Internal i
I’< RN ,\24 v + / Fuse | nonisolated device
1 A \ power PC
: : supply Shielded USB memory device
E : [0V GND, Fuse ASG cable SG
: (f ------- -} e SEELTELTELTE
T oromsive cround oo | s | R
1

Protective ground

Hood Hood
Functional ground

Grounding - -pp--- —* A

Grounding

NAS5-O0OWOO0O0-V1 grounding diagram

¥ | L ::“[::

Non-isolated
power
supply

e
3
e

—
Serial USB slave
connector connector
Ethernet hood hood

t
b o USB host

connector
24 VDC PE (Protective ground) hood

GND —FG (Functional ground)

@ Additional Information

The internal power supply of the NAS-LJOOWDO OO Product uses an isolated DC power sup-
ply, and therefore is not susceptible to the effects of grounding of the 24 V side.
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Precautions for Safe Use

Precautions for Safe Use

18

When unpacking the NA Unit, check carefully for any external scratches or other damages. Also,
shake the NA Unit gently and check for any abnormal sound.

The NA Unit must be installed in a control panel.

To conform to UL Type 1 standards, the mounting panel thickness must be 1.6 to 6.0 mm.

To conform to UL Type 4X standards, the thickness must be 1.6 to 4.5 mm.

To conform to UL Type 4X standards, always use the NAS-CJOOWOOOO (-V1) with a High-pressure
Waterproof Attachment (PWA). If you do not use a PWA, there is a risk of water entry, which may
cause severe equipment damage. Do not use the NA Unit outdoors. Tighten the Mounting Brackets
evenly to a torque of between 0.5 and 0.6 N-m to maintain water and dust resistance. If the tightening
torque exceeds the specified value, or the tightening is not even, deformation of the front panel may
occur. What is more, make sure the panel is not dirty or warped, that the front surface is smooth, and
that the panel is strong enough to hold the NA Unit.

Do not let metal particles enter the NA Unit when preparing the panel.
Turn OFF the power supply before connecting or disconnecting cables.

Periodically check the installation conditions in applications where the NA Unit is subject to contact
with oil or water.

Be certain to use the cables with lock mechanism such as serial cable or the Ethernet cable after
confirming if it is securely locked.

Do not touch the packaging part of the circuit board with your bare hands. Discharge any static elec-
tricity from your body before handling the board.

Do not use volatile solvents such as benzene and thinners or chemical cloths.

Water and oil resistance will be lost if the front sheet is torn or is peeling off. Do not use the NA Unit,
if the front sheet is torn or is peeling off.

As the rubber packing will deteriorate, shrink, or harden depending on the operating environment,
periodical inspection is necessary.

Confirm the safety of the system before turning ON or OFF the power supply, or pressing the reset
switch.

The whole system may stop depending on how the power supply is turned ON or OFF. Turn ON/OFF
the power supply according to the specified procedure.

Operate DIP switch according to the following way.

Correct technique Incorrect technique

- e
DIP switch

The DIP switch may break if it is levered with a tool against the case as shown in the figure.

Once the DIP switch settings are changed, reset by pressing the reset switch, or restart the power
supply.
Initialize the project, after confirming that existing project is backed up at the Sysmac Studio.

When changing the password, do not reset or turn OFF the power supply until the writing is com-
pleted. A failure to store the password may cause the project to fail to function.

While uploading or downloading a project or a system program, do not perform the operations as fol-
lows. Such operations may corrupt the project or the system program:

* Turning OFF the power supply of the NA Unit
* Resetting the NA Unit.
* Removing the USB devices or SD card.

Back of the case
N\
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Precautions for Safe Use

» Disconnecting the cable between a support tool and the NA Unit.
* Do not connect an AC power supply to the DC power terminals.
* Do not perform a dielectric strength test.

» Use a DC power with a slight voltage fluctuation and that will provide a stable output even if the input
is momentarily interrupted for 10 ms. Also use the one with reinforced insulation or double insulation.

Rated Power Supply Voltage: 24 VDC (Allowable range 19.2 to 28.8 VDC)
« Use a power cable with AWG#12 to #22 thick (0.35 mm? to 3.31 mm?). Peel the coating 7 mm length

and tighten the terminal screw with the torque in the range of 0.5 to 0.6 N-m. Also confirm if the termi-
nal screw is tighten appropriately.

» Ground the NA Unit correctly.
* When using the NA5-COOOWOOOO-V1, to help prevent electrical shock, ground to 100 Q or less by

using dedicated ground wires (with cross-section area of 2 mm? or larger) and tighten the terminal
screw on the protective ground terminal to a torque of 1.0 to 1.2 N-m.

» Do not use any battery if strong impact is applied to it (e.g. by dropping on the floor) because such a
battery may cause a leakage.

» Confirm the type of the battery to install the battery properly.

» Apply power for at least five minutes before changing the battery. Mount a new battery within five
minutes after turning OFF the power supply. If power is not supplied for at least five minutes, the
clock data may be lost. Check the clock data after changing the battery.

* Do not dismantle a battery nor let it short-circuit.

» Do not apply an impact with the lithium battery, charge it, dispose it into a fire, or heat it. Doing either
of them may cause an ignition or a bursting.

» Dispose of the NA Units and batteries according to local ordinances as they apply.

{m |
g
BEE A E

» The following precaution must be displayed on all products containing lithium primary batteries with a
perchlorate content of 6 ppb or higher when exporting them to or shipping them through California,
USA.

Perchlorate Material - special handling may apply.
See www.dtsc.ca.gov/hazardouswaste/perchlorate

The NA-Series contains a lithium primary battery with a perchlorate content of 6 ppb or higher. When
exporting a product containing the NA-Series to or shipping such a product through California, USA,
label all packing and shipping containers appropriately.

» Do not connect the USB devices in the environment subject to the strong vibration.
+ Use a USB memory device for temporary purposes such as data transfer.
» Do not connect USB devices which are not allowed to connect to NA Unit.

 Start actual system application only after checking normal operation of the system including storage
devices such as USB memory and SD card.

» When connecting peripheral devices which do not meet the performance level of the NA Unit for
noise and static electricity, ensure sufficient countermeasures against noise and static electricity dur-
ing installation of the peripheral devices to the NA Unit.

» Do not carry out the following operations when accessing USB devices or SD card:
» Turning OFF the power supply of the NA Unit
* Press the Reset switch of the NA Unit
+ Pull out the USB devices or SD card

* When using the No. 6 pin of the serial port connector for a voltage of DC+5 V, make sure the supply
equipment's current capacity is below 250 mA before using it. The DC+5 V voltage output of the NA
Unit is +5 V5%, and the maximum current is 250 mA.
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Precautions for Safe Use

To ensure the system's safety, make sure to incorporate a program that call periodically signals dur-
ing the operation at connected device side and can confirm the normal functionality of the NA Unit
before running the system.

Start actual system application only after sufficiently checking project, subroutine and the operation of
the program at the connected device side.

To execute a subroutine with multiple threads, fully check the operation of the program that takes
multithreads into consideration, before starting actual system application.

To use numeric input functions safely, always make maximum and minimum limit settings.
Do not press the touch panel with a force greater than 30 N.

Do not use hard or pointed objects to operate or scrub the screen, otherwise the surface of the
screen may be damaged.

The deterioration over time may cause the touch points to move on the touch panel. Calibrate the
touch panel periodically.

A touch position detection error of approximately 20 pixels may occur due to the precision of the
touch panel. Always take this into account when positioning objects on the panel so adjoining objects
will not be activated by mistake.

Confirm the safety of the system before pressing the touch panel.

Do not accidentally press the touch panel when the backlight is not lit or when the display does not
appear or is too dark to identify visually.

You can change the brightness by changing the setting such as in the system menu or by download-
ing project.

If the brightness is set to very dark, it causes flickering or unreadable screen. Additionally, the bright-
ness can be restored by transferring the project again after setting the property of the brightness
appropriately.

In a case of the applications where end users can control the brightness, create the applications so
as keeping on operations by such as assigning the function which restores the brightness to one of
function keys, if necessary.

Signals from the touch panel may not be entered if the touch panel is pressed consecutively at high
speed. Make sure to go on the next operation after confirming that the NA Unit has detected the input
of the touch panel.

The function keys have the restrictions as follows:

* When you use gloves or others, the function keys may not work correctly depending on the mate-
rial and thickness of the gloves. Take actual conditions of the gloves usage into considerations
prior to the system startup to perform the confirmation.

» The function keys do not work when covered with water. Remove the water completely before
use.
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Precautions for Correct Use

® Do not install or store the NA Unit in any of the following locations:

Locations subject to severe changes in temperature

Locations subject to temperatures or humidity outside the range specified in the specifications
Locations subject to condensation as the result of high humidity

Locations subject to corrosive or flammable gases

Locations subject to strong shock or vibration

Locations outdoors subject to direct wind and rain

Locations subject to strong ultraviolet light

Locations subject to dust

Locations subject to direct sunlight

Locations subject to splashing oil or chemicals

® Take appropriate and sufficient countermeasures when installing systems in
the following locations:

Locations subject to static electricity or other forms of noise
Locations subject to strong electric field or magnetic field
Locations close to power supply lines

Locations subject to possible exposure to radioactivity

® Mounting Panel

To conform to UL Type 1 standards, the mounting panel thickness must be 1.6 to 6.0 mm.

To conform to UL Type 4X standards, the thickness must be 1.6 to 4.5 mm.

To conform to UL Type 4X standards, always use the NAS-C1COWOOIO (-V1) with a High-pres-
sure Waterproof Attachment (PWA). If you do not use a PWA, there is a risk of water entry, which
may cause severe equipment damage.

Tighten the Mounting Brackets evenly to a torque of between 0.5 and 0.6 N-m to maintain water
and dust resistance. If the tightening torque exceeds the specified range or the tightening is not
even, deformation of the front panel may occur. Make sure the panel is not dirty or warped, that
the front surface is smooth, and that the panel is strong enough to hold the NA Unit.
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Regulations and Standards

Regulations and Standards

Conformance to EC Directives

22

I Applicable Directives

« EMC Directive

I Concepts

® EMC Directive

OMRON devices that comply with EC Directives also conform to the related EMC standards so that
they can be more easily built into other devices or the overall machine. The actual products have
been checked for conformity to EMC standards.*

Whether the products conform to the standards in the system used by the customer, however, must
be checked by the customer. EMC-related performance of the OMRON devices that comply with EC
Directives will vary depending on the configuration, wiring, and other conditions of the equipment or
control panel on which the OMRON devices are installed. The customer must, therefore, perform
the final check to confirm that devices and the overall machine conform to EMC standards.

*

Applicable EMC (Electromagnetic Compatibility) standards are as follows:
EMS (Electromagnetic Susceptibility): EN 61131-2:2007
EMI (Electromagnetic Interference): EN 61131-2:2007

Conformance to EC Directives

The NA-series PTs comply with EC Directives. To ensure that the machine or device in which the
NA-series PT is used complies with EC Directives, the NA-series PT must be installed as follows:

» The NA Unit must be installed within a control panel.

* You must use reinforced insulation or double insulation for the DC power supplies connected to
the NA Unit.

* NA-series PTs that comply with EC Directives also conform to the Common Emission Standard
(EN 61000-6-4). Radiated emission characteristics (10-m regulations) may vary depending on the
configuration of the control panel used, other devices connected to the control panel, wiring, and
other conditions.

You must therefore confirm that the overall machine or equipment complies with EC Directives.

» This is a Class A product (for industrial environments). In a residential environment, it may cause
radio interference, in which case the user may be required to take appropriate measures.
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Conformance to KC Standards

When you use this product in South Korea, observe the following precautions.
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This product meets the electromagnetic compatibility requirements for business use. There is a risk of
radio interference when this product is used in home.
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Related Manuals

The following manuals are related to the NA-series PTs. Use these manuals for reference.

Manual name Cat. No. Models Applications Description
NA-series Program- | V117 NAS-OWOOOO Learning the speci- | Information is provided on NA-series
mable Terminal Hard- fications and set- PT specifications, part names, instal-
ware User’s Manual tings required to lation procedures, and procedures to
install an NA-series | connect an NA Unit to peripheral
PT and connect devices.
peripheral devices. | |nformation is also provided on main-
tenance after operation and trouble-
shooting.
NA-series Program- | V125 NA5-COwWOOO0O-v1 Learning the speci- | Information is provided on NA-series
mable Terminal Hard- fications and set- PT specifications, part names, instal-
ware(-V1) User’s tings required to lation procedures, and procedures to
Manual install an NA-series | connect an NA Unit to peripheral
PT and connect devices.
peripheral devices. | |nformation is also provided on main-
tenance after operation and trouble-
shooting.
NA-series Program- | V118 NAS-OWOOOO (-v1) Learning about NA-series PT pages and object func-
mable Terminal Soft- NA-series PT pages | tions are described.
ware User’s Manual and object func-
tions.
NA-series Program- | V119 NAS-OWOOOO (-v1) Learning the speci- | Information is provided on connec-
mable Terminal fications required tion procedures and setting proce-
Device Connection to connect devices | dures to connect an NA-series PT to
User’s Manual to an NA-series PT. | a Controller or other device.
NA-series Program- | V126 NA-RTLDOO Learning about the | Information is provided on the specifi-
mable Terminal procedure to install | cations of the Soft-NA and differences
Soft-NA User’s Man- the Soft-NA and from the NAS series.
ual differences from Information is also provided on main-
the NAS series. tenance after operation and trouble-
shooting.
NA-series Program- | V120 NAS-COWOOOO Learning in con- The part names and installation pro-

mable Terminal

crete terms infor-

cedures are described followed by

Startup Guide mation required to | page creation and transfer proce-
install and start the | dures with the Sysmac Studio. Also
operation of an operation, maintenance, and inspec-
NA-series PT. tion procedures after the project is

transferred are described. Sample
screen captures are provided as
examples.
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Related Manuals

Manual name Cat. No. Models Applications Description
NX-series CPU Unit W535 NX701-0000 Learning the basic | An introduction to the entire NX-series
Hardware User's specifications of system is provided along with the fol-
Manual the NX-series CPU | lowing information on the CPU Unit.
_Units, includi_ng + Features and system configuration
mtrc.)ductory.lnf.or- « Introduction
mation, designing, .
installation. and » Part names and functions
maintenance. * General specifications
Mainly hardware * Installation and wiring
information is pro- | « Maintenance and inspection
vided. Use this manual together with the
NJ/NX-series CPU Unit Software
User's Manual (Cat. No.W501).
NJ-series CPU Unit | W500 NJ501-0000 Learning the basic | An introduction to the entire
Hardware User’s NJ301-0I00000] specifications of NJ-series system is provided along
Manual the NJ-series CPU | with the following information on a
NJ101-0000 L .
J10 Units, including Controller built with a CPU Unit.
introductory infor- | . Features and system configuration
.matlon, .de3|gn|ng,  Introduction
installation, and Part d functi
maintenance. art names a.n. u.nc ions
Mainly hardware . Generall speC|f|ca-t|$>ns
information is pro- | ° Installation and wiring
vided. * Inspection and maintenance
Use this manual together with the
NJ-series CPU Unit Software User’s
Manual (Cat. No. W501).
NJ/NX-series CPU W501 NX701-00000 Learning how to Provides the following information on
Unit Software User’s NX1P2-0000000 program and set a Controller built with an
Manual NX102-0000] up an . NJ/NX-series CPU Unit.
NJ/NX-series CPU | . cPy Unit operation
NJ501-00000 Unit
NJ301-0000 ) » CPU Unit features
NJ101.0000 !\/Ifamly stFJﬁV\{are + Initial settings
i Lrildoer;na lonispro- 1, Programming based on IEC
' 61131-3 language specifications
NJ/NX-series Instruc- | W502 NX701-00100 Learning detailed The instructions in the instruction set
tions Reference Man- NX102-01010000 specifications on (IEC 61131-3 specifications) are
ual NX1P2-000000 the basic instruc- described.
tions of an
NJ501-000D NJ/NX-series CPU
NJ301-0000 Unit.
NJ101-0000
NJ/NX-series Trou- W503 NX701-0J000 Learning about the | Concepts on managing errors that
bleshooting Manual NX102-0I010000 errors that may be | may be detected in an NJ/NX-series
detected in an Controller and information on individ-
NX1P2-000000 . .
NJ/NX-series Con- | ual errors are described.
NJ501-0000 troller.
NJ301-0000
NJ101-0000
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Related Manuals

Manual name Cat. No. Models Applications Description
CJ Series Program- | W393 CJ1H-CPULOIOH-R Learning the basic | The following information is provided
mable Controllers CJ1G/H-CPULICH specifications of on a CJ-series PLC.
Operation Manual CJ1G-CPUCICIP the CJ-series « Introduction and features
PLCs, including ) . .
’ » System configuration design
CJ1M-CPULID] introductory infor- | y lati gd B g
CJ1G-CPUOO mation, designing, nstallation and wiring
installation, and * 1/0O memory allocation
maintenance. * Troubleshooting
Use this manual together with the
Programming Manual (Cat. No.
W394).
CS/CJ/NSJ Series W394 CS1G/H-CPUOOH Learning about the | The following information is provided
Programmable Con- CS1G/H-CPUOIO-V1 functions of the on a CS/CJ-series or NSJ-series
trollers Operation CS1D-CPUCICH CS/CJ-s.erles and | PLC.
Manual NSJ-series PLCs. | . programming
CS1D-CPUOOS
* Master function
CJ1H-CPUOOH-R .
CJ1G/H-CPUOOH " Fllo memory
) « Other functions
cJie-cPuLLP Use this manual together with the
CJIM-CPUDIT] Operation Manual (CS-series PLCs:
CJ1G-cpPulOd W339, CJ-series PLCs: W393).
NSJO-0000(B)-G5D
NSJO-0000(B)-M3D
CS/CJ/NSJ-series W340 CS1o-CPU-UOO-OO Learning detailed Instructions are described in detail.
Instructions Refer- CJ1o-CPU-000O-000 informa!tion. On pro- | When programming, use this man-
ence Manual CJ2H-CPU-OO0-O00 | 9rémming instruc- | ) together with the Operation Man-
tions. ual (CS-series PLCs: W339
NSJHE-000E0-000 CJ-series PLCs: W393) and the Pro-
gramming Manual (W394).
CS/CJ Series Pro- W341 CQM1H-PROO01 Learning the oper- | The operating procedures of the Pro-

gramming Consoles
Operation Manual

CQM1-PROO01
C200H-PRO27
+CS1W-KS001

ating procedures of
the Programming
Consoles.

gramming Consoles are described.

When programming, use this man-
ual together with the Operation Man-
ual (CS-series PLCs: W339,
CJ-series PLCs: W393), the Pro-
gramming Manual (W394), and the
Instructions Reference Manual
(W340).
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Related Manuals

Manual name Cat. No. Models Applications Description
CS/CJ/INSJ Series W342 CS1G/H-CPUOCH Learning detailed 1) C-mode commands and 2) FINS
Communications CS1G/H-CPULO-V1 specifications on commands are described in detail.
Com";:”ds Il?efer- CS1D-CPUCICH :he C(.)mrtnunti.ca- Refer to this manual for information
ence Manua 1oNs INStrucions | on communications commands

CS1D-CPULILIS addressed to (C-mode commands and FINS com-
CS1W-ScuI-V1 C8/CJ-series CPU | mands) addressed to CPU Units.
CSTW-SCBLILIVT Egijs anq PLC Note This manual describes com
-series S. -
CJ1G/H-CPULILH munications commands that
cJ1G-cpPuOOP are addressed to a CPU Unit.
CJ1M-CPUOO The communications path is
CJ1G-CPULIC not. relevant. (The communi-
cations commands can be
CJ1w-scutit-vi sent through the serial com-
munications port of the CPU
Unit, the communications port
of a Serial Communications
Board/Unit, or a communica-
tions port on another Com-
munications Unit.)
CJ-series CJ2 CPU | W472 CJ2H-CPU6LI-EIP Learning the hard- | The following information is provided
Unit Hardware User’s CJ2H-CPU6L] ware specifica- on a CJ2 CPU Unit.
Manual CJ2M-CPULIC] tions of CJ2 CPU | .. ntroduction and features
Units. » Basic system configuration
» Part names and functions
« Installation and setting procedures
» Troubleshooting
Use this manual together with the Sofft-
ware User’s Manual (Cat. No. W473).
CJ-series CJ2 CPU | W473 CJ2H-CPUGLI-EIP Learning the soft- | The following information is provided
Unit Software User’s CJ2H-CPU6G ware specifica- on a CJ2 CPU Unit.
Manual CJ2M-CPULC] tior?s of CJ2 CPU « CPU Unit operation
Units. * Internal memory
» Programming
» Settings
* Functions built into the CPU Unit
Use this manual together with the
Hardware User’s Manual (Cat. No.
W472).
Ethernet Units Oper- | W420 CS1W-ETN21 Learning how to Information is provided on the Ether-
ation Manual Con- CJ1W-ETN21 use an Ethernet net Units.
struction of Networks Unit. Information is provided on the basic
setup and FINS communications.
Refer to the Communications Com-
mands Reference Manual (Cat. No.
W342) for details on FINS com-
mands that can be sent to
CS/CJ-series CPU Units when using
the FINS communications service.
Ethernet Units Oper- | W421 CS1W-ETN21 Learning how to Information is provided on construct-
ation Manual Con- CJ1W-ETN21 use an Ethernet ing host applications, including func-

struction of
Applications

Unit.

tions for sending/receiving mail,
socket service, automatic clock
adjustment, FTP server functions,
and FINS communications.
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Related Manuals

Manual name Cat. No. Models Applications Description
CS/CJ-series Ether- | W465 CJ2H-CPU6LI-EIP Learning how to Information is provided on the built-in
Net/IP™ Units Oper- CJ2M-CPU3] use the built-in Eth- | EtherNet/IP port and EtherNet/IP
ation Manual CS1W-EIP21 erNet/IP port_of the | Units.

CJ2 CPU Units. Basic settings, tag data links, FINS
CJ1W-EIP21 . .
communications, and other functions
are described.
Sysmac Studio Ver- W504 SYSMAC-SE20100 Learning about the | The operating procedures of the Sys-
sion 1 Operation operating proce- mac Studio are described.
Manual dures and func-
tions of the
Sysmac Studio.
CX-Programmer W446 CXONE-ALOOC-V4 Learning about the | The operating procedures of the
Operation Manual CXONE-ALCICID-V4 CX-Programmer CX-Programmer are described.
except for informa-
tion on function
blocks, ST pro-
gramming, and
SFC programming.
NY-Series Industrial | W553 NYBOO-10O0O0O Learning the basic | An introduction to the entire
Box PC User's Man- specifications of NY-series system is provided along
ual the NY-series with the following information on the
Industrial Box PCs, | Industrial Box PC.
including introduc- | . Features and system configuration
toryllnf.ormgtlon, * Introduction
designing, installa- .
tion, and mainte- » Part names and functions
nance. » General specifications
+ Installation and wiring
+ Maintenance and inspection
NY-Series Industrial | W555 NYPOO-O1O00O-00W | Learning the basic | An introduction to the entire
Panel PC User's c1oo0 specifications of NY-series system is provided along
Manual the NY-series with the following information on the
Industrial Panel Industrial Panel PC.
PCs, including « Features and system configuration
|ntro'ductory.|nf.or- « Introduction
mation, designing, .
. . + Part names and functions
installation, and
maintenance. * General specifications
+ Installation and wiring
* Maintenance and inspection
NY-Series IPC W556 NY512-1000 Learning the basic | An introduction to the entire

Machine Controller
Industrial Box PC
Hardware User's
Manual

specifications of
the NY-series
Industrial Box PCs,
including introduc-
tory information,
designing, installa-
tion, and mainte-
nance.

Mainly hardware
information is pro-
vided.

NY-series system is provided along
with the following information on the
Industrial Box PC.

+ Features and system configuration
* Introduction

+ Part names and functions

* General specifications

+ Installation and wiring

* Maintenance and inspection
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Related Manuals

Manual name Cat. No. Models Applications Description
NY-Series IPC W557 NY532-1000 Learning the basic | An introduction to the entire
Machine Controller specifications of NY-series system is provided along
Industrial Panel PC the NY-series with the following information on the
Hardware User's Industrial Panel Industrial Panel PC.
Manual PCs, including « Features and system configuration
mtrc.)ductory.lnf.or- « Introduction
mation, designing, .
installation, and » Part names and functions
maintenance. * General specifications
Mainly hardware « Installation and wiring
information is pro- | * Maintenance and inspection
vided.
NY-Series IPC W558 NY532-10000 Learning how to The following information is provided
Machine Controller NY512-10000 program and set on the NY-series Controller functions.
Industrial Panel PC / up the Controller « Controller operation
Industrial Box PC functions of an . Controller features
Software User's Man- NY-series Indus- .
ual trial PC. » Controller settings
» Programming based on IEC
61131-3 language specifications
NY-Series Instruc- W560 NY532-1000 Learning detailed | The instructions in the instruction set
tions Reference Man- NY512-100000 specifications on (IEC 61131-3 specifications) are
ual the basic instruc- described.
tions of an
NY-series Indus-
trial PC.
NY-Series Trouble- W564 NY532-1000 Learning about the | Concepts on managing errors that
shooting Manual NY512-10000 errors that may be | may be detected in an NY-series
detected in an Controller and information on individ-
NY-series Indus- ual errors are described.
trial PC.
NX-series NX1P2 w578 NX1P2-00000 Learning the basic | An introduction to the entire NX1P

CPU Unit Hardware
User's Manual

specifications of
the NX-series
NX1P2 CPU Units,
including introduc-
tory information,
designing, installa-
tion, and mainte-
nance.

Mainly hardware

information is pro-
vided.

system is provided along with the fol-
lowing information on the NX1P2
CPU Unit.

» Features and system configuration
* Introduction

» Part names and functions

» General specifications

« Installation and wiring

* Maintenance and inspection
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Related Manuals

Manual name Cat. No. Models Applications Description
NX-series NX1P2 W579 NX1P2-00000 Learning about the | Of the functions for an NX1P2 CPU
CPU Unit Built-in /0 details of functions | Unit, the following information is pro-
and Option Board only for an vided.
User's Manual NX-series NX1P2 | . Byilt-in I/O
,CPU Un'_t andan |, gerja) Option Boards
introduction of ,
functions for an * Analog Option Boards
NJ/NX-series CPU | An introduction of following functions
Unit. for an NJ/NX-series CPU Unit is also
provided.
+ Motion control functions
+ EtherNet/IP communications func-
tions
» EtherCAT communications func-
tions
NX-series NX102 W593 NX102- OO0 Learning the basic | An introduction to the entire NX102
CPU Unit Hardware specifications of system is provided along with the fol-
User's Manual NX102 CPU Units, | lowing information on the CPU Unit.
including introduc- | . Features and system configuration
tory.lnfo-rmatlon, * Introduction
design, installa- .
tion, and mainte- | Part names and functions
nance. Mainly * General specifications
hardware informa- | ¢ Installation and wiring
tion is provided. + Maintenance and inspection
NX-series Z395 NX-SL5000 Learning how to Describes the hardware, setup meth-
Safety Control Unit / NX-SIO0000 use the NX-series | ods, and functions of the NX-series
Communication Con- NX-SOCO00 Safety Control Safety Control Units and Communi-
trol Unit Units and Commu- | cations Control Units.
, NX-CSGULU nications Control
User’s Manual .
Units.
NX-series Z396 NX-CsGOOd Learning about the | Describes the software setup meth-
Communication Con- built-in functions of | ods and communications functions of
trol Unit an NX-series Com- | an NX-series Communications Con-
I . munications Con- | trol Unit.
Built-in Function .
trol Unit.
User’s Manual
NJ-series 0037 NJ501-ROOO Using the Describes the settings and operation

Robot Integrated
CPU Unit

User’s Manual

NJ-series Robot
Integrated CPU
Unit.

of the CPU Unit and programming
concepts for OMRON robot control.
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Terminology

Terminology

Term Description
HMI A general term for interface devices that indicates both hardware and software elements. In
this manual, “HMI” refers to an OMRON Sysmac-brand product unless otherwise specified.
PT The hardware elements of the HMI.
NA Series The NA Series of Programmable Terminals and peripheral devices.
NAS5 Series NA5-OWOOOO-V1 and NAS-OJOOOOO.
HMI Project A Sysmac Studio project for an HMI.
NA Unit An NA-series Programmable Terminal.
Download Transferring data from the Sysmac Studio to an HMI.
Upload Transferring the project from an HMI to the Sysmac Studio.

IAG collection

When you provide IAGs, you provide them as IAG collections. IAGs are also imported as
IAG collections. An IAG collection contains one or more IAGs.
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Revision History

Revision History

32

A manual revision code appears as a suffix to the catalog number on the front and back covers of the
manual.

[Cat. No.

V118-E1-18 |

*— Revision code

Revision code Date Revised content
01 June 2014 Original production
02 October 2014 | Made revisions accompanying version upgrade.
03 April 2015 Made revisions accompanying version upgrade.
04 October 2015 | Made revisions accompanying version upgrade.
05 December 2015 | Made revisions accompanying version upgrade.
06 April 2016 Made revisions accompanying version upgrade.
07 July 2016 Made revisions accompanying version upgrade.
08 October 2016 | Made revisions accompanying support of NX1/NY series.
09 February 2017 | Made revisions accompanying version upgrade.
10 October 2017 | Made revisions accompanying version upgrade.
11 April 2018 Made revisions accompanying support of NX102 series.
12 July 2018 Made revisions accompanying version upgrade.
13 October 2018 | Made revisions accompanying version upgrade.
14 January 2019 | Made revisions accompanying version upgrade.
15 April 2019 Made revisions accompanying version upgrade.
16 April 2020 Made revisions accompanying version upgrade and the addition of units.
17 July 2020 Made revisions accompanying version upgrade.
18 October 2020 | Made revisions accompanying version upgrade.
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Introduction to the NA-series Pro-

grammable Terminals
]

This section describes the features, basic system configuration, specifications, and
overall operating procedure of the NA-series Programmable Terminals.
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Introduction to the NA-series Programmable Terminals

NA-series Programmable Terminals

1-1-1

The NA-series Programmable Terminals represent the next generation of HMIs for industrial applica-
tions. They display information on FA manufacturing sites and function as control interfaces while pro-
viding safety, reliability, and maintainability. They provide all of the functions of traditional programmable
terminals with a clearer, easy-to-use interface.

OMRON offers the new Sysmac Series of control devices designed with unified communications speci-
fications and user interface specifications.

The NA-series Programmable Terminals are Sysmac devices that you can use together with the
NJ/NX/NY-series Machine Automation Controllers and the Sysmac Studio Automation Software to
achieve optimum functionality and ease of operation.

If you connect an NA-series Programmable Terminal to an NJ/NX/NY-series Controller, all you have to
do to specify memory in the Controller is to specify the Controller variables for the objects on the Pro-
grammable Terminal screens. This allows you to create screens without being concerned with the
memory map of the Controller.

Automation Software NA-series PT

~a_ Specifications with Only

Variables from Objects on
Screens

Sysmac Studio Programming with

Variables to Eliminate
Worrying about the
Memory Map

NJ/NX/NY-series Controller

/
=—

SvSinac

always in control

Ethernet

Features

I Hardware Features

® High-resolution Display Panels

High-resolution display panels are used to more clearly display large amounts of information than
was possible with previous OMRON products.

® Two Ethernet Ports (Standard Feature)

You can use both Ethernet ports to separate the segment attached to control devices from the seg-
ment attached to maintenance devices. Access is possible from both segments at the same time.

You can connect the following devices.
* NJ/NX/NY-series Controllers

* PLCs

» Computers

» Sysmac Studio
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1 Introduction to the NA-series Programmable Terminals

4
>
® Standard-feature SD Memory Card Slot 8
You can use an SD Memory Card inserted in the NA Unit to automatically transfer the project you %
created on the Sysmac Studio to the NA Unit, to update the system program in the NA Unit, or to é
save the log data from the NA Unit. a0
=)
N-2
» o
I Software Features
® Specifications with Variables for Superior Reusability

If you connect to an NJ/NX/NY-series Controller, all you have to do to specify memory in the Control-
ler is to specify the Controller variables. This allows you to create objects that are not dependent on IN
specific devices or memory maps. This in turn makes the objects much more reusable than they N
were with previous PTs. py
QO

® Program with Visual Basic

You can use Microsoft’s Visual Basic to program advanced functions that you cannot achieve with
standard objects.

® A Wealth of Security Features

The many security features of the NA-series PTs include operation authority settings and execution
restrictions with IDs.

® Use the Integrated Development Environment of Sysmac Studio Automation
Software

You use the Sysmac Studio to create applications for the NA-series Programmable Terminals.

The Sysmac Studio provides an integrated development environment that covers not only the
NA-series Programmable Terminal, but also the Controller and devices on EtherCAT as well.

You can use consistent procedures for all devices regardless of differences in the devices. The Sys-
mac Studio supports all phases of Controller application, from page creation and sequence design
through debugging, simulations, commissioning, and changes during operation.

® A Wealth of Simulation Features

You can perform simulations using a virtual HMI on the Sysmac Studio. And you can also perform
online debugging with a virtual NJ/NX/NY-series Controller.
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1 Introduction to the NA-series Programmable Terminals

1-2 How HMis Operate

This section describes how the HMI operates.

1-2-1 HMI Software Configuration

An HMI consists of the following software.
» System Program

The system program is required to start the HMI and execute the runtime. For details, refer to
NA-series Programmable Terminal Hardware User’s Manual (V117) or NA-series Programmable Ter-
minal Hardware(-V1) User's Manual (V125).

¢ Runtime

The runtime is the middleware that executes the project. The runtime is started by the system pro-
gram and it manages execution of the project.

* Project

You use the Sysmac Studio to create your applications. The applications are executed on the run-
time.

1-2-2 HMI Projects

An HMI project contains mainly the following data.

— Pages 77" Pages consist of — You can specify variables,
objects. and the actions for events.
Project ——— Global variables ~ ----- HMI variables
— Globalevents ~  ----- Events that are shared
by the entire project

—— Subroutines @0 0----- You can start subroutines
when events occur.

In addition, there is data that is shared by the entire project, such as user alarms, data logging, recipes,
and resources.

1-2-3 Pages

One HMI screen is called a page.
There are the following two types of pages.

Page type Size

Main Maximum screen size for each model
I:l Smaller than the maximum screen

Popup
size for each model

You paste objects on the pages.

1-4 NA-series Programmable Terminal Software User’s Manual (V118)



1 Introduction to the NA-series Programmable Terminals

0
1-2-4 Objects g
I
The objects that you paste on HMI pages consist of the following three elements. §
(]
T
)
Element %
— Properties @~ ----- These are static properties.
Example: Names and other general properties, colors,
positioning, and other display properties, and
Object assigned condition expressions or variables
D —r——Animations @ ----- Operating properties for condition expressions ;;
Example: Operating specifications, such as flashing, g
enabling/disabling operation, size/coordinate =2
changes, and displaying/hiding. &
— Eventsand =~~~ " You can specify events and the actions to perform when the
Actions events occur.

Example: You can specify subroutines to execute, e.g.,
when a function key is pressed or a value
changes.
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1 Introduction to the NA-series Programmable Terminals

1-2-5 Memory Specifications for Connected Devices

I Overview

You use HMI global variables to specify memory in a Controller or PLC.
You assign HMI global variables to connected device variables in advance to map them.

1) Variables for connected devices are registered to device variables in the HMI project with one of the
following methods.

a) Variables for connected devices that are registered in the same project are registered automati-
cally.

b) You can copy and paste variables from another project using the clipboard.
¢) You can import variables from the external connected device.

2) Devices variables are assigned to HMI global variables.
3) The assigned HMI global variables are specified in the properties of the objects.
4) Then, you transfer the project that you created to the HMI.

Sysmac Studio
project

Sysmac Studio Device registered in the project HMI project
(NJ/NX/NY-series Controller)

| HMI settings |
Global variables
,1| Global variables |3) Variables
a) Automatic registration il . specified in
g L’ Pages N properties
1 I
v ";,A ned Object J
1) | Device variables +" 2) Assigned. @’
b) Pasted from 4) Transferred.
clipboard. )
c) Importing HMI
Different project, i.e., . .
in Sysmac Studio Physical NJ/INX/NY-series
Controller or other device
Controller /
Global variables
o O O

Refer to 4-1 Registering Variables on page 4-3 for the details on HMI variables.
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1 Introduction to the NA-series Programmable Terminals

1-2-6 Events

Events are triggers that activate actions.”

*1. Actions are various operations that can be directly assigned to events.

ajesadQ S|IINH MOH Z-1

Events occur when the common page status or object status meets certain conditions.

Events are classified into three groups as shown below.

Group Description

Global events Events that occur for shared project status. N
[\
&
Events Page and object events Events that occur for specific page or object status. m
S
2]

User alarm events Events that occur for user alarm status.
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1-2-7 Subroutines

Introduction to the NA-series Programmable Terminals

You can execute user-created subroutines in the HMI based on the following three types of conditions.

* When global events occur
* When events occur on pages or for objects
* When user alarm events occur

There are two types of subroutines that you can create.

« Global Subroutines

You create these subroutines under the global subroutine item of the HMI project.

» Page Subroutines

You create these subroutines with the page code editor.

You can use Visual Basic to write both the global subroutines and the page subroutines.

Sysmac Studio project

[0]: Event: F1 Key Click

[1]: Event: Interval
Action: IncreaseVariable

Events

* Object event e

* Global events (i.e., events shared by all pages)

Action: CallSubroutine —-——r--

Action: CallSubroutine

Called.

v Global
subroutine

N

Coded in Visual Basic

/

-
-

- Page_
subroutine

7Y
1
1
1
T
:
1
1
D Object

» User Alarm Event

Date and Time Message prioity | Group

5/22/2014 100303 A\ EmergencyStop Level 4

Emergencystop

Acknowledge ‘

[0]: Event: Raised

[1]: Event: Acknowledged
Action: IncreaseVariable

Action: CallSubroutine ————a

* You can call a global subroutine by executing the CallSubroutine action when a global event occurs.
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1 Introduction to the NA-series Programmable Terminals

* You can call a global subroutine or page subroutine by executing the CallSubroutine action when an
event occurs on the page or for an object.

* You can call a global subroutine by executing the CallSubroutine action when a user alarm event
occurs.

ajesadO SINH MOH Z-1

You can also call a global subroutine from another global subroutine or a page subroutine.

1-2-8 Functions Shared by the Entire HMI Project

In addition to global events, the following functions are shared by the entire HMI project.

I Alarms

Alarms notify the user when certain conditions are met in the HMI.

The following alarms are supported.
» User alarms

I Data Logging

You can log data to store the changes in the values of specified variables over time.

100l01d IINH 24pu3 8y} Ag paleys suonouny g-z-1

You can display the saved data with Trend Graph objects. You can also save this data to external files.

I Recipes

A recipe is used to write data (numeric data or text strings) that was set in advance in the project to all
of the specified variables as a group or to read all of the specified variables as a group.

You can manipulate the registered recipe data with Recipe Viewer objects.

I Resources

You can manage resources, such as the text strings, movies, still images, and documents that are dis-
played for objects and alarms on pages.

1-2-9 Data That Retained When Power Is Turned OFF

The following data is retained when the power supply is turned OFF.

With No Battery or Low Battery Voltage

* Project data

Log data that is not written to the SD Memory Card
* User alarm history

Values of variables with Retain attribute
Callibration information for touch panel

With Good Battery (in addition to the above)
» Clock information
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1 Introduction to the NA-series Programmable Terminals

1-3 Operating Procedure for HMIs

This section gives the operating procedure for an HMI and then describes it in more detail.

1-3-1

Overall Procedure

The overall procedure to use an HMI is given below.

STEP1

STEP2

STEP3

STEP4

System Configuration and Project Design
Design the system configurations and project.

STEP 1-1 Designing the System Configurations

STEP 1-2 Designing the Project (Pages, Variables, Subroutines, etc.)

Software Settings (Configurations and Setup) and Creating the HMI Application

Create the system configurations that you designed in step 1 on the Sysmac Studio. Also create
the project (pages, variables, subroutines, etc.), build the project, and debug it with simulation

and other functions.

Determining the Connected Device Variables
and Mapping HMI Variables to Them (We rec-
ommend this as the basic procedure.)

Setting HMI Variables First and Then Mapping
Them to Connected Device Variables

STEP 2-1 Starting the Sysmac Studio and Creating
a Project

STEP 2-1 Starting the Sysmac Studio and Creating
a Project

STEP 2-2 Software Settings (Configurations and
Setup)

STEP 2-2 Creating the HMI Application

STEP 2-3 Creating the HMI Application

STEP 2-3 Software Settings (Configurations and
Setup)

STEP 2-4 Building the HMI

STEP 2-4 Building the HMI

STEP 2-5 Offline Debugging

STEP 2-5 Offline Debugging

Mounting and Wiring
Mount the HMI.

Connect the connected device and computer (Sysmac Studio) to the HMI.

Confirming Operation and Starting Actual System Operation

Download the project from the Sysmac Studio.

Make the settings on the System Menu, check operation on the physical devices, and start

operation.
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1-3-2 Procedure Details

STEP1

System Configuration and Project Design

Reference

10} ainpadsoid Bunesado ¢-L

Step Description T
» Connect an HMI to the external Section 2 Configuration Units in NA Series %
device. Programmable Terminal Hardware User’s
STEP 1-1 + Connect an HMI to the Sysmac Manual (V117)
Designing the Studio. Section 2 Configuration Units in NA Series

System Configu- Programmable Terminal Hardware(-V1)

rations User’s Manual (V125)
NA-series Programmable Terminal Device
Connection User’s Manual (V119)

STEP 1-2 Design the project as given below. | NA Series Programmable Terminal Software

Designing the User's Manual (V118)
Project (Pages,
Variables, Sub-

routines, Etc.)

s|ieje anpeoold Z-¢-1

» Design the contents to display on
the pages (the pages and objects
to use).

1) Designing the
Pages and Sub-

routines + Design the execution methods
and contents of the subroutines.

2) Designing » Design the global events.

Items Shared by | - Design the alarms, recipes, data

All Pages logging, and other functions.

* HMI external variable design:

Design the mappings between the

connected device variables and

the HMI global variables.

Design the HMI internal variables

and subroutine variables.

» Define the attributes of the above
variables, such as the Data Type,
Name, and Retain attributes.

3) Variable Design | *

STEP2

Software Settings (Configurations and Setup) and Creating the HMI Application

Sysmac Studio oper-

Step Description ; Reference

ations
STEP 2-1 1. Start the Sysmac Press the New Project | Sysmac Studio Version 1 Opera-
Starting the Sys- | Studio and create a Button. tion Manual (W504)

mac Studio and
Creating a Project

project.
2. Insert the HMI.

Use HMI on the Insert
Menu.

Section 2 Basic Sysmac Studio
Operations
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® Determining the Connected Device Variables and Mapping HMI Variables to

Them

We recommend this procedure as the basic procedure.

» Connecting to a Connected Device Registered in the Current Project

STEP 2-2
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings
on the Sysmac Studio.

Use Configurations and
Setup in the Multiview
Explorer of the Sysmac
Studio.

Section 3 HMI Con-
figuration and Setup

* Mapping Vari-
ables

+ Assign global variables to con-
nected device variables (map-
ping variables).

Map the variables under
Configurations and
Setup — Variable Map-

ping.

3-3 Mapping Vari-
ables on page 3-7

* HMI Settings

+ Set the parameters related to
the HMIL.
Startup Page, Brightness Set-
tings, IP Address, FTP Settings,
NTP Settings, FINS Settings,
VNC Settings, etc.

Make the settings under
Configurations and
Setup — HMI Settings.

3-4 HMI Settings on
page 3-10

* Security Set-
tings and Lan-
guage Settings

» Set the operation rights to the
HMI and the language to display
on the HMI.

Make the settings under
Configurations and
Setup — Security Set-
tings and Configura-
tions and Setup —

Language Settings.

3-5 Security Settings
on page 3-19

3-7 Language Set-
tings on page 3-21

+ Connecting to a Connected Device Not Registered in the Current Project

STEP 2-2
Software Set-
tings (Configu-
rations and
Setup)

Make the initial software settings on
the Sysmac Studio.

Use Configurations and
Setup in the Multiview
Explorer of the Sysmac
Studio.

Section 3 HMI Con-
figuration and
Setup

* Register the external connected
devices.

Add the connected
device under Configura-
tions and Setup —
Device References.

3-2 Device Refer-
ences on page 3-3

¢ Device Set-
tings

* You can do either of the following.

a) Importing Variables from the
Actual Connected Device: Place
the Sysmac Studio online with
the connected device and import
the variables from the connected
device.

b) Importing Variables from Another
Project: Copy the variable table
in the other project and paste it
in the variable table for the con-
nected device to import the vari-
ables.

c¢) Importing Variables from a File:
Import the information on the
variables of the connected
device from a file, such as an
Excel file.

Set up communications
and import the variables.

Copy the variable table
from another project
using the clipboard.

Import variable informa-
tion from a file.
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1 Introduction to the NA-series Programmable Terminals

Assign global variables to connected
device variables (mapping variables).

Map the variables under

Configurations and

Section 3 HMI Con-
figuration and

: Ma;.)pmg Setup — Variable Map- Setup and 3-3 Map-
Variables . ) )
ping. ping Variables on
page 3-7
» Set the parameters related to the Make the settings under | 3-4 HMI Settings on
HMIL. Configurations and page 3-10

* HMI Settings

Startup Page, Brightness Settings,
IP Address, FTP Settings, NTP
Settings, FINS Settings, VNC Set-
tings, etc.

Setup — HMI Settings.

* Security Set-

+ Set the operation rights to the HMI
and the language to display on the

Make the settings under
Configurations and

3-5 Security Set-
tings on page 3-19

tings and HMI. Setup — Security Set- 3-7 Language Set-
Language tings and Configura- tings on page 3-21
Settings tions and Setup —
Language Settings.
STEP 2-3 Create the application (pages, Use HMI in the Multiv- | Section 4 Creating the
Creating the HMI | variables, subroutines, etc.) with iew Explorer of the HMI Application
Application the Sysmac Studio. Sysmac Studio.

1) Registering
Variables

* Register the variables in the HMI
global variable table with the
Sysmac Studio.

Note: Variables that were mapped
in step 2-2 are automatically regis-
tered in the HMI global variables
table.

Use the editor for HMI
— Data — Global Vari-
ables

4-1 Registering Vari-
ables on page 4-3

2) Creating Pages

+ Paste the objects on each page
and set the object properties
and other settings.

Use the editor for HMI
— Pages.

4-3 Creating Pages on
page 4-20
Section 5 Objects

3) Creating Sub-

+ Create the subroutines.
You can create the following.
* Global subroutines

+ Page subroutines

Subroutines shared by
the entire project:
Select HMI — Global
Subroutine.

Page subroutines: Use

4-5 Subroutines on
page 4-50

routines HMI — Pages | Page
Name and select View
Code Editor from the
individual pages.
. * Make the settings that are Use HMI — User 4-4 Setting Common
4) Settings . . . )
shared by the project: alarms, Alarms, HMI — Reci- | Object Functions on
Shared by All . .
recipes, data logging, global pes, etc. page 4-32
Pages
events, etc.
STEP 24 » Convert the HMI project into a Use Build HMI on the | 4-8 Building on page

Building the HMI

form that the HMI can execute.

Project Menu.

4-59

STEP 2-5
Offline Debug-

ging

» Check the operation of the
pages on the Simulator (a virtual
HMI).

Use Start NA Simula-
tion or Run with Con-
troller Simulator on
the Simulation Menu.

Section 7 Debugging

NA-series Programmable Terminal Software User’s Manual (V118)
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Introduction to the NA-series Programmable Terminals

® Setting HMI Variables First and Then Mapping Them to Connected Device

Variables
STEP 2-2 Create the application (pages, | Use HMI in the Multiview Section 4 Creating the
Creating the HMI | variables, subroutines, etc.) Explorer of the Sysmac Stu- | HMI Application
Application with the Sysmac Studio. dio.

1) Registering
Variables

Register the variables in the
HMI global variable table with
the Sysmac Studio.

HMI — Data — Global Variables
Table

4-1 Registering Vari-
ables on page 4-3

2) Creating Pages

Paste the objects on each
page and set the object prop-
erties.

Use the editor for HMI —
Pages.

4-3 Creating Pages on
page 4-20

Section 5 Objects

3) Creating Sub-

Create the subroutines.
You can create the following.
* Global subroutines

Subroutines shared by the
entire project: Select HMI —
Global Subroutine — Add.
Page subroutines: Use HMI —

4-5 Subroutines on
page 4-50

routines * Page subroutines Pages and select View Code
Editor from the individual
pages.
. Make the settings that are Use HMI — User Alarms, HMI | 4-4 Setting Common
4) Settings o . . .
shared by the project: alarms, | — Recipes, etc. Object Functions on
Shared by All . .
recipes, data logging, global page 4-32
Pages
events, etc.
» Connecting to a Connected Device Registered in the Current Project
STEP 2-3 Make the initial software settings Use Configurations Section 3 HMI Config-

Software Set-
tings (Configura-
tions and Setup)

on the Sysmac Studio.

and Setup in the Mul-
tiview Explorer of the
Sysmac Studio.

uration and Setup

* Mapping Vari-
ables

ping variables).

+ Assign global variables to con-
nected device variables (map-

Map the variables
under Configura-
tions and Setup —
Variable Mapping.

3-3 Mapping Vari-
ables on page 3-7

e HMI Settings

the HMI.

VNC Settings, etc.

» Set the parameters related to

Startup Page, Brightness Set-
tings, IP Address, FTP Settings,
NTP Settings, FINS Settings,

Make the settings
under Configura-
tions and Setup —
HMI Settings.

3-4 HMI Settings on
page 3-10

* Security Set-
tings and Lan-
guage Settings

on the HMI.

» Set the operation rights to the
HMI and the language to display

Make the settings
under Configura-
tions and Setup —
Security Settings and
Configurations and
Setup — Language
Settings.

3-5 Security Settings
on page 3-19

3-7 Language Set-
tings on page 3-21
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» Connecting to a Connected Device Not Registered in the Current Project

STEP2-3
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings
on the Sysmac Studio.

Use Configurations
and Setup in the Mul-
tiview Explorer of the
Sysmac Studio.

Section 3 HMI Config-
uration and Setup

e Connected
Device Settings

* Register the external connected
devices.

Add the connected
device under Configu-
rations and Setup —
Device References.

3-2 Device References
on page 3-3

* You can do either of the follow-
ing.

a) Importing Variables from the
Unit Connected Device:
Place the Sysmac Studio
online with the connected
device and import the vari-
ables from the connected
device.

b) Importing Variables from
Another Project: Copy the
variable table in the other
project and paste it in the
device variable table.

c¢) Importing Variables from a
File: Import the information
on the variables of the con-
nected device from a file,
such as an Excel file.

Set up communica-
tions and import the
variables.

Copy the variable table
from another project
using the clipboard.

Import variable infor-
mation from a file.

3-2-2 Connected
Devices in the Current
Project on page 3-3

+ Assign global variables to con-
nected device variables (map-
ping variables).

Map the variables
under Configura-
tions and Setup —
Variable Mapping.

3-3 Mapping Vari-
ables on page 3-7

¢ HMI Settings

» Set the parameters related to
the HMI.
Startup Page, Brightness Set-
tings, IP Address, FTP Settings,
NTP Settings, FINS Settings,
VNC Settings, etc.

Make the settings
under Configura-
tions and Setup —
HMI Settings.

3-4 HMI Settings on
page 3-10

» Security Set-
tings and Lan-

+ Set the operation rights to the
HMI and the language to display
on the HMI.

Make the settings
under Configura-
tions and Setup —
Security Settings and

3-5 Security Settings
on page 3-19

3-7 Language Set-
tings on page 3-21

guage Settings Configurations and
Setup — Language
Settings.
STEP 2-4 » Convert the HMI project into a Use Build HMI on the | 4-8 Building on page

Building the HMI

form that the HMI can execute.

Project Menu.

4-59

STEP2-5
Offline Debug-

ging

» Check the operation of the
pages on the Simulator (a virtual
HMI).

Use Start NA Simula-
tion or Run with Con-
troller Simulator on
the Simulation Menu.

Section 7 Debugging
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1 Introduction to the NA-series Programmable Terminals

STEP3

STEP4

Mounting and Wiring

Step

Description

Reference

1) Mounting

* Mount the HMI to the panel.
» Wire Power Supply.

3-3 Installing NA Units in NA Series Pro-
grammable Terminal Hardware User's Man-
ual (V117)

3-3 Installing NA Units in NA Series Pro-
grammable Terminal Hardware(-V1) User's
Manual (V125)

2) Wiring the
Ethernet Cable to
the Connected
Device

* Wire the Ethernet cables.

3-4 Wiring Methods in NA Series Program-
mable Terminal Hardware User's Manual
(V117)

3-4 Wiring Methods in NA Series Program-
mable Terminal Hardware(-V1) User's Man-
ual (V125)

NA-series Programmable Terminal Device
Connection User’s Manual (V119)

3) Connecting the
Computer (Sys-
mac Studio)

* Wire the USB cable.
or
* Wire the Ethernet cable.

2-4 Support Software in NA Series Program-
mable Terminal Hardware User's Manual
(V117)

2-4 Support Software in NA Series Program-
mable Terminal Hardware(-V1) User's Man-
ual (V125)

Confirming Operation and Starting Actual System Operation

Step

Description

Sysmac Studio

. Reference
operations

1) Online Connec-
tion to Sysmac
Studio and Proj-
ect Download

» Turn ON the power supply to the

HMI and place the Sysmac Stu-
dio online. Then, download the
project.*1
*1.Use the Synchronize operation
of the Sysmac Studio to
download the project.

Use Communica-
tions Setup on the
HMI Menu.

Use Synchroniza-
tion on the HMI
Menu.

Section 6 Connecting
to the HMI and Section
8 Synchronizing Proj-
ects

2) Operation
Check on NA Unit

* Integrate the NA Unit into the
actual system, manipulate the
project that you created and
confirm the following: that cor-
rect values are written to the
connected device, that the

pages change correctly, and that

values set at the connected
device are updated.

— Section 7 Debugging

3) Actual System
Operation

+ Start actual operation.
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Basic Sysmac Studio Operations
]

This section describes basic operations on the Sysmac Studio.

2-1 Parts of the Sysmac StudioWindow ................... ...t 2-2
2-1-1  Application Window . . .. ... 2-2
2-2 MenuCommand Structure ..............cciiiiiiiiinrrnnennnnns 2-6
2-3 Basic Editing Operations .............. . it 2-9
2-4 Sysmac Studio Settings and Operations .. ........................ 211
2-4-1 Setting Parameters . ... . . 2-11
2-4-2  Programming . .. .. ...t e 2-11
2-4-3  Library Functions ... ... . ... ... 2-12
2-4-4  Operations forDebugging . . . ... .. 2-12
2-4-5  CommuNICatiONS . . ... ot 2-12
2-4-6  Security MeasUres .. ..........iiuiiiii e 2-12
2-4-7 Online Help .. ... . 2-13
2-4-8 Project Management Functions ............ ... ... ... .. . i, 2-13
2-5 Basic Operations for HMI Projects ................ .. .. oot 214
2-5-1 Creating a Project File fromthe StartPage .......................... 2-14
2-5-2  Adding an HMI to an Existing Project .. .......... .. ... ... .. ... ...... 2-15
2-5-3  Changing Devices . . ... ... 2-16
2-5-4  Importing and Exporting Devices ......... ... .. ... . . 2-18
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2 Basic Sysmac Studio Operations

2-1 Parts of the Sysmac Studio Window

This section gives the names and functions of the parts of the Sysmac Studio Window.

This manual describes only functions that apply when an HMI is selected for the device. For information
on Sysmac Studio functions not described in this manual, refer to the Sysmac Studio Version 1 Opera-
tion Manual (Cat. No. W504).

M Precautions for Correct Use

When you use the Sysmac Studio, use the standard Windows desktop theme. If you do not use
the standard Windows desktop theme, part of the display may not be correct.

2-1-1  Application Window

Tab

Menu bar Toolbar

BE L4 SAWHE % B F T a =N

Configurations
and Setup Header

Number

(a) Multiview Explorer
(b) Edit Pane

(c) Toolbox

The functions of these parts are described starting on the next page.
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2 Basic Sysmac Studio Operations

I Multiview Explorer (a)

 This pane is your access point for all Sysmac Studio data.

Multiview Explorer - I When an HMI is selected, it is divided into a Configurations
and Setup Layer and an HMI Layer.
HMI_NAS5_0 v I __‘ + You can also display the Page Explorer to display lists of

objects on pages or the Code Explorer to display lists of

Ll Configurations and Setup subroutines.

eferences

MopuIp o1pn}s dewsAs ay o shed |-Z

& Variable Mapping
L] HMI Settings
#, Security Settings
@ Troubleshooter
P, Language Settings
v
¥ [ Pages
LEA
P wi) User Alarms
» [ Controller Events
Bz Data Logging
P}E Data Groups
B, Recipes
[i= Custom Keypads
b [ Data
L Global Events
> & Gl Subroutines
- [T Re

MopuIp uoneolddy |-|-g

[l Imported LAGs

IT:"_I Scale Transformations

 Filter Ed

NA-series Programmable Terminal Software User’s Manual (V118) 2-3



2 Basic Sysmac Studio Operations

® Layers and Items in the Multiview Explorer

Configurations and Setup HMI
Device References Pages
Variable Mapping Page
HMI Settings User Alarms
Security Settings Group
Troubleshooter Controller Events
Language Settings User Events
Operation Log Settings Data Logging
DataSet
Data Groups
DataGroup
Recipes
Recipe
Custom Keypads
Group
Data
Data Types

Global Variables
Global Events
Global Subroutines
SubroutineGroup
Resources
Root
Imported IAGs
IAG
Scale Transformations

EI Precautions for Correct Use

You cannot download the data to the HMI if an error icon is displayed.

® Page Explorer

Ry Tww The Page Explorer displays a list of objects on a page. If you click an object in the

E Page0 Page Explorer, the object will be selected on the Edit Pane.
E Button0

@ Datalamp0

To change the attributes for grouped objects or for individual objects in IAGs, select
the individual objects on the Page Explorer.

Page Explorer

® Code Explorer

The Code Explorer displays the subroutines in the project. You can double-click a
V[ Sl s subroutine to edit it. You can also search for the place where a subroutine is used by

¥, [ SubroutineGroupl . Lo Rk i
5] GlobalSubl right-clicking a subroutine name and selecting Search from the menu.
¥ 7 Pages Subroutine

¥ [Z] PageOxb
[F] WriiteSubroutine

Muttvie..  poge .. [T
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2 Basic Sysmac Studio Operations

| Edit Pane (b)

The basic Sysmac Studio operations on the Edit Pane generally apply to HMIs. If an HMI is selected,
you can edit pages and set up the HMI.

I Toolbox (c)

MopuIp o1pn}s dewsAs ay o shed |-Z

» The Toolbox shows the objects that you can use to edit the page that is displayed in
| the Edit Pane.

You can also display the Properties Window, Animations Window, and Events and
¥ Buttons Actions Window to make the settings of the objects.

[A Momentary Button

[E  Reset Button
E1  SetButton

Toggle Button

Lamps
Shapes
Standard Controls

Gauges

MopuIp uoneolddy |-|-g

HMI Controls

Custom
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2 Basic Sysmac Studio Operations

2-2 Menu Command Structure

The menu commands that are displayed when an HMI is selected as the device are listed below.

Menu Submenu/command
File Close
Save
Save As
Save As New Number
Import
Export
Page Settings
Print
Image File Output
Exit
Edit Undo
Redo
Cut
Copy
Paste
Delete —
Select All
Search and Replace
Find Previous
Find Next
Jump to Multiview Explorer
View Multiview Explorer
Project Shortcut View
Toolbox
3D Visualizer
Output Tab Page
Watch Tab Page
Cross Reference Tab Page
Build Tab Page
Search and Replace Results Tab Page
Page Explorer
Code Explorer
Properties
Animations
Events and Actions
Smart Project Search —
Recently Closed Windows —
Clear Recently Closed Windows History —
Zoom Zoom In
Zoom Out
Zoom to Fit
Zoom Reset
Reset Window Layout —
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2 Basic Sysmac Studio Operations

Submenu/command
Insert Controller NJ101
NJ301
NJ501
NX1P2
NX102
NX701
NY512
NY532
Application Manager
Safety Network Controller NX
Drive
HMI NA5
NA
Vision Sensor FH
FHV
FQ-M
Measurement Sensor ZW
Slave Terminal EtherNet/IP Coupler
External Device
Page
Page Group
User Alarm Group —
Data Set
Recipe
Global Subroutine Group
Project Build HMI
IncrementalBuild HMI
Abort Build
Resource Usage -
Reset Default Value
IAG Collections Manager
HMI Communications Setup
Change Device
Online o
Offline
Synchronization NA Device

Media Device

Transfer Transfer From Device
HMI Clock

Update HMI Name o
Security HMI Write Protection

HMI Source Code Protec-
tion

Clear All Memory

Reset HMI Device

NA-series Programmable Terminal Software User’s Manual (V118)
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2 Basic Sysmac Studio Operations

Menu Submenu/command
Simulation Start NA Simulation
Stop NA Simulation
Step Execution
Step In
Step Out
Continue —
Jump to Current Position
Set/Clear Breakpoint
Enable/Disable Breakpoint
Clear All Breakpoints
Run with Controller Simulator
Tools Import Object Properties
Export Object Properties
Set Shortcut Key
Option
Window Close
Float
Dock
New Horizontal Tab Group
New Vertical Tab Group
Move to Next Tab Group
Move to Previous Tab Group —
Close All But This
Close All Except Active Device
Close All
Close Tab
Open Next Tab
Open Previous Tab
Help Help Contents
Instruction Reference
Keyboard Mapping Reference —
Online Registration
About Sysmac Studio
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2 Basic Sysmac Studio Operations

2-3 Basic Editing Operations

This section describes differences in basic Sysmac Studio operation when an HMI is selected as the
device.

suonesado Bunip3 siseg ¢-z

I Entry Assistance

There are some differences in the standard operation of the Sysmac Studio when an HMI is selected as
the device. This section describes those differences.

® Entering Variable Names and Data Types
» Entering variable names, e.g., when setting properties
» Entering data types in variable tables

Example: When you enter a variable name as a property, the variable names that you can enter are
displayed in a list.

Variable bl +

binValue0 As Boolean | ¢ |BinValue0
5 @ binvaluel
@ binvalue2

@ _HMI_IsScreenSaverActive

eadba -
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2 Basic Sysmac Studio Operations

® Entering Text in the Code Editor

» When you enter text in the Code Editor, the cursor moves to the first item in the list that starts with
the character that you entered.

 Button1_Click

1} 'Code behind Page - Add local subroutines for the page. ‘il

2{=I5ub Button1_Click

3 Dim intValue0 As i

4 a=10 4> Boolear

5| End Sub G Byte
%> Char
9@ Date

eeeee

9@ Double
== Global
hd Loﬂg
{} Microsoft

* When you press the Tab Key after entering the first part of the keyword (“in” in this example), the
rest of the keyword is automatically entered.

i Buttonl_Click
1| 'Code behind Page - Add local subroutines for the page.
2{7Sub Button1_Click
31| Dim intValue0 As Integerl
4| a=10
5| | End Sub

® Entering Text and Resource ID

» Entering text and resource ID when setting properties
Example: When you enter text as a property, the texts that you can enter are displayed in a list.
Texts and resource IDs are displayed at intervals.

Button

Resource ID

P Font English (United States)

HerizontalAlignment

Button [String0]
Button1 [String1]
Button2 [String2]

4

@ Additional Information

For text which has multiple lines, line feed codes are replaced with spaces in the resource ID

list.
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2-4 Sysmac Studio Settings and Opera-

tions

2-41

2-4-2

This section lists the operations of the Sysmac Studio that can be used only when an HMI is selected.

Setting Parameters
Item Description Reference
HMI Settings You can make settings for an HMI. Section 3 HMI Configuration
and Setup

Device References

If you connect an HMI to a device (e.g., Control-
ler or PLC) that is not registered in the current
HMI project, the connected external device will
be added.

Internal Device

Controllers registered in the project are dis-
played.

External Device

You can set up communications and import vari-
ables for connected devices that have been
added.

3-2 Device References on
page 3-3

Variable Mapping

You can associate variables in the connected
devices with variables in the HMI.

3-3 Mapping Variables on
page 3-7

Programming
Item Description Reference

Toolbox The Toolbox displays a list of the objects that Section 5 Objects
you can use.
You can search for the required objects and
drag them to the Page Editor to position the
objects.

Properties You can set the static attributes of the pages
and objects.

Animations You can set the operations for object condition

expressions.

Events and Actions

You can set the actions to perform when events
occur.

Page Explorer

The Page Explorer displays a list of objects on a
page. You can select objects or change the
order of the display.

Code Explorer

The Code Explorer displays lists of subroutines
in the project. You can double-click a subroutine
to edit it.

Page Editor

You can position objects and create pages. You
can also use the Page Editor to make settings
for objects.

4-3 Creating Pages on page
4-20

Code Editor

You can use Visual Basic to create subroutines.

4-5 Subroutines on page 4-50

NA-series Programmable Terminal Software User’s Manual (V118)
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2 Basic Sysmac Studio Operations

2-4-3

2-4-4

2-4-5

2-4-6

Item Description Reference
Search and Replace You can search and replace strings in project 4-6 Search and Replace on
data. page 4-57
Cross Reference Searches the area where the search target is 4-7 Cross References on
allocated, and displays a list. page 4-58

Build Build HMI

Convert the project into a form that the HMI can
execute.

IncrementalBuild
HMI

Builds only parts that were changed since the
last build.

Abort Build

You can abort a build operation.

Resource Usage

You can display the resource usage.

4-8 Building on page 4-59

Library Functions

Reference

Item Description
Toolbox You can register objects that you have created
and then reuse them.
IAG You can output an IAG that you created in an

IAG project as an |IAG collection, to use it in
another project.

Section 9 Reusing Objects

Operations for Debugging

Item

Description

Reference

Monitoring

You can monitor variables during project execu-
tion.

You can monitor the present values of HMI
global variables. You use the Watch Tab Page
for monitoring.

Section 7 Debugging

Changing the Present Values
of Variables

You can change the present values of global
variables and system-defined variables.

You can do this on a Watch Tab Page.

Section 7 Debugging

Controlling Execution with
Breakpoints and Step Execu-
tion

You can control simulation execution to monitor
the program or to check operation.
Step execution and pausing are also possible.

Section 7 Debugging

Communications

Item

Description

Reference

Going Online with an HMI

You can place the computer online with an HMI
to synchronize the project.

Section 6 Connecting to the
HMI

Security Measures

Item Description Reference
Prevention of Confirming HMI If the device name or the serial ID is different 3-5 Security Settings
Incorrect Con- device Names and | between the project and the HMI when an on page 3-19

nections Serial IDs

dialog box is displayed.

online connection is established, a confirmation
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2 Basic Sysmac Studio Operations

2-4-7

2-4-8

Item Description Reference
Preventing Incor- | Operation Author- | You can use operation authorities to restrict the
rect Operation ity Verification ability to perform operations or display data.
Prevention of the | Password Protec- | You can set password protection for project files
Theft of Assets tion for Project to protect your assets.
Files
Recording oper- | Operation Log You can record logs when operations specified
ations on the NA unit are executed.
Online Help
Item Description Reference
Sysmac Studio Help System | You can access Sysmac Studio operating pro-
cedures.
Keyboard Mapping Reference | You can display a list of convenient shortcut
keys that you can use on the Sysmac Studio.
Project Management Functions
ltem Description Reference

Image File Output

You can output a page as an image file. You can
set any page to be output.

11-3 Image File Output on
page 11-6

Import/Export User Alarm

You can import or export user alarms.

11-4 Import/Export User
Alarm on page 11-7

Import/Export Resources

You can import or export resource general
strings and alarm strings.

11-5 Import/Export Resources
on page 11-13

Import/Export Object Proper-
ties

You can import or export object text and vari-
ables on pages, and expressions.

11-6 Import/Export Object
Properties on page 11-20

Import/Export Pages

You can import or export pages and
page-related settings.

11-7 Importing/Exporting
Pages on page 11-24

NA-series Programmable Terminal Software User’s Manual (V118)
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2 Basic Sysmac Studio Operations

2-5 Basic Operations for HMI Projects

|
This section describes how to create and save projects and perform other basic operations to use

HMIs.

2-5-1 Creating a Project File from the Start Page

Use the following procedure to create a project file from the Start Page.

1 Click the New Project Button in the Start Page.

S5y sue ==

Start Page

Sysmac Studio
Aus tion 'ware

e S S S S IS S A i
The Project Properties Dialog Box is displayed. The following table gives the functions of the

buttons.
Menu command Description
New Project Button Creates a project file.
Open Project Button Opens an existing project file.

2 Enter the project name, author, and comment in the Project Properties Dialog Box, select HM/
from the device category, and then click the Create Button. (Only the project name is required.)

B sysmac Studio [l o=

[ Project Properties

ine
Projectname [
[@@ Open Project Author
&F Import..
— -
Online

Standard Project ~

4 Connect to Device

Version Control -
[& Version Control Explorer Bj Select Device
i (i) Controller
License
NJ501

Create

You can change the properties later. Refer to the Sysmac Studio Version 1 Operation Manual
(Cat. No. W504).

A project file is created and the following window is displayed.
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2 Basic Sysmac Studio Operations

"E| New Project - HMILNAS 0 - Sysmac Studio ==

HMLNAS_0 v |n|

: [ 3
» Configurations and Setup

b HMD

Buttons

Lamps

Shapes

Standard Controls
Gauges

HMI Controls

‘Custom

Blowers
Conveyors
Flags

Flow Meters

Output

>
>

»

>

>

>

>

> Arrows
>

>

>

>

» Hoppers
>
>

B Filter
A project file is created with the specified device already inserted.
Multiview Explorer

HMLNAS_0

p Configurations and Setup
» HMI

2-5-2 Adding an HMI to an Existing Project

Right-click the Controller Icon and select Add Device from the menu.

Derive Device 3
Change Device

Rename

Delete

Property

Switch Device Control Display

Or, select the device directly from the Insert Menu.
Example: HMI - NA5: The Add Device Dialog Box is displayed.

1] .
BR Select Device

Category HMI v
Device [ v - 12wWiolg v
Version 1.00 -

0K Cancel

Select the device and then click the OK Button. The device is added to the project.
new_Controller 0 = | l

To change the target device, select a device from the list.

new_Controller_ 0
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2 Basic Sysmac Studio Operations

2-5-3 Changing Devices

Right-click the HMI Icon and select Change Device from the menu. Or, select Change Device from the
HMI Menu.

HMINA5 0 v
= Add Device

-
L = Rename

Delete

Import

Export

Switch Device Control Display

guag:

A, Lang s
The Change Device Dialog Box is displayed.

Change Device

'-Eﬁ Select Device

Categary HMI
Device MNAS v - 12Wi0iO +
Version 1.00 v

Select the device and then click the OK Button. The device is changed.

M Precautions for Correct Use

+ If you change the device, the settings for functions that are not supported by the new model
will be lost.

« If you change to a model that has a different display size, the objects will be enlarged or
reduced according to the new display size. However, elements other than objects, such as
font sizes, will not change.

| HMI Versions

Set the version when you create a new HMI project or when you add an HMI to an existing project.

You can set the version to the runtime version of the HMI that you are using. You can program and
make settings within the ranges that are supported for the runtime version. If you attempt to use func-
tions that are not supported by the runtime version that you set, you will not be able to use them or
errors will occur.
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% Additional Information

When you open the project that was created in past versions of the Sysmac Studio version 1.11
or higher, it will be converted as follows.

sjoaloid |INH 410} suonesadQ siseg G-Z

Runtime Sysmac Studio

\{,e;fs(::’: V1.1 V1.18 V1.24 | V1.27 V1.32 | V1.43

conver- | V110 | 02 | VA3 [ V144 | V145 | V116 | V147 | to | V123 | or or V131 | or or

sion V1.22 V1.26 | V1.30 V1.42 | later

1.00 1.00 [1.01"{1.02"7|1.03" [1.03"2|1.03""|1.03" [ 1.03" | 1.03"" | 1.03"" [ 1.03™ | 1.03"" | 1.03"" | 1.03"

1.01 — 101 [1.02"]1.03|1.03"2[1.03"|1.03"|1.03"" | 1.03"|1.03" | 1.03"" | 1.03"" | 1.03"" | 1.03""

102 |— |— 1.02 1.03{1.03""2|1.03" [ 1.03"|1.03"" | 1.03"" [ 1.03" | 1.03"" | 1.03"" | 1.03™ | 1.03""

1.03 |— |— — 1.03 [1.032 |1.03 [1.03""[1.03""|1.03"|1.03"" [1.03™"|1.03""|1.03" | 1.03™

104 |— |— |— — —2  11.04 [1.04 |1.04 |1.04 [1.04 [1.04 |1.04 |1.04 |1.04

105 |— |— |— |— — 1.05 |1.05 |[1.05 [1.05 [1.05 |1.05 |1.05 [1.05 [1.05 N
106 |— |— |— — — — 1.06 |1.06 |1.06 [1.06 [1.06 |1.06 |1.06 |1.06 A
107 |— |— |— — — — 1.07 |1.07 |1.07 [1.07 [1.07 |1.07 |1.07 |1.07 §
108 |— |— |— — — — — 1.08 |1.08 |1.08 [1.08 [1.08 |1.08 |1.08 <§
109 |[— |— |— — — — - = 1.09 [1.09 [1.09 |1.09 [1.09 |[1.09 S
110 |— |— |— — — — - = |- 110 |1.10 |1.10 [1.10 [1.10 %
1.1 — |- |- — — — - = = |- 111 111 111 [ 1.1 @
112 |— |— |— — — — — — = |- — 112|112 [1.12

113 |— |— |— |— — — — - = |- — — 113 [1.13

114 |— |— |— |— — — — - = |- |- — — 1.14

*1. The runtime version will be converted.
*2. The runtime version will be converted to 1.04 if the HMI Extended Option is enabled.

NA-series Programmable Terminal Software User’s Manual (V118) 2-17
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2-5-4 Importing and Exporting Devices

Right-click the HMI Icon and select Import or Export from the menu.

@ Additional Information

You cannot execute exporting devices if an error exists in the project.

I Importing Devices

Use the following procedure to import a device.

1 Right-click the HMI Icon and select Import from the menu.

1
HMI_NA5 0 v H=H

Add Device
Change Device

Al Configurations and Setup

Rename
e/ Delete
Export
Switch Device Control Display

2 Click Browse.

B 1mport X

Perform device import.

Option

Relink internal devices in the project.

Apply default v

3 Select the file and click Open.

B Import solution ==
%v\@ » Libraries b Documents » ~ [ 43 || Search Documents 2

Organize = New folder =~ 0 @

o -
¢ Favorites — Documents library e
M Desktop Includes: 2 locations

i Downloads Name Date modified Type
% Recent Places

| HMI_NAS 0.edh 5/29/2018 3:55 AM  EDH File

54 Libraries
= Documents 3
J’ Music
&) Pictures

B Videos

1% Computer L
&, Local Disk (C)
=5 RECOVERY (D:)
= HD-CBUZ (F)

3

File name: HMI_NAS 0.edh ~ | Sysmac Studio HMI Device file

e i
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4 Set the options as required and click Execute.

Import X

Perform device import.

(o7 e G C:¥Users¥0Omron¥Documents¥HMI_NAS_O.edh Browse

Option

Relink internal devices in the

syoofoad |INH 103 suonesadQ siseg G-

Execute

saoIneQ Buiodx3g pue Buiodw| $-G-g
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I Exporting Devices

Use the following procedure to export a device.

1 Right-click the HMI Icon and select Export from the menu.

HMILNA50 v ! .
==  Add Device

b Configurations and Setup Change Device

¥ &l Dev Lef
¥ 5l Internal

Rename
Delete
Import

T = Switch Device Control Display

2 Ciick Browse.

B Export X

Perform device export.

3 Select the file and click Save.

B Export file ==
%v\ (5 » Libraries » Documents » « | 44| [ Search Docurnents 2]
Organize »  New folder = @

¢ Favorites Documents library e Falder =
B Deskiop Includes: 2 locations
% Downloads Name Date modified Type
E‘l Recent Places
= No items match your search.
54 Libraries
[ Documents
&' Music
&5 Pictures
B# Videos
1% Computer
&, Local Disk (C)
s [ i, 3
File name: | [gIZSNESRURTT) -
Save as type: lSrysma.: Studio HMI Device file (".edh) V]

) ide otdens =

4 Click Execute.

58] Export *

Perform device export.

[0 T C:¥Users¥Omron¥Documents¥HMI_NAS_0.edh Browse

Execute
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HMI Configuration and Setup
]

This section describes how to configure and set up HMIs on the Sysmac Studio, includ-
ing mapping variables with connected devices and HMI settings.

3-1 Outline of Configurationsand Setup ................ ... ... ... 3-2
3-1-1  Connected Device Registration and Variable Mapping . ... ............... 3-2
3-2 DeviceReferences . .........c.oiiiiiiiiii ittt 3-3
3-2-1  Typesof Connected Devices ........ ...t 3-3
3-2-2  Connected Devices in the Current Project . ......... ... ... ... ... ..... 3-3
3-2-3  Registering External Connected Devices ............... . ... ioinn. 3-4
3-3 Mapping Variables .......... ... e 3-7
3-3-1  Mapping Variables . ........ .. . .. 3-7
3-3-2  Opening the Variable Mapping Tab Page and Tab Page Parts ... .......... 3-7
3-3-3 Variable Mapping Methods . .......... .. .. .. 3-8
3-4 HMISettings ....... ..ot ittt e s e ane s 3-10
3-4-1 HMISettings ... ..o 3-10
3-4-2  Device Settings . .. ... 3-11
3-4-3  TCP/IP Settings .. ...\ttt 3-13
3-4-4  FTP Settings . . ..ot 3-14
3-4-5 NTP Settings . . ... oo 3-15
3-4-6  FINS Settings . ... .o e 3-16
3-4-7 VNC Settings . ... ... 3-17
3-4-8  Printing Settings .. ... ... 3-18
3-5 Security Settings .......... .. i e e 3-19
3-6 Troubleshooter .......... ...ttt iinaaenanennn 3-20
3-7 Language Settings .......... ...t e 3-21
3-8 OperationLog Settings .......... ... i 3-22
39 HMICIoCK . ... .o et e s aaaens 3-25
310 Updatingthe HMIName . . .......... ... ..t i eenns 3-26
3-11 Write Protectingthe HMI .. ........ ... ... . . .. i, 3-27
3-12Clear AlIMemMOry ... ... i e e e 3-28
313 Resettingthe HMI .. ....... .. ... i e 3-29
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3 HMI Configuration and Setup

3-1 Outline of Configurations and Setup

This section describes how to set up HMIs and connected devices, such as Controllers and PLCs. The
following items are provided in the HMI Configurations and Setup.

Item Description
Device References You can set up connected devices and import variables.
Variable Mapping You can assign HMI variables to the variables in the connected devices.
HMI Settings These are the parameters related to the HMI.
Security Settings You can set up restrictions to operations on HMis.
Troubleshooter You can set parameters for the Troubleshooter.
Language Settings You can make settings for multi-language projects.
Operation Log Settings | These are used for an Operation Log.

3-1-1 Connected Device Registration and Variable Mapping

Device references must be set only to connect to external devices that are not registered in the current
project. They are not necessary to connect to a Controller that is registered in the current project.

The following figure shows the relationship between connected device references and variable map-
ping.
The HMI global variables are mapped to the connected device variables.

To access variables in the connected devices from an HMI, you must map the variables.

Sysmac Studio Project

Pages
Page 1 |~
Page 0
. Object Properties
Object -
D // Behaviour | e
Expression \Controller0_aa
(E) Selectable
HMI Global Variable Table _m Variable Map m_Connected Device References
’V R bae [ ara 10 (C)Mapping Global variables of connected devices External device
( ngt;ollero_aaa gl§o|ean Position Data type 3 ( M%me E?at? type
nteger Controller] aaaBoolearControl ler0_aaa aaa oolean
bbb | Integer| Controf TergEbbb Integer (1) Variables copied through the cipboard rom other
projepis or vaﬂables imported by accessing the
(D) Automatic registration physical device (PLC or Conlroller)
(importing comnected
Selectable device variables
(B) Automattic registration ;) e automafaly ot fom Cotolrs n e prjet
Internal
device

(A) Connected device variables are a) automatically imported from the same project or b) copied from
another project or manually imported from an external device or a file, such as an Excel file.

(B) The connected device variables are automatically registered in the variable mappings.

(C)  The HMI global variables are mapped to the connected device variables.

(D)  The mapped HMI global variables are automatically registered in the global variable table of the HMI.
(E)  You specify HMI global variables in the object properties.
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3 HMI Configuration and Setup

3-2 Device References

This section describes how to set up HMIs and connected devices, such as Controllers and PLCs.

3-2-1 Types of Connected Devices

Different operations are used to connect to Controllers that are registered and Controllers that are not

registered in the current project.

+ Controllers that are already registered in the current project are automatically registered in the HMI
project as internal connected devices.

» To connect to a device that is not registered in the current HMI project, you must register the device
as an external connected device.

S9OUBIDJOY 92IN8(Q Z-C

@ Additional Information

If you upload a project that includes Controllers registered as internal connected devices to a
project in which the Controllers are not registered, the devices are registered as internal con-
nected devices that do not have links to Controllers. Refer to 8-1 Synchronizing Projects on
page 8-2 for details.

3-2-2 Connected Devices in the Current Project

Se0IA8( P8JosuUU0) JO s8dAl |-Z-€

Controllers that are registered in the current project are displayed as connected devices. Use the fol-
lowing procedure to display the device settings if you need to check them.

1 Click Device References under Configurations and Setup in the Multiview Explorer.
2 The Controllers that are registered in the current project are displayed under Internal Device.

3 Double-click the project to display the following Device Configuration Tab Page.
B New Project - HMI_NAS_0 - Sysmac Studio | =Sl =

File Edit View Insert Project HMI Simulation Tools Help

IS ax @ @ E e 5 4, s .
Multiview Explorer ~ 1 _new_ConlmIler_ﬂ b -

¥ Device Configuration

minaso v ]

Device Configuraion ———— ~Communications Configuration

¥ Configurations and Setup Device Name new_Controller_0 Ei Use the IP address configured on the internal device

¥ | Device References Device Vendor Omeal IP Address 192 . 168 . 250 . __1
¥ 8 Itemal Devices | peyie Seres p— seconds

- > o ication Drivi S Ei Communication Error Indication
+* Variable Mapping ‘Communication Driver Ethernet

L1 HMI Settings
&, Security Settings
A, Language Settings
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3-2-3 Registering External Connected Devices

To connect the HMI to a device that is not registered in the current HMI project, you must register the

device as an external connected device. The procedures to register and set up external connected
devices are given below.

I Registering and Setting Up External Connected Devices

This section describes how to register and set up external connected devices.

1 Right-click Device References under Configurations and Setup in the Multiview Explorer.

=1
HMI_NA5_0 v ]I

¥ .. Dewvice References
# Intenal Devices | Add ¥
«* Vanable Mapping

2 Select Add - ExternalDevice. The device is added as ExternalDeviceld, where O is a serial
number starting from 0.

—T
HMI_NAS_0 v I

¥ Configurations and Setup

W . Device References

@ Internal Devices

+* Variable Mapping

3 Double-click the new ExternalDevicel.

E‘ New Project - HMI_NAS_0 - Sysmac Studio

G a
Multiview Explorer -1

HMINA5 0 | I.J ~Device Configuration ~Communications Configuration

Device Name © IP Address @ Route Path
Device Vendor Omron v 1P Address E
Device Series fol] v Timeout seconds

Communication Driver | CIP Ethernet v Encading us-ascii v

£ Communication Error Indication

~Data Types

Update HMI data types with any changes that have been made on this device reference

Update

Importing

Impaort variable and data type information from a physical device

Import variable information from a file

Import

Status of last 5 import attempts [Not Imported.

Output
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3 HMI Configuration and Setup

4 Select the vendor of the required device in the Device Vendor Box under Device Configura-
tion. The device series of the selected vendor is displayed. Make the selections for the required
device. The device communications drivers of the vendor selected for the device series are dis-
played. Select the communications driver for the required device.

~Device Configuraion ———————— ~Communications Configuration

Device Name ExternalDevice 1P Address ... ]
Device Vendor Omron o Timeout seconds

Device Series NJ v Ei Communication Error Indication

Communication Driver Ethernet v

~Data Types

Update HMI data types with any changes that have been made on this device reference
Update

Importing

Import variable and data type information from a physical device

S9OUBIDJOY 92IN8(Q Z-C

Import variable information from a file

Import

w

Status of last 5 import attempts  Not Imported.

5 Make the required settings in the Communications Configuration Area. Refer to the NA-series
Programmable Terminal Device Connection User’s Manual (Cat. No. V119) for details.

~Device Configuration ————— ~Communications Configuration

Device Name ExternalDeviced 1P Address 192 .168.250 . 1|
Device Vendor Omron v || Timeout seconds

Device Series NJ v E Communication Error Indication

Communication Driver Ethemnet i

~Data Types
Update HMI data types with any changes that have been made on this device reference
Update

Importing

Import variable and data type information from a physical device

Tmport Update

Import variable information from a file

Import

Se0IA8(] PejosuU0) [euselx] BuueisiBey ¢€-z-¢

Status of last 5 import attempts [Not Imported.
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I Importing External Connected Device Variables

To connect the HMI to a device that is not registered in the current HMI project, you must import the
variables from the external connected device.

There are three ways to import external connected device variables.

+ Importing device variables online from the actual external connected device
» Copying variables from the variable table in another project

* Importing variables from an Excel or CXT file

® Importing Device Variables Online from the Actual External Connected
Device

Click the Import Variables Button. The variables are imported from the external connected device.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119)
for details.

® Copying Variables from the Variable Table in Another Project

You can use the clipboard to copy the required variables from the Support Software for the con-
nected device and paste them in the device variables table for the external connected device. How-
ever, you cannot copy connected device variables if they are structure variables.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119)
for details.

® Importing Variables from an Excel or CXT File

Click the Import from File Button. The variables are imported for the external connected device.
Refer to the NA-series Programmable Terminal Device Connection User's Manual (Cat. No. V119)
for details.

I Updating Device Variables

If you change the variables on a device, update the device variables in the HMI project as required.

There are three ways to update device variables.

» Updating device variables online from the actual external connected device
» Copying variables from the variable table in another project

 Importing variables from an Excel or CXT file

® Updating Device Variables Online from the Actual External Connected Device

Click the Update Variables Button. The differences between the variables on the external con-
nected device and the device variables in the HMI project are displayed. Select the variables to
update.

® Copying Variables from the Variable Table in Another Project
You can use the clipboard to copy the required variables from the Support Software for the con-
nected device and paste them in the device variables table for the external connected device.

® Importing Variables from an Excel or CXT File

Click the Import from File Button. The differences between the variables in the Excel file and the
device variables in the HMI project are displayed. Select the variables to be updated.
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3-3 Mapping Variables

This section describes the settings required to access variables in connected devices through HMI
global variables.

w
&
3-3-1 Mapping Variables 5
T,
Mapping variables refers to assigning variables in devices connected to the HMI (called device vari- a
ables) to global variables in the HMI. Device variables are used on the HMI by assigning them to HMI §
global variables. g
Therefore, mapping variables is required. Not accessing device variables directly allows you to reuse 8
projects simply by changing the variable mappings.
3
Global variables that are assigned to device variables are called external variables.
b
3-3-2 Opening the Variable Mapping Tab Page and Tab Page Parts 5
E.
. . <
@ Additional Information %
o
You can also use a setting to map variables automatically. For details, refer to 77-1 Sysmac ]

Studio Option Settings on page 11-2.

1 Double-click Variable Mapping under Configurations and Setup.
The Variable Mapping Tab Page is displayed.

Position | Port | Data Type | Variable | Variable Comment
_& Configured Devices
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| Parts of the Window

No Item Description

1 Position Displays the IP addresses of the connected devices.

2 Port Displays the connected devices and device variables in a tree structure.

3 Data Type The data types of the device variables are displayed.

4 Variable You can set the name of a HMI global variable. You can use entry assistance to
select from a list of previously registered HMI global variables.

5 Variable Comment | You can set comments for the HMI global variables. These comments are also
applied to the global variable table. If comments are set for the device variable,
Comment " for the device variable is automatically applied.

*1. If there are multiple comments registered in internal variables, Comment 1 will be applied.

3-3-3 Variable Mapping Methods

To map variables, you can either create new global variables and assign them or you can assign previ-
ously created global variables.

To increase the reusability of the project, create the global variables first and then assign them.

However, if a device variable is a structure, you must create a new external variable during variable
mapping.

I Creating New External Variables

You can create a new global variable and assign it to a device variable.

When you create an external variable, you can either have the name generated automatically or you
can create it manually.

® Automatically Creating New Variable Names

Use the following procedure.

1 Select one or more device variables in the variable mappings, right-click, and select Create
Device Variable from the popup menu.

Position | Port | Data Type | VELEL] | Variable Comment
w ¥ Configured Devices
T 192.168. ¥ ' new_Controller_0
» System Variables
¥ User Variables
blnValuel
intValuel

Search
Expand/Collapse All

Create Device Variable

Mapping List

Automatically generated variable names are registered in the global variable table according to
the following rule.

Automatic generation rule: The device variable name is added after the controller name and
separated with an underline.
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® Manually Entering New Variable Names

Select the device variable and directly enter the variable name in the Variable column.

Selecting Previously Registered Global Variables and Mapping
Them

You can select global variables that are already registered in the global variable table and assign them
to device variables.

For example, this method can be used to map external variables in the following cases.
» Setting an HMI global variable first and then assigning it to a device variable
+ Creating a common project first and specifying connected devices later

Use the following procedure.
1 Register the global variables in the global variable table in advance.

2 When you map variables, you can select global variables from lists of variables that are already
registered in the global variable table and assign them to device variables.

Position | Port | DataType | VELEL | Variable Comment

¥ ¥ Configured Devices
T 192168 ¥ ' new_Controller_0
] P System Variables
: ¥ User Variables

binvaiuel — -
intValuel _HMI_CanEjectSDCard _
_HMI IsBatteryLow
_HMI IsDatalnput
_HMI IsPageSwitching
_HMI IsScreenSaverActive
_HMI_RunSignal

@ Additional Information

When the variables are mapped, the device variable comments are automatically set as global
variable comments.
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3-4 HMI Settings

This section describes the HMI settings.

3-4-1

HMI Settings

You can make settings for an HMI.

The following table lists the setting items.

Item

Description

When setting is required

Device Settings

There are page, screen saver,
brightness settings, and other set-
tings.

These settings are always required.

TCP/IP Settings These are the Ethernet settings for | These settings are always required.
TCP Ethernet ports 1 and 2
/1P P '
FTP Settings These are the FTP server settings. | These settings are required to use
FTP the FTP server.
NTP Settings These are the NTP client settings. These settings are required when
ATP you use an NTP client.

FINS Settings

These are the settings for FINS com-
munications.

These settings are required when
using FINS communications with a
CJ-series PLC.

VNC Settings

These are the VNC settings.

These settings are required to use
VNC.

Print Settings

B E E

These are the settings for printing
and capturing screens on the HMI.

These settings are required to print
or capture screens.

I Setting Procedure for HMI Settings

1 Double-click HMI Settings under Configurations and Setup in the Multiview Explorer. The
HMI Settings Tab Page is displayed in the Edit Pane.

2 Click the icons on the left to display the corresponding dialog boxes.
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3-4-2 Device Settings

These are the device settings.
[
= s

W Startup Page

¥ Startup Language

Startup language |English (United States)

w Software Keypads / USE Keyboard

USB Keyboard layout  English (United Kingdom) v

sbumes INH t-€

¥ Security
M Automatically log out user after period of inactivity.

¥ System Menu

w

Double-Tap Interval |15econd v

Top Left M Top Right
Detectable Comer k
H Bottom Left Bottom Right

¥ Screen Saver

Screen saver type | Disable Screen Saver R

¥ Screen Brightness

¥ Sound

sBumes soIneq zZ-t-¢

Touch Input Notification
Alarm Notification

Sound Type Continuous
Minimum Alarm Priority | User Fault Level 8
¥ Internal Retained Memory Settings
Maximum Number of User Alarm Logs [20000 ¥
¥ Global variable
The maximum number of STRING-type characters (default) n
w Safety Monitor

M Enable

Item Description
Startup Page
| Page name Sets the page to display first when the HMI is started.
Startup Language
| Startup language Sets the project language to use when the HMI is started.
Software Keypads/USB Keyboard
System Keypad Size Sets the display size of the system keypad.
USB Keyboard layout Sets the layout of the USB keyboard.
Security
Automatically log out user after Select this check box to automatically log out the user after a specified
period of inactivity. period of inactivity.
Inactivity period Specify the time of inactivity before the user is logged out automatically.
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Item

Description

System Menu

Double-tap Interval

Sets the interval to use to detect double taps.

Detectable corner

Select the corners in which to detect the operation to display the System

Menu.

Screen Saver

Screen saver type

Sets the type of screen saver.

Activate after

Sets the time after the screen is touched before the screen saver is
started.

Screen Brightness

Screen brightness

Sets the brightness of the screen.

Sound

Touch Input Notification

Sets whether to beep when an input is accepted.

Alarm Notification

Sets the buzzer that is beeped when an alarm occurs, specifically, the
type of buzzer and the user alarm level.

Internal Retained Memory Settings

Maximum Number of User Alarm
Logs

Sets the maximum number of alarm logs to save in the NA.

Global Variables

The maximum number of
STRING-type characters (default)

Sets the maximum number of characters allocated for a String Retain
variable when the maximum number of characters is not set.

Safety Monitor

Enable

Enables the Safety Monitor function.
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3-4-3 TCPI/IP Settings

These are the settings for TCP/IP.
_\ HMI Settings x >

TCP
= /1P

¥ Ethernet Port 1 - IP Address

1P Address

Subnet mask

Default gateway ;

¥ Ethernet Port 1 - DNS

primary DN server |
Secondary DNS server E
primary WINS server |
Secondary WINS server ;

¥ Ethernet Port 2 - IP Address

sbumes INH t-€

Ei Direct connection with Sysmac Studio

1 acress |
subne masc Y

¥ Ethernet Port 2 - DNS
Primary DNS server E
Secondary DNS server E
Primary WINS server E
Secondary WINS server E

w

sbumes dI/doL €-v-¢€

The following settings are provided for Ethernet port 1 and Ethernet port 2.

Item Description
Ethernet Port 1 - Settings

IP Address Sets the local IP address.

Subnet mask Sets the subnet mask.

Default gateway Sets the IP address of the default gateway. This setting is not required when
a default gateway is not used.

Primary DNS server Sets the IP address of the primary DNS server.

Secondary DNS server Sets the IP address of the secondary DNS server.

Primary WINS server Sets the IP address of the primary WINS server.

Secondary WINS server Sets the IP address of the secondary WINS server.

Ethernet Port 2 - Settings

Direct connection with Sys- Select this check box to connect Ethernet port 2 directly to the Sysmac Stu-

mac Studio dio without going through an Ethernet switch. If you select this check box,
the IP addresses and other settings for Ethernet port 2 are ignored.

IP Address Sets the local IP address.

Subnet mask Sets the subnet mask.

Default gateway Sets the IP address of the default gateway. This setting is not required when
a default gateway is not used.

Primary DNS server Sets the IP address of the primary DNS server.

Secondary DNS server Sets the IP address of the secondary DNS server.

Primary WINS server Sets the IP address of the primary WINS server.

Secondary WINS server Sets the IP address of the secondary WINS server.
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3-4-4 FTP Settings

These are the FTP server settings.
=]

=
FTP server O Donotuse @ Use
Login name |E—
password |

Item Description
FTP Settings
FTP server Specifies whether to use the FTP server of the HMI.
Login name Sets the login name to externally connect to Ethernet port 1 or 2 on the HMI
via FTP. You can use up to 12 alphanumeric characters.
Password Sets the password to use to externally connect to Ethernet port 1 or 2 via FTP.
You can use 8 to 32 alphanumeric characters.

3-14 NA-series Programmable Terminal Software User’s Manual (V118)



3 HMI Configuration and Setup

3-4-5 NTP Settings

These are the settings for an NTP (Network Time Protocol) client.

The HMI gets the clock information from the specified NTP server at the specified interval and updates
the built-in clock information.

| A 1 TP

B Synchronize with an Internet time server

ne server [

sbumes INH t-€

w

sbumes d1N S-v-¢

Item Description

NTP Settings

Synchronize with an Internet | Select this check box to synchronize the built-in clock in the HMI with the
time server clock information from the NTP server.

NTP server Sets the IP address of the NTP server.

Interval Sets the interval at which to get the clock information from the NTP server.
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3-4-6 FINS Settings

These are the settings for FINS communications.

These settings are required when FINS communications are used between the HMI and a CJ-series
PLC.

= H

¥ FINS Address
Network Node

¥ FINS/UDP

FINS/UDP port no

¥ Remote Network Table
Remote Network | Relay Network Relay Node

Item Description
FINS Address
Ethernet port #1 Sets the FINS network address of Ethernet port 1.
The FINS node address is automatically created from the IP address.
Ethernet port #2 Sets the FINS network address of Ethernet port 2.
The FINS node address is automatically created from the IP address.
FINS/UDP
FINS/UDP port no Displays the port number used for FINS/UDP.
Remote Network Table Sets the routing table.
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3-4-7 VNC Settings

These are the settings for VNC (Virtual Network Computing).
VNC implements a remote desktop to allow remote control of a computer located on a network.

You must enable the server functionality on the HMI to control. You can start the client software on the
computer from which to perform remote control, connect to the HMI, and then control it remotely.

= v
VNC Server ) Do notuse @ Use
Port No. =]
voce (I
password |
Enable VNC multiple login ) Disable @ Enable
Enable registered client login () Disable @ Enable

sbumes INH t-€

IP Address | MAC Address Comment

w

sbumes ONA L-v-€

Item Description
VNC Settings

VNC Server Specifies whether to use VNC.

Port No. Sets the port number.

Mode Sets the operations to enable from the VNC client.

Password Sets the password.

Enable VNC multiple login Specifies whether to allow multiple clients to log in.

Enable registered client login | Specifies whether to allow only certain clients to log in.

IP Address Registers the IP addresses of the client devices to be allowed
to log in.

MAC Address Registers the MAC addresses of the client devices to be allowed to log in.
(e.g., 3D:F2:C9:A6:B3:4F).

Comment Specifies a comment.
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3-4-8 Printing Settings

These are the settings for printing and capturing screens on the HMI.

You can capture screens displayed on the HMI.

¥ Printing Settings

Color Mode Color b
Print With Tile ) Without Title @ With Title

Item Description
Printing Settings

Color Mode Sets one of the following options for the number of colors or use of highlight-
ing:
» Color
» Grayscale
* Reverse Grayscale

Print With Title Sets whether to print the page title.
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3-5 Security Settings

These settings are used to restrict the operations that can be performed on the HMI and register
accounts.

I Setting Procedure for Security Settings

1 Double-click Security Settings under Configurations and Setup in the Multiview Explorer.
The Security Settings Tab Page is displayed in the Edit Pane.

sBumes fjundag G-¢

¥ User Accounts
Name ‘ Password ‘ Role ‘ Comment

Administrator R Administrator Default Administrator

w

¥ Roles and Access Levels

Role / Access Level | Level 1 | Level 2| Level 3| Level 4| Level 5|

Administrator 1 1 | | 1

+

¥ Security Settings

System Menu Level None ¥

Item Description
User Accounts Registers user accounts.
Roles and Access Levels Sets the access level for each role.
Security Settings Sets the level of operations to permit from the System Menu.
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3-6 Troubleshooter

These settings are used for the troubleshooter for the NJ/NX/NY series.

For details, refer to the NA-series Programmable Terminal Hardware User's Manual (Cat. No. V117) or
NA-series Programmable Terminal Hardware(-V1) User's Manual (Cat. No. V125).
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3-7 Language Settings

These settings are used for multi-language projects.

I Project Language and System Language

There are two languages on the HMI.
* Project Language
The project language is displayed for the project that you create.
+ System Language
The system language is displayed for the System Menu and for error messages displayed by the system.

The two language settings are managed as pairs. If you change the project language, the paired sys-
tem language will also change.

I Language Setting Procedure

1 Double-click Language Settings under Configurations and Setup in the Multiview Explorer.
The Language Settings Tab Page is displayed in the Edit Pane.

Number Item Description
(a) Adds a language to the language list.

(b)
()
(d)

Deletes the selected language from the language list.

Moves the selected language one position up in the language list.

Moves the selected language one position down in the language list.

ERERE

(e) Language List Displays a list of the languages. The language at the top of the

list is treated as the default language.

Project Languages Sets the project language.

System Languages Sets the system language.

Software Keypads Sets the software keypad to be used.

Transfer to Device Sets whether or not the language is transferred to the HMI.

FontFamily ™ Sets the font that is set by default when an object is created.

FontSize ™1 Sets the font size that is set by default when an object is created.

FontStyle ' Sets the font style that is set by default when an object is created.

*1. Only appears when the Runtime version is 1.11 or higher.

@ Additional Information

You can clear the selection of the Transfer to Device Check Box so that the language files are
not transferred to the HMI. You can use this to delete unnecessary languages depending on the
destination of the HMI.
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3-8 Operation Log Settings

These settings are used for an Operation Log.

@ Additional Information

To use the Operation Log, the media to save data specified in the Operation Log Settings must
be installed on the NA unit in a state where data can be written to it.

Il Start Operation Log

Target Device ) | New operation log file generation interval
Target Folder ; 9 — © Daily (from 00:00 - 23:59)

Operation when logging limit reach ific number of logs

Logging limit

Operation to be logged

Starting Runtime

Synchroni

Function

Changing project languag

Changing IME type d.

Operation locking Locking and unlocking an operation are logged.

Screen saver Start and end of the er are logged.

VNC Start and end of a communication with a client are logged.
FTP Server Start and end of a communication with a client are logged.

Recipe Writing and reading a recipe are |
Data logging Start and end of logging are logged.
Operation logging ging are logged.

tem setting Chang sYs tings is logged.

/Logout g of the user setting are logged.

System Menu 5 m Menu are k
Trouble Shooter Start and exit of the
[[] Operation Log Viewer Start and exit of peration Log Viewer ar:
[ Safety Monitor Start and exit Safety Monitor are log
[ Ladder Monitor Start and exit of the Ladder Monitor are logged.

O
(]
[
]
|
(]
|
(]
@
(]
]
]
@l
|
=
]
m
|

Batch settings for objects |

Item Description
Start Operation Log Activates or deactivates operation logging.
Target Device Specifies the media to save operation logs.
Target Folder Specifies the folder to save operation logs.

Operation when logging limit reached | Specifies the operation to execute when the number of logs to be saved
in the log file reaches its upper limit.

Logging limit Specifies the limit of the number of logs to be saved in a single log file.
New operation log file generation Specifies the conditions for generating new log files.

interval

Operations to be logged Sets the operations to be logged.

Batch settings for objects Sets all “Operation Log” of the properties of the object.
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® Subject Operations of Operation Log

The following system operations of the NA unit are subject to operation logging. Select the Opera-
tion to be logged Check Box in Operation Log Settings to record these to Operation Log.

Ot;)):rlztg;::;o Operation Description o
Starting Startup When the Runtime starts up. g
Runtime Exit When the Runtime stops. 2
Synchroniza- | Start Project Transfer When a project data transfer with the NA unit starts. %’.
tion Complete Project Transfer When a project data transfer with the NA unit completes. ,i
Function key | Function Key operation When a Function key is operated. 8
Language Set language When the project language is changed. g
switching g
IME change IME change When the IME type is changed. @
Operation Disable touch input When the input operation from the touch panel is disabled.
locking Enable touch input When the input operation from the touch panel is enabled.
Screen saver | Start screensaver When the screen saver starts.
End screensaver When the screen saver is exited.
VNC Connect to VNC server When a user logs in from a VNC client.
Disconnect VNC server When a VNC client logs out.
FTP Server Connect to FTP server When a user logs in from an FTP client.
Disconnect FTP server When an FTP client logs out.
FTP Client Connect with FTP Client When a user logs into the FTP server using the FTP client
function.
Disconnect with FTP Client | When a user logs out from the FTP server using the FTP client
function.
Recipe Write recipe When recipe data is written to the controller.
Read recipe When recipe data is loaded from the controller.
Data logging | Start Data logging When data logging starts.
Stop Data logging When data logging stops.
Operation Start Operation logging When operation logging starts.
Logging Stop Operation logging When operation logging stops.
System Change System settings When settings for the following items of the NA unit are
setting changed.
» Time
« Time zone
* NTP Settings
+ System Languages
+ Ethernet
* FTP Server
* VNC Server
* FINS
» Screen Brightness
Login/Logout | Login When a user logs in in a state where there is no user currently
logged in.
Logout When a user logs out.
Switch user When a user logs in in a state where there is a user currently
logged in.
System Menu | Show System Menu When the System Menu starts up.
Exit System Menu When the System Menu is exited.
Trouble Show Troubleshooter When the Troubleshooter starts up.
Shooter Exit Troubleshooter When the Troubleshooter is exited.
Operation log | Show Operation Log Viewer | When the Operation Log Viewer starts up.
Viewer Exit Operation Log Viewer When the Operation Log Viewer is exited.
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3-24

Operation to

o= ] Operation Description
Safety Show Safety Monitor When the Safety Monitor starts up.
Monitor Exit Safety Monitor When the Safety Monitor is exited.

® Subject Objects of Operation Log and Events to be Recorded

The subject objects of Operation Log and events to be recorded are shown below. Select the Oper-

ation Log Check Box in Properties of each object to record these to Operation Log.

Classification

Object

Events to be Recorded

Button

Button object

Click/Touch/Release

Momentary Button object

Click/Touch/Release

Set Button object

Click/Touch/Release

Reset Button object

Click/Touch/Release

Toggle Button object

Click/Touch/Release

Standard controls

CheckBox object

Click/Checked/Unchecked

Data Display object

Touch/Release

Data Edit object Release
DateTime object Touch/Release
DropDown object SelectionChanged

Image object

Touch/Release

Label object

Touch/Release

ListBox object

SelectionChanged

Radio Button object

Touch/Checked/Unchecked

Slider object

Release/LostMouseCapture/KeyUp/Val-
ueChanged

Tab Control object

SelectionChanged

Text Box object

Touch/Release

Shapes

Curve object Touch/Release
Ellipse object Touch/Release
Line object Touch/Release

Polygon object

Touch/Release

Polyline object

Touch/Release

Rectangle object

Touch/Release

Triangle object

Touch/Release
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3-9 HMI Clock

To set the clock in the HMI, select HMI Clock from the HMI Menu when you are online. Set the required
items and click the Apply Button to update the information in the HMI.

HMI Clock

~TimeZone

Computer
(UTC-08:00) Pacific Time (U5 & Canada) JERLULS

¥90ID INH 6-€

Date and time
Computer HMI

6/5/2014 6/5/2014 15,
== Synchronize with computer > =
12:14:51 03:12:12

w

Item Description
Time Zone
Computer Displays the time zone of the computer.
HMI Sets the time zone of the HMI
Automatically adjust clock for | Select this check box to enable automatically adjusting for daylight savings
DST time.
Date and time
Computer Displays the current date and time on the computer.
Synchronize with computer Updates the clock information on the HMI with the clock information from the
computer.
HMI Set the clock information on the HMI.
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3-10 Updating the HMI Name

To change the HMI name, select Update HMI Name from the HMI Menu when you are online.
A confirmation dialog box is displayed. To update the HMI name that is set in the project, click the Yes
Button.

Sysmac Studio

The HMI Unit named [HMIL_MAS_0] will be updated with the name from the project [HML_NAS5_1].
Do you want to continue? (Y/MN)
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3-11 Write Protecting the HMI

To write-protect the HMI, select Security - HMI Write Protection from the HMI Menu when you are
online.

A confirmation dialog box is displayed. Click the Yes Button to write-protect the HMI.

Hmi device write-protection is released.

A
ﬂ The Hmi device application CAN be changed.

Do you want to set the write protection? (Y/N)

IWH 2y} Bunoajoid M LL-€

Ves!]l\‘o

w

Only the project is write-protected. The project can still log data and write other data.
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3-12 Clear All Memory

You can initialize the HMI.

When you perform the Clear All Memory operation, all data is cleared except for time data. To clear all
memory in the HMI, select Clear All Memory from the HMI Menu when you are online.

A confirmation dialog box is displayed. Click the OK Button to clear all memory.

Clear All Memary
—Clear All Memory

This function initializes the target HMI to the factory default. All
memory, log data and settings will be cleared and reset to
default.

Confirm the target HMI, and press the OK button.

HMI Unit Name HMI_MNAS 0
Maodel NAS-9W0015
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3-13 Resetting the HMI

You can reset the HMI.

To reset the HMI, select Reset HMI Device from the HMI Menu when you are online. A confirmation
dialog box is displayed. Click the Yes Button to reset the HMI.

Sysmac Studio

This operation resets the HMI device. Make sure resetting will cause no problems for access to 5D Memory Card.

It goes offline after resetting.
Go online again after starting the HMI

INH dy3 Bumesay ¢i-¢

Do you want to reset? (Y/N)

w
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Creating the HMI Application

This section describes how to create the HMI application (pages, variables, subrou-
tines, etc.) with the Sysmac Studio.

41
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4-1 Registering Variables

4-1-1 Variables

A variable is a ‘container’ that holds data.

The HMI supports the following types of variables.
Variable type Description
Global variables Global variables are defined by the user and can be accessed from anywhere in the

project. You can register up to 35,000 total in the entire project and up to 30,000 for

each connected device."

Global variables are declared in the HMI global variable table.

Global variables include external variables and internal variables, which are
described below.

External variables External variables are global variables that are used to access data in Controllers
and other connected devices.

soa|qeliep Buliaysibay |-

External variables are assigned to device variables in the variable mapping.
Internal variables An internal variable can be used only within the HMI.

All global variables that are not external variables are internal variables.

S9|qeleA |-L-y

System-defined | System-defined variables are provided in advance in the HMI. The names and all
variables attributes are defined by the system. They have specific functions.
You cannot change the variable names or any other attributes of these variables.
Subroutine variables Subroutine variables are defined by the user and are used only within subroutines.

Subroutine variables are declared in Dim statements in page subroutines or global
subroutines.

You can use all of the data types that are supported by Visual Basic.

*1. For the Runtime version 1.02 or lower, the registerable numbers are up to 35,000 in the entire project, and up
to 20,000 for each connected device.
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4-1-2 Registering Global Variables

® Opening the Global Variable Tab Page

Double-click Global Variables under HMI - Data in the Multiview Explorer. Or, right-click Global
Variables under HMI - Data and select Edit from the menu.

p- [ Pages
P i User Alarms
» [ Controlle

P}E Data

B Reci

[=) Custom Keypads
¥ [ Data

> i Global Subroutines

B .7 Resources

The global variable table is displayed in the Edit Pane.

-

Name Data Type Initial Value AT Retain | Constant | Update Rate Comment

I L I I = T = —

The basic Sysmac Studio operations for the global variable table generally apply to HMIs. Refer to
the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for the basic operations.

However, the following items are different. Refer to 4-1-4 Attributes and Entry Methods for Global
Variables on page 4-10.

Item Description

Name There are specific prohibited characters that apply to HMIs.

Data Type There are specific data types for HMIs.

AT You can set the device variables to which to assign the global variables. This setting is
not used for internal variables.

Update Rate You can select the interval at which to get values from the connected device. This set-
ting is used only for external variables.

Scaling You can select a conversion expression for the value obtained from the connected
device. This setting is used only for an external variable.

@ Additional Information

Even if you change the name of a previously registered global variable, the name of the vari-
able accessed from objects or subroutines will not change.
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® Registering Global Variables from the Properties Window
Use the following procedure to add a global variable from the Properties Window for an object.

Example: Using the Properties Window for a Set Button

1 Open the Properties Window for the object, and enter a variable name in the Variable Box
under Behavior.

Button0

D SetButton -

varl

o e D

OnDe e 0

O ]

alFeedba Touch (Button) -

2 Click the + Button to the right of the variable name that you entered.

& o o I
¥ General
Name Button0

Type SetButton
» Appearance
¥ Behavior

IsEnabled Add Global variable
DoubleTouchTime  JREN ] arl

OnDelayTime Data Type Boolean
OffDelayTime

Comment
VisualFeedback
¥ Layout [F] Map to Controller Variable

» Position (Left, Top) |Add or Update Variable

» Size (Width,Height) 120, 40

A dialog box appears to add a global variable.

3 Set a data type in Data Type Box.
4 Enter a comment in the Comment Box.
5 Click the Add Variable Button.

This completes adding a variable.

@ Additional Information

* You can also create an array variable by specifying the data type as follows:

Add Global Variable X

Narme Var2_array

Data Type Boolean(2,3)

Comment

[C] Map to Controller Variable

|Add or Update Van'ablel

* You can add a variable the same way for an object for which an expression is specified under
Behavior in the Properties Window.
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4-1-3 Registering External Variables

I External Variables

External variables are global variables that are used to access data in connected devices.

I Creating External Variables

The following two methods can be used to create external variables.
+ In the variable mapping, map a global variable to a connected device variable.
* When creating a global variable, also register a variable in the device.

When using the variable mapping, you can create a new variable or select a previously created global
variable.

If you create a new external variable in the variable mapping, it will automatically be registered as a
global variable.

Refer to 3-3 Mapping Variables on page 3-7 for details on the variable mapping.

I Attributes of External Variables

If you create a new external variable in the variable mapping, the following attributes are registered for
it in the global variable table.

Refer to 4-1-5 System-defined Variables on page 4-14 for details on the attributes of variables.

Attribute Setting Chang.es fo set-
tings
Name Specified variable name Possible.
Data Type Refer to the NA-series Programmable Terminal Device Connection | Possible.
User’s Manual (Cat. No. V119) for details on data type for the HMI
global variables based on data types for device variable.
Initial Value None Not possible.
AT Device _name.Device variable_name Possible.
Retain Non-retained Not possible.
Constant None Not possible.
Update Rate 500 ms Possible.
Scaling None Possible.
Comment Specified comment Possible.
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® Registering External Variables from the Properties Window

Use the following procedure to add an external variable that is mapped to a Controller variable from
the object Properties Window.

Example: Using the Properties Window for a Set Button

1 Open the Properties Window for the object, and enter a variable name in the Variable Box
under Behavior.

IS
i

—

e Button0 g

«Q

D SetButton - ="

&

PP Ce 2

O é.

varl <

]

3

(=2

o e ] )

»n
OnDe e 1]
0 V]

alFeedba Touch (Button) -

2 Click the + Button to the right of the variable name that you entered.

& 2 e I

¥ General
Name Button0

Type SetButton
» Appearance
¥ Behavior

IsEnabled Add Global variable
DoubleTouchTime  NEINE Varl

OnDelayTime Data Type Boolean
OffDelayTime

sa|qeue) [eusa)xg buueisibey ¢-L-1

Comment
VisualFeedback
¥ Layout [F] Map to Controller Variable

(Left, Top) Add or Update Variable

width, Height) 120, 40

A dialog box appears to add a global variable.

Set a data type in Data Type Box.

Enter a comment in the Comment Box.

(S I SNt

Select the Map to Controller Variable Check Box.

Add Global Variable x
Name Varl

Data Type Boolean

Comment

Map to Controller Variable
Controller Variable Details
Device new_Controller_o -

Variable  var1

Data Type pooL -

Comment

Add or Update Variable
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6 Change the items in Controller Variable Details as needed.

Add Global Variable X
Name Varl
Data Type Boolean

Comment

Map to Controller Variable
Controller Variable Details
Device new_Controller_o -

Variable N3 vari

Data Type pooL -

Comment

Add or Update Variable

7 Click the add or update the global variable button.

Variables are added to the device and HMI, and are automatically mapped.

@ Additional Information

If an Array[0..3] of BOOL-type NJ_var1 array variable has already been registered in the
Controller, you can map the variable as an array variable by specifying the data type as fol-

lows:
Add Global Variable x
Name varl

Data Type Boolean(3)

Comment

Map to Controller Variable

Controller Variable Details

Device [ o

Variable  n3_vari

Data Type ARRAY[0..3] of BOOL -

Comment

[Add or Update Variable]

You can map a variable in the same way for an object for which an expression is specified
under Behavior in the Properties Window.

When registering variables from properties, comments entered in the dialog box are regis-

tered into variables of each device.
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4 Creating the HMI Application

® Registering External Variables from the Global Variable Table

Use the following procedure to add an external variable that is mapped to a Controller variable from
the Global Variable Table.

1 Double-click Global Variables under HMI - Data in the Multiview Explorer. Or, right-click Global
Variables under HMI - Data and select Edit from the menu.

B [iif) Pages
B i User Alarms
> |ﬂ Con
#z Data Logging
FE Data (
B B Recipes

¥ [ Data
L4 Data Types

so|qeliep Buuaysibay |-

sa|qeue) [eusa)xg buueisibey ¢-L-1

3 Right-click the variable and select Register To Controller from the menu.

| DataType | InitialValue | AT | Retain |Constant| UpdateRate | Scaling | Comment ||
Create New Ll L]

Cut

Copy

Delete

Register To Controller
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4 Creating the HMI Application

4 Change the items in Controller Variable Details as needed, and click Add or Update Variable.

[E=5 E=N 5
Add Global variable
Name Varl

Data Type Boolean

Comment

Controller Variable Details
Device new_Controller_0 -
Variable  ygr1
Data Type pooL -

Comment

[Add or Update Variablel

The global variable is registered in the controller.

Name Data Type | Initial Value | AT Retain ECw:\nstanl N sh Comment |

S I A I O A X

@ Additional Information

* You cannot register multiple variables at once.

* You cannot register structure, union, or enumeration variables that use data types defined on
the device.

* When registering variables from the Global Variable Table, comments entered in the dialog
box are registered into variables of each device.

4-1-4 Attributes and Entry Methods for Global Variables

This section describes attributes and entry methods for global variables.

I Attributes of Global Variables

® Name Attribute

Global Variables x

Enter a text string for the name. Observe the following restrictions.

You cannot use any symbols except for underscores.

The first letter cannot be a number.

The names are not case sensitive.

You cannot use names that start with “_ HMI”, “ eHMI_”, “ sHMI_”, “ uHMI_”, or “_SyxSPC_".
You cannot use names that are reserved for the Sysmac Studio or Visual Basic.

You cannot use more than 127 characters.

You cannot use three underscores in a row.

You cannot redundantly use names that are already used for a device name, global subroutine,
keypad, or page.
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4 Creating the HMI Application

® Data Type Attribute

Gamarvareoe] IR
1 Data Type I Initial Value | AT | Retain | Constant| UpdateRate | Scaling

T revCont | 0o Nore

Boolean

| Comment

Enter a data type directly or select one from the list.

You can use the following data types, which are supported by Visual Basic. Arrays of the data types that

are supported by Visual Basic are also supported. If you specify an array, specify the element number »
in parentheses after the data type in the same way as in Visual Basic. ;
1]
Q
Clas_smca- Data type Data type Size Range of values %
tion name 5
Basic data Boolean Boolean — True or False ‘i
types Byte Byte 1 byte 0 to 255 (unsigned) §
Char Char 2 bytes 0 to 65,535 (unsigned) %

Date Date 8 bytes 0:00:00 (midnight) on January 1, 0001 through

11:59:59 PM on December 31, 9999
Decimal Decimal 16 bytes | 0 through

+/-79,228,162,514,264,337,593,543,950,335
(+/-7.9...E+28) with no decimal point;

0 through +/-7.9228162514264337593543950335
with 28 places to the right of the decimal;

smallest nonzero number is
+/-0.0000000000000000000000000001 (+/-1E-28)
Double Double 8 bytes -1.79769313486231570E+308 through
-4.94065645841246544E-324 for negative values;

4.94065645841246544E-324 through
1.79769313486231570E+308 for positive values

s8|qeleA [BqO|D J0j SPOYIBIN AJug pue Senqupy - |-

Integer Integer 4 bytes -2,147,483,648 through 2,147,483,647 (signed)
Long Long 8 bytes -9,223,372,036,854,775,808 through
9,223,372,036,854,775,807 (9.2...E+18) (signed)
SByte SByte 1 byte -128 through 127 (signed)
Short Short 2 bytes -32,768 through 32,767 (signed)
Single Single 4 bytes -3.4028235E+38 through -1.401298E-45 for negative
values;
1.401298E-45 through 3.4028235E+38 for positive
values
String String Variable 0 to approximately 2 billion Unicode characters
length™® | (UTF-16)
Ulnteger Ulnteger 4 bytes 0 through 4,294,967,295 (unsigned)
ULong ULong 8 bytes 0 through 18,446,744,073,709,551,615 (1.8...E+19)
(unsigned)
UShort UShort 2 bytes 0 to 65,535 (unsigned)
Derivative TimeSpan Structure that gives a time interval
data types Structures/ This is a user-defined data type that integrates different data types into a single
Unions/ group.

Enumerations | yvoy can name the data type.

Specify the name of the variables that use the user-defined data type, and one
of the member variables included in the group.
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*1. The length is fixed only when a Retain variable is specified. The maximum number of characters is specified
with the following notation.

String[*maximum_number_of characters][(number_of array_elements)]

Values in square brackets [ ] may be omitted. If a Retain variable is specified and the maximum number of
characters is not set, the maximum number of variables specified under HMI Settings - Device Settings -
Global Variables applies.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119) for
information on which of the above HMI variable data types can be assigned to the data types of con-
nected device variables for different connected devices.

® Initial Value Attribute

Global Variables x

I Retain | Constant | UpdateRate | Scaling I Comment

MLVt ST oo s

Specify a value for the variable for one of the following situations when the Retain attribute is not
specified.

* When the power supply is turned ON
* When you specify to initialize the value when the project is transferred

Enter a value directly or select an item from the list (the values in the list depend on the data type).

Select None for no initial value. You cannot specify the Initial Value attribute for an external variable.

@ Additional Information

If the box is left blank, the initial value of the variable will be as follows:

Data type Initial value
Boolean, Byte, Char, Decimal, Double, Integer, Long, 0
SByte, Short, Single, Ulnteger, ULong, or UShort
String Blank
Date January 1, 0001, 0:00:00 (AM 0:00)

® AT Attribute

Global Variables x

Retain | Constant | Update Rate | I Comment

HMI binValuel O | O [500Milliseconds

This attribute is specified for external variables. Use the following format.

Device _name.Device variable_name
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® Retain Attribute

Glebal Variables X

1 Data Type I Initial Value | | Retain ||Constant| Update Rate | 1 Comment
Lbruel o rewon| (1 || 1 BWibecones here |

Specify whether to retain the value of the variable in the following cases.
* When the power supply is turned ON
* When you do not specify to initialize the value when the project is transferred

You cannot specify the Retain attribute for an external variable, structure variable, or union variable.

£~
You can specify up to 5,000 Retain variables (36,864 bytes). For version 1.08 or higher, a building ;
error occurs if the maximum number or maximum size is exceeded. The size depends on the data K]
type, as shown below. For String arrays, one element is counted as one variable. For example, Inte- g.
ger variable a(10) is counted as one variable, but String variable b(10) is counted as 10 variables. é
Data type Non-volatile memory consumption (bytes) s
Boolean 1 é_‘
Byte 1 2
Char 2
Date 8
Decimal 16
Double 8
Integer 4 »
Long 8 s
SByte 1 =z
Short 2 &
Single 4 g
String 2 x Number of characters + 3 gg)_
Ulnteger 4 o
ULong 8 é
UShort 2 g
TimeSpan 8 2
Structure Cannot be set. g
Union Cannot be set. %’
Enumeration 4 g
5
® Constant Attribute %’
(2]

Global Variables x

1 Data Type | Initial Value | AT I Comment

If you set the Constant attribute, you can set the initial value of the variable when the project is
downloaded, but you cannot overwrite the value afterward.

You cannot specify the Constant attribute for an external variable.
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® Update Rate Attribute

o

Data Type Initial Value Retain | Constgnt Update Rate Comment

500 Millisecor v

10 Minutes
30 Minutes
1 Hour

The update interval with the connected device is specified for external variables. If None is set for an
external variable, communications are only performed with the connected device when necessary.
Periodic communications are not performed. You do not need to specify this attribute for an internal
variable.

® Scaling

Specify a conversion expression to apply to the values of the connected device for external vari-
ables. The external variable for which scaling is set will be cast as the Double type. Therefore, it is
necessary to set Double in Data Type regardless of the data type of the device variable.

For information on setting the conversion expression, refer to 4-4-11 Registering Scaling on page
4-47.

® Comment Attribute

Data Type Initial Value Retain | Constant Update Rate Comment

Enter a comment. When the device variable comment is changed for an external device, the change
is automatically applied.

4-1-5 System-defined Variables

I System-defined Variables

System-defined variables are internal variables that are pre-defined by the system. All system-defined
variable attributes are fixed. The names and all other attributes of these variables are defined, and spe-
cial functions are assigned to them. You cannot change the names or any other attributes.

* You can use the system-defined variables for an HMI as soon as you register an HMI in the project. It
is not necessary to register system-defined variables in the global variable table.

» System-defined variables that are related to an HMI start with “_HMI_".

@ [ HMI_NarmsClearedMotick
@ _HMI_AlsrmsMNotAck
¢ _HMI_AllrmsRaised
& _HMI_Al{rmsRaisedNotick
4| _HMI_Brijghtness
nEjectSDCard

@\ _HMI_CyfrrentPage
@\ _HMI_ChrrentUserName
@ \HMI_flurrentUserRole H
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I System-defined Variables

® System-related Variables

Variable name Meaning Description Iti;a:)t: R/W
_HMI_Brightness Brightness Sets the brightness of the screen. Integer R/W
_HMI_CanEjectSDCard Can Eject SD Tells whether you can remove the SD | Boolean |R

Card Memory Card. I
True: Ejection is possible, False: Ejec- ;
tion is not possible. Q
_HMI_ConnectedVNCClient | Connected num- | Gives number of client via VNC. Integer R %
Count ber of VNC Client é'
_HMI_CurrentPage Current Page Sets the name of the currently dis- String R/W 5
Name played page. =
_HMI_CurrentPagelndex Current Page Sets the number of the currently dis- Integer R/W %
Number played page.
_HMI_DateTime System Time Gives the system clock time as the Date- R
local time. Time
_HMI_Hour Current Hour Gives the hour in the current time. Integer R
_HMI_IsBatteryLow Low Battery Volt- | Gives True if the battery voltage has Boolean | R N
age dropped below a specific level. ;
_HMI_IsDatalnput Data Entry in Gives True when a data entry objectis | Boolean |R »
Progress selected. )
_HMI_IsPageSwitching Page Switching in | Gives True while page switching pro- Boolean | R 3
Progress cessing is in progress and False after §
processing is completed. §
_HMI_IsScreenSaverActive | Screen Saver Sta- | Tells whether the screen saver is Boolean | R/W s
tus active. §_
True: Active, False: Not active. &
_HMI_ManagedRAMInUse | Usage of Man- Gives the total bytes of managed RAM | ULong R
aged RAM that is currently allocated to some pro-
cess.
_HMI_Millisecond Current Millisec- Gives the milliseconds in the current Integer R
onds time.
_HMI_Minute Current Minutes Gives the minutes in the current time. | Integer R
_HMI_RAMInUse Usage of RAM Gives the total bytes of RAM that is ULong R
currently allocated to some process.
_HMI_RAMTotal Total RAM Gives the total bytes of RAM that the ULong R
system is using or can use. This is not
the currently usable amount of RAM.
_HMI_RunSignal Run Signal Changes periodically while the HMI is | Boolean | R
operating.
_HMI_Second Current Seconds | Gives the seconds in the current time. | Integer R
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® Alarm-related Variables

Variable name Meaning Description Data
type
_HMI_AlarmCount Alarm Count Gives the total number of alarms that | Integer
have occurred, been cleared, or been
acknowledged. The value is initialized
when the alarm history is cleared.
_HMI_AlarmsClearedNotAck | Cleared Unac- Gives the number of alarms that are | Integer
knowledged cleared but not acknowledged.
Alarms
_HMI_AlarmsNotAck Unacknowledged | Gives the number of alarms that are | Integer
Alarm Count not acknowledged.
_HMI_AlarmsRaised Current Alarm Gives the number of current alarms. Integer
Count
_HMI_AlarmsRaisedNotAck | Unacknowledged | Gives the number of current alarms Integer
Current Alarm that are not acknowledged.
Count
® User and Security
Variable name Meaning Description Data
type
_HMI_CurrentUserName Current User Gives the name of the user that is cur- | String
Name rently logged in.
_HMI_CurrentUserRole Current User Gives the authority (role) of the user String
Authority that is currently logged in.

I System Enumeration Variable Table

The following table shows the enumeration variables that are used to control the HMI.

Enumerators are specified for input enumeration variables instead of numerical values.

Data type name

Description

_eHMI_ALARM_STATUS

Specifies the alarm status.
Acknowledged: Acknowledged
All: All

Cleared: Already cleared.

ClearedAckNotRequired: Already cleared and no need to
acknowledge.

ClearedAcknowledged: Already cleared and acknowledged.

ClearedUnacknowledged: Already cleared but not yet acknowl-
edged.

Raised: Raised.

RaisedAckNotRequired: Raised and no need to acknowledge.
RaisedAcknowledged: Raised and already acknowledged.
RaisedUnacknowledged: Raised but not yet acknowledged.

Unacknowledged: Not yet acknowledged.
Specifies the buzzer mode.

_eHMI_BUZZER_TYPE
ContinuousBuzzer: Continuous buzzer
IntermittentLongPulse: Intermittent long buzzer

IntermittentShortPulse: Intermittent short buzzer
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Data type name Description
_eHMI_COLUMN Specifies the column for sorting or filtering the user alarms
viewer.

AlarmCode: Alarm code

All: All

DateAndTime: Date and time
Group: Group

LoggedInUser: Logged-in user
Message: Message

Name: Name

Priority: Priority

Status: Status

ElapsedTime: Elapsed time
_eHMI_EXPOSETTYPE Specifies the search target of the Safety Monitor.

All: All variables
InputVariable: Input to Safety CPU

OutputVariable: Output from Safety CPU
_eHMI_FTPFileType Specifies the target when using an FTP client.

All: All

File: Files only

soa|qeliep Buliaysibay |-

Directory: Folders only
_eHMI_GRAPH_CURSOR Specifies the cursor for graphs.

Cursor1: Cursor 1

Cursor2: Cursor 2

SO|0eLEA PaULBP-WaISAS G-|-p

_eHMI_GRAPH_DIRECTION Specifies the direction of graphs.
Left: Left
Right: Right
_eHMI_GRAPH_ZOOM_TARGET Specifies the expansion mode for graphs.
Both: Both

Horizontal: Horizontal direction only

Vertical: Vertical direction only
_eHMI_IME_LANGUAGE Specifies the IME input mode.

CurrentSystemLanguage: System language

Japanese: Japanese

Korean: Korean

SimplifiedChinese: Simplified Chinese
TraditionalChinese: Traditional Chinese
_eHMI_KNOWN_PATH Specifies the medium.

SDCard: SD card

USBMemory: USB memory
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Data type name Description
_eHMI_PRIORITY Specifies the priority of the items to be displayed in the user
alarms viewer.
All: All

UserFaultLevel1: User alarm level 1
UserFaultLevel2: User alarm level 2
UserFaultLevel3: User alarm level 3
UserFaultLevel4: User alarm level 4
UserFaultLevel5: User alarm level 5
UserFaultLevel6: User alarm level 6
UserFaultLevel7: User alarm level 7
UserFaultLevel8: User alarm level 8

UserInformation: Information
_eHMI_SERVICE_STATE Specifies the state of the service.

Running: Running

Suspended: Suspended

_eHMI_SERVICE_TYPE Specifies the type of the service.
VNCServer: VNC server
_eHMI_SORT_ORDER Specifies the sort order of the user alarms viewer.

Ascending: Ascending

Descending: Descending
_eHMI_TROUBLESHOOTER_PAGE Specifies the screen displayed for the troubleshooter.

ActiveControllerEvents: Controller error list screen

ActiveUserEvents: User error list screen

ControllerEventLogs: Controller error log list screen

UserEventLogs: User error log list screen

I System Structure Variable Table

The following table shows the structure variables that are used to control the HMI.

Data type name Variable Data type Description
_sHMI_VNC_CLIENT_INFO Comment String Specifies a comment.
IPAddress String Specifies an IP address.
MACAddress String Specifies a MAC address.

4-1-6 Subroutine Variables

I Subroutine Variables

Subroutine variables can be used only with subroutines. Subroutine variables conform to Visual Basic
specifications.

Refer to the NA-series Subroutine Reference for details.
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4-2 Registering Data Types

® Registering Data Types
You can combine existing data types to define and register a new data type.

To use a data type that was registered with the Data Type Editor, just select it from the data types in
the Variable Editor. You can define data types that are structures or enumerations.

® Opening the Data Types Tab Page

1 Double-click Data Types under HMI - Data in the Multiview Explorer, or right-click Data Types
under HMI - Data and select Edit from the menu.

sadA] eyeq Bunvysibay z-

obal Variables =

& Global Ev
The Data Type Editor is displayed.

o -
I Name I Base Type I Comment I

Union

Enumerated

The basic operating procedures for the Data Type Editor are the same throughout the Sysmac Stu-
dio. For basic usage instructions, refer to the Sysmac Studio Version 1 Operation Manual (Cat. No.
W504). The differences are as follows:

* You cannot register unions.

* You cannot set the offset type, offset bytes, or offset bits.
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4-3 Creating Pages

One page represents one screen in the HMI project.

You can arrange various objects on a page to achieve the required functions.

There are two types of pages, as described in the following table.

Page Type in the Page Behavior Sizes (width and height) Application
Main Fixed for each model Basic pages
Pages can be layered.
You can specify a transparent color
and specify a background page.
Popup You can set the page sizes as long | Warning dialog boxes and other

as they are not larger than the main
page size.

applications

Main Pages

Popup Pages

The maximum
size is fixed.

You can specify
any size that is
not larger than
the maximum

size.

The maximum size is fixed.

® Main Pages

You can specify any
size that is not larger
than the maximum size.

The main pages are the basic pages. You can create applications to call popup pages from main
pages or move to other main pages. You can place up to 450 objects on one main page. You cannot
place more than one Trend Graph, Broken-line Graph, or Media Player object on one page.

You can create layers of main pages.

You can specify a background page to make the top layer transparent and place a specified page
underneath it. You can layer up to five pages including the main pages.

You can create a common page, e.g., with a toolbar, to display with all other pages and then specify
it as the background page so that you do not have to create it more than once.

Main pages

Page1 —»
Page2 —»
Page3 —»

® Popup Pages

Page 1: Transparent background
Page 2: Transparent background

Page 3: Background color

Popup pages are called from main pages. Use them to display warnings and other information. You
can place up to 450 objects on one popup page. The following limitations apply to popup pages.

* You cannot display multiple popup pages at the same time.
* You cannot place Trend Graph, Broken-line Graph, Tab Control, or Media Player objects on a

popup page.

» The background color Alpha is disregarded. For this reason, if a transparent color is set, it will be
drawn as a non-transparent color.
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4-3-1 Displaying Pages

Click Pages under HMI in the Multiview Explorer.

|T HMI |

The pages are displayed under Pages.

N
w
Q
8
4-3-2 Registering Pages 2
v
[
The project contains one page by default, and you can add more pages as required. E
I Registering New Pages
1 Right-click Pages under HMI and select Add - Page from the menu. IS
w
| o
Add » Page Group ]
B PageQ =
B ) User glarms %.
B2 Data Logging EU
A new page, Page1, is added under Pages. Lc:g

I Deleting Pages

1 Right-click the page to delete in the Multiview Explorer and select Delete from the menu.

A deletion confirmation dialog box is displayed.

4
a Are you sure you wish to delete the following item? Paged

Y=
Click the Yes Button. The page is deleted.
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I Copying and Pasting Pages

1 Select the page to copy in the Multiview Explorer and press the Ctrl + C Keys. Or, right-click the
page and select Copy from the menu.

¥ [if) Pages

View Page Editor

ode Editor
Rename
Delete

Cut

7l Imported IAGs

[ : Scale Transformations
"

The page is copied.

2 Select Pages in the Multiview Explorer and press the Ctrl + V Keys. Or, right-click Pages and
select Paste from the menu.

¥  Pages
BH Pagel

B i User Alarms

Bz Data Logging

Add »

The copied page is registered with “Copy_1_of " added to the front of the name of the page that
was copied. All of the objects on the page are also copied.

¥ HMI
¥ | Pages

B8 Pagel
B Copy_1 of Page0

@ Additional Information

* You can change the names of pages. Right-click the page and select Rename from the
menu.

« If you copy a page from another product and a page with the same name already exists, the
page will be named as a copy.

* When the page name is changed, the change is executed across the entire project. The
replace results are displayed in the Search and Replace Results Tab Page.

4 -22 NA-series Programmable Terminal Software User’s Manual (V118)



4-3-3 Page Property Settings

You can set properties for the pages.

I Setting Properties

4 Creating the HMI Application

1 Right-click in a location in the Edit Pane where there is no object and select Properties.

2 Set the properties for the page in the Properties Window that is displayed.

Item classifi-
cation

Property

Description

Main pages

Popup pages

General

Name

Sets the name of the
page. All names must be
unique.

OK

OK

Type

The object type is dis-
played. Page is displayed
for a page.

Display only

Display only

Appearance

Background Color

Sets the background
color. A transparent page
will automatically be set if
a background page is
specified.

OK

OK

Behavior

PageType

Sets the type of page.

OK

OK

BackgroundPage

Sets a page that is over-
lapped as the back-
ground.

OK

AutoNavigateKeypads

If you select this check
box, the keypad is auto-
matically displayed
according to the Data
Input Order settings.

OK

OK

DisplayMode

If you select Modal, no
operations are possible on
the main page while a
popup page is displayed.
If you select Modeless,
main page operations are
possible while a popup
page is displayed.

OK

Moveable

If you select this check
box, the popup page can
be moved.

OK

CloseOnPageChange

If you select this check
box, the popup page is
automatically closed when
the page is changed.

OK
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Item cl.assm- Property Description Main pages Popup pages
cation
Layout Position (Let, Top) Sets the display position | --- OK

of the popup page. If you
select Custom, the coor-
dinates of the top left cor-
ner of the page are
specified with (Left, Top).
Size (Width, Height) Sets the size of the page. | Display only OK
The maximum size is the
physical size of the
screen.

OK: Can be edited, Display only: Cannot be edited, ---: Property does not exist.

Click the arrowhead (IEI) at the right of each item to make selections.

If you select a popup for the behavior setting, you can increase and decrease the width and

height layout sizes with the arrowheads EI on the right side of the box after first selecting the
size to change (left: width, right: height).

¥ Behavior
PageType
DisplayMode

Maovable

CloseOnPageChange

AutoNavigateKeypads

¥ Layout

Position Center

¥ Size (Width Height)  [EEURELD)

Height

4h

240
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4-3-4 Editing Pages

You can arrange objects on the pages to achieve the required functions.

I Positioning Objects

Drag objects from the Toolbox to position them on a page.

[ New Project - HMILNAS_0 - Sysmac Studio =] ]
File Edit View Insst Project HMI Simulation Toals Help

Multiview Explorer

HMI_NAS_0 2

v
w Configurations and Setup
» {3 Device References ¥ Buttons
T HMI Settings
£, Security Settings [E Momentary Button
A Language Settings B3 Reset Button

¥ [ Pages

sabed Buneaiy ¢-p

Set Button

E  Toggle Bution

<) User Alarms > Lamps

Data Logging
£ Recipes P Shapes
» 7 Data
% Global Events
» & Global Subroutines > Gauges
5 Resources
7 IAG Resources

P Standard Controls

P HMI Controls

P Custom
Output > Arows

P Blowers

> Conveyors
Button
A Button object.

sebed Bunpg v-¢-v

H Filter

I Moving Objects

To move an object, click the object and drag it while the cross cursor is displayed.

I Resizing Objects

Click one of the resize handles around the object and drag it while the resizing cursor is displayed.
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I Rotating Objects

Click the rotation handle .~ to the upper right of the object and drag it while the angle is displayed in the
center of the object.

I Changing Object Labels

You can directly change the label of an object by selecting it and performing one of the following
operations.

* Press the F2 Key.

» Double-click the left mouse button.
* Right-click and select Edit.

* Click the Edit Button on the Toolbar.

The following objects are supported for this function:

« All the button objects including Buttons, Momentary Buttons, Set Buttons, Reset Buttons, and
Toggle Buttons

+ All the lamp objects including Bit Lamps and Data Lamps
» Label objects

+ Text Box objects

» Check Box objects

+ Radio Button objects
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I Duplicating Objects

You can create the specified number of duplicate objects in the vertical and/or horizontal direction
based on the selected object or objects.

You can also duplicate the object or objects by specifying an offset value for an array variable.

1 Select the object to duplicate.
To duplicate multiple objects at the same time, select all the objects to be duplicated.

2 Right-click the selected object and select Create Duplicate Objects... from the popup menu.

A dialog appears in the Edit Pane to specify object duplication. Specify the number of duplicate 2
objects and the direction. o
=~
(]
5 Create Duplicate Objects =R (=S ) 2
~Object Duplication Options ~Order of Newly Created Objects 8
Number of horizontal objects -
Horizontal spacing (pixels) _ | —> | g
Number of vertical objects 8
Vertical spacing (pixels) _
~Array Index Substitution
Variable Location Horizontal Increase | Vertical Increase
=
@
N
m
=
g:
«Q
R
O]
Q
[0]
7]

If a Value Other Than 0 Is Specified in the Horizontal Increase and Vertical Increase Box:

If an array variable has been specified for the object, you can duplicate the object by adding the
specified offset value to the element number.

I Set As Default

Changes the initial value of the object's properties.

Default value registration applies only to frequently used objects, such as buttons. Properties that have
a different setting for each object, such as variables, cannot be registered as a default value.

@ Additional Information

» The object default value is registered for each object type and managed as a project.

» The default values that have been set in a project property will be applied when the object
properties are set to initial values. For example, when an object is copied from one project to
another project, the default values set in the destination project will be applied to the initial
values of the object properties.
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® Changing default value

Follow the procedure below to set default value. The default value will be applied to the object's
properties if it has been set to the property details.

1 Set the object properties to the state you wish to set as default value.

T B 8 e I

¥ General

-

¥ Appearance

Design Rectangle =

Family
Hc'riznnta
verticalli [CRUS

(SREEIGIER 2, 2, 2, 2

2 Right-click the object and select Set As Default in the menu that appears.

Cut

Copy

Delete

Align

Flip

Edit

Create Duplicate Objects-—-

Grid 3

Add to Toolbox ‘

Set As Default

View Code ‘

Properties

3 An object with the same settings can be created by dragging and dropping the object from the
tool box.

| Toolbox

_<Search> -

¥ Buttons

Momentary Button

m
[ ResetButton

Set Button
Toggle Button
» Lamps

» Shapes
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® Returning the default value to the initial state

Follow the procedure below to return the default value to the initial state. Note that this proce-
dure returns the default value of all objects to the initial state.

1 Select Reset Default Value in the Project menu.

File Edit View Insert Project HMI Simulation Tools Window Help
Build HMI F&
IncrementalBuild HMI  Ctri+F8

Multiview Explorer

Resource usage

HMI_NAS 0 »
Reset Default Valus

| J Configurations and Setup

IAG Collections Manager Ctrl+8

2 A confirmation dialog box appears. Click OK.

sabed Buneaiy ¢-p

Reset Default Value

Do you want to reset the default value to the initial status?

Cancel

sebed Bunpg v-¢-v
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| Editing with the Toolbar

The functions that are commonly used to edit pages are provided in the Toolbar.

e English (United States) v

=Bl Code View
This button displays the Code Editor.

. Group

This button creates a group of objects.

. Ungroup

This button ungroups previously grouped objects.

B it

This button is used to edit graphic objects, labels of Button or Lamp objects, and other objects.

. Rotate Right 90 Degrees

This button rotates an object 90° clockwise.

. Rotate Left 90 Degrees
This button rotates an object 90° counterclockwise.

. Flip Vertical
This button flips a graphic object vertically.

. Flip Horizontal
This button flips a graphic object horizontally.

. Bring to Front
This button moves an object to the front.

. Bring Forward

This button moves an object toward the front.

. Send Backward
This button moves an object toward the back.

. Send to Back
This button moves an object to the back.

. Align Left

This button aligns the left edges of the selected objects.

. Align Center Horizontal
This button aligns the centers of the selected objects vertically.

. Align Right
This button aligns the right edges of the selected objects.
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. Align Top

This button aligns the top edges of the selected objects.

. Align Center Vertical
This button aligns the centers of the selected objects horizontally.

. Align Bottom
This button aligns the bottom edges of the selected objects.

. Distribute Horizontally
This button positions the centers of the objects at equal distances horizontally.

. Distribute Vertically
This button positions the centers of the objects at equal distances vertically.

sabed Buneaiy ¢-p

ﬂ To Previous Tab Page
This button displays the previous tab page.

E To Next Tab Page
This button displays the next tab page.

E Data Input Order Setting

This button changes the mode to the one to set data input order, and specifies the input order of
objects.

sebed Bunpg v-¢-v

Simulation Mode
This button changes the mode to the one to confirm object state.

Simulation Index

This button switches the index and lets you confirm the display state of objects.

English (United States) v Change Language

This box changes the project language that is displayed in the Edit Pane. When Display AllLan-
guages is selected, text in all languages is displayed at once.
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4-4 Setting Common Object Functions

This section describes the settings for functions that are shared by the entire HMI project.

The following functions are provided.

4-4-1

User alarms
Controller events
Data logging

Data groups
Recipes

Custom keypads
Global events
Global subroutines
Resources
Imported IAGs
Scale Transformations

Registering User Alarms

I User Alarms

You can specify conditions for specified variables to display user messages when the conditions are
met.

You can use this to record information when errors occur, when operation is started, etc.

I Registering a New User Alarm

You manage user alarms by group.

The groups are displayed in the User Alarms Viewer and are helpful in organizing information.

1 Right-click HMI under User Alarms in the Multiview Explorer and select Add - Group from the

menu.

» [if Pages
¥ <)

Import
Events Export
f2 Data Logging

H—E Data Groups

Group1 is added under User Alarms.

¥ HMI
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2 Double-click the new group.
A tab page to edit the group is displayed in the Edit Pane so that you can register user alarms.

AlarmID | Alarm Code| pression Priori Message | Popup | Acknowledge | Page
[ Vil

@ Additional Information

You can import or export the user alarm settings using the Excel workbook format. Refer to
11-4 Import/Export User Alarm on page 11-7.

suonoung 309[qo uowwon Bues v

I Deleting, Copying, and Pasting Groups

You can delete, copy, and paste groups using the same procedures as those that you use for pages.

4-4-2 Setting Controller Events

I Events

Events are the errors, changes of states, or user-defined occurrences that occur in the controller.
For details, refer to the NJ/NX-series CPU Unit Software User’s Manual (Cat. No. W501), NJ/NX-series
Troubleshooting Manual (Cat. No. W503), and NY-series Troubleshooting Manual (Cat. No. W564-E1).

SjuaAg Jajjouo) Bumes z-p-

I User Events

User events include the errors and information defined by users, and can be triggered by commands
from the controller.

You can specify on the NA's NJ/NX/NY-series troubleshooter, the user screens to be switched to
from the troubleshooter screen when a detailed user event of the controller is displayed.

NJ/NX Troubleshooter 7/2/2015 3:19:50 PM

Event Type |Error | | Back
Event Name [test_event |

Event Code 123 Date/Time 7/2/2015 3:28:12 PM

Group |

Event Level |User fault Level 1

Detailed Information
testtest2

Attached Info 1 [ox00

Attached Info 2 [ox00

Show Specified Page

Screen Shot Error Reset

RUN | new_Controller_0 (192.168.250.1)
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I Registering User Events

To switch a detailed user event screen of the troubleshooter to a user screen, you must specify the
event table for the controller and the transition destination screen that corresponds to each event.

1 Specify the event table of the user events in the project for the controller.

Multiview Explorer -1 B

new_Controller 0 v

Etl T

‘ l ‘ WEdit muitiple tabies [[Snguage

User fault Level 1]

-

\ 4 Configurations and Setup Event CodeEvent Name|{ Event Level |Group|

Details

User fault Level 1]

User fault Level 1]

User fault Level 1

2 Double-click User Events under HMI - Controller Events in the Multiview Explorer of the proj-
ect for the HMI, or right-click User Events under HMI - Controller Events and select Edit from

the menu.

HML NA5 0

4
_d Configurations and Setup
L4 HML

> [ Pages

Controller:  |new_Controller 0

Event Code | Event Name/Comment

Troubleshooter Associated Page
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3 Select the controller for which to perform the settings.
Select the target controller from the drop-down list at the top of the Edit Pane.

1b

Controller: ' new_Controller_0

Event Code | Event Name/Comment | Troubleshooter Associated Page

4 Right-click on the grid and select Add from the menu.

|b
Controller: |new_Controller_ 0 —

Event Code | Event Name/Comment | Troubleshooter Associated Page

suonoung 309[qo uowwon Bues v

5 Specify the event codes for the user events.
'|b
Controller: | new_Controller_0

Event Code | Event Name/Comment | Troubleshooter Associated Page

SjuaAg JajjouoD Bumes z-i-v

6 Specify the user screens to use as the transition destinations.
'|b

Controller:  |new_Controller 0

Event Code | Event Name/Comment | Troubleshooter Associated Page

1

I Deleting, Copying, and Pasting User Events

You can delete, copy, and paste user events using the same procedures as those that you use for
pages.
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4-4-3 Registration for Data Logging

I Data Logging

You can use data logging to store the changes in the values of specified variables over time.
You can display the saved data with Trend Graph objects. You can also save this data to external files.

I Registering a New Data Set

To log data, you must create one or more data sets. You can create different data sets to change the
location where the data is saved.

1 Right-click HMI - Data Logging in the Multiview Explorer and select Add - Data Set from the
menu.

b 5 Pages
b i) User Alarms

Data Logging
=, Recipes
P = Data

L Global Events

DataSet0 is added under Data Logging.

¥ HMI
b [ Pages
b i) User Alarms
¥  Data Logging
2 DataSetD

2 Double-click the new data set.

A tab page to make settings for the data set is displayed in the Edit Pane. You can set the vari-
ables to log, the storage locations, and other parameters.

Start New Database File
Storage Type

Target Device SD Memory Card

Target Folder \Data LoggingLog Files

Update Type Regular Interval

Update Rate 5 Seconds

Ei Automatically Start on HMI Device

Variable Data Type Comment

@ Additional Information

You can copy the data set settings to Excel or another spreadsheet application to edit the set-
tings.
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I Deleting, Copying, and Pasting Data Sets

You can delete, copy, and paste data sets using the same procedures as those that you use for pages.
4-4-4 Registering Data Groups

I Data Groups

You can register the data groups that are displayed as broken-line graphs.

You can register multiple series of data as a data group. You can also register multiple variables or
array variables in each data series.

suonoung 309[qo uowwon Bues v

I Registering a New Data Group

To display a broken-line graph, you must create a data group. A maximum of 32 groups can be regis-
tered. You can specify up to 20 series of data for a single group.

1 Right-click HMI - Data Groups in the Multiview Explorer and select Add - Data Groups form
the menu.

Ji=) Custom Keypads
¥ [ Data
DataGroup0 is added under Data Groups.

sdnoig) ejeq Buussibay -1

b [ Pages
B a1 User Alarms
> |ﬂ Controller Events

®=2 Data Logging
v H-E Data Groups
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2 Double-click the new data group.

A tab page to perform settings for the data group is displayed in the Edit Pane. You can specify
variables to be displayed, as well ad other parameters.

Data Series Data Type Comment

Data Type Comment

I Deleting, Copying, and Pasting Data Groups

You can delete, copy, and paste data groups using the same procedures as those that you use for
pages.
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4-4-5 Registering Recipes

I Recipes

A recipe is used to write data (numeric data or text strings) that was set in advance in the HMI to all of
the specified variables as a group or to read all of the specified variables as a group.

You can manipulate the registered recipe data with Recipe Viewer objects.

I Registering a New Recipe

To use recipes you must create them.

1 Right-click HMI - Recipe in the Multiview Explorer and select Add - Recipe Template from the
menu.

suonoung 309[qo uowwon Bues v

P [ Pages
b A User Alarms
Bz Data Logging

Resie Recipe Template

b 5 Data
L Global Events
b & Global Subroutines

Recipe0 is added under Recipes.

sadioay Bulielsibay G-y

¥ HMI
P [ Pages
P «i User Alarms
Pz Data Logging
Recipes
E Recipel

2 Double-click the new Recipe0. A tab page to make settings for Recipe0 is displayed in the Edit
Pane. You can set the variables to use and other parameters.

Ingredient Name Variable Default Value Min Value Max Value Visible | Editable

@ Additional Information

You can copy the recipe settings to Excel or another spreadsheet application to edit the set-
tings.

I Deleting, Copying, and Pasting Recipes

You can delete, copy, and paste recipes using the same procedures as those that you use for pages.
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4-4-6 Registering Custom Keypads

I Custom Keypads

You can specify the colors, layouts, and other properties of buttons to create keypads.

You can manage custom keypads by creating groups in which to register multiple keypads including
Boolean Keypad, Numeric Keypad, Hexadecimal Keypad, QWERTY Keypad, DateTime Keypad, and
TimeSpan Keypad.

I Registering a New Custom Keypad

To create a custom keypad, you must first create a custom keypad group. You can register up to 50
groups.

1 Right-click HMI - Custom Keypads in the Multiview Explorer and select Add - Custom Keypad
Group from the menu.

2 Right-click the new custom keypad group, and select Add and then select a custom keypad
from the menu.

Rename
nes  Delete

Cut

TimeSpan Keypad
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3 Double-click the new custom keypad.

A tab page to edit the custom keypad is displayed in the Edit Pane. You can set the layout,
design, and other parameters for the objects.

=g m English (United States) v

H
;
F=Y
(7
(]
=
=3
«Q
(2]
=)
3
3
o
=}
o)
g
D
(2]
~-*
M
f=
3
(2]
[=A
o
=]
(]

Clear ‘ | Alt ‘ |

I Applying a Custom Keypad

To use a custom keypad, you must specify the custom keypad group to use on the Language Settings
Tab Page.

1 Double-click Language Settings under Configuration and Setup in the Multiview Explorer.

2 Select a custom keypad group from the drop-down list of the Software Keypads in the Edit
Pane.

spedAay| woisn) Buusisibay 9-p-

Multiview Explorer

HMI_NA5_0
| System Languages | Software Keypads ‘ Transfer to Device ‘

Standard

Standard

Other languages
Project Languages | System Languages | Software Keypads | Transfer to Device |

Deleting, Copying, and Pasting Custom Keypads or Custom Keypad
Groups

You can delete, copy, and paste custom keypads or custom keypad groups using the same procedures
as those that you use for pages.
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4-4-7 Setting Global Events and Corresponding Actions

I Global Events

Global events occur at the project level and do not belong to any specific page.

When a global event occurs, the action that is assigned to the event is executed.

® Global Events
Global events include function key operations, changes in the values of variables, starting the proj-
ect, etc. A list of the events that you can set is provided in A-71 Events and Actions on page A-2.

® Actions

You can specify the action to perform when a global event occurs from a list of predefined actions.
Actions include executing global subroutines and other system-defined operations. A list of the
actions that you can set is provided in A-1 Events and Actions on page A-2.

I Setting Up Global Events

To set up a global event, you select the global event and then set the action to execute when the event
occurs.

1 Right-click HMI - Global Events in the Multiview Explorer and select Edit from the menu. Or,
double-click HMI - Global Events.

P [ Pages
B i User Alarms

Pz Data Logging

£ Recipes
b & Data
Global Events
i Global Subroutines

Edit

2 A tab page to make settings for the global event is displayed in the Edit Pane.

< Select Event to Add > -

3 Click in the column on the right to select the event to set from the event list.

< Select Event to Add >

FlKeyRelease
F2KeyPress
F2KeyClick
F2KeyRelease
F3KeyPress
F3KeyClick
F3KeyRelease
Interval
ProjectInitialization
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A global event is added.

< Select Event to Add > -

0 FlKeyPress

0

< Select Action to Add > -

4 In the Actions row below the new global event, click in the right column and select the action to
perform for the event from the action list.

H

A

[

(]

~-

(=4

=]

«Q

0

- = 3
¥ Events < Select Event to Add > A g
¥ [0] FiKeyPress [ S
AsyncExecution = g

=

< Select Action to Add > - g

-

BuzzerOff -n

BuzzerOn S

BuzzerOneShot 9..

CallSubroutine g

ClearUserAlarmLog o

ClosePage
DecreaseVariable
EjectSDMemory
EnableInputOperation
EndSyncLock

IncreaseVariable

InvertVariable
Login

Logout
ResetVariable

SaveScreenshot I

SavelUserAlarmLogToFile

5 When you add global events, they are numbered serially from 0 in the order that you add them.

I Deleting Global Events

To delete all of the settings for global events, right-click the Events header at the top and select Reset.

To delete an individual event, click the ﬁ Button on the right edge of the event.

suoioy Buipuodsalio) pue sjusAg [eqoo) Bumes /-t
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4-4-8 Registering Global Subroutines

I Global Subroutines

You can register global subroutines, which you can then call from anywhere in the project.

You can register common subroutines that do not rely on page conditions to make subroutines easier to
maintain.

I Registering a New Subroutine Group

To register global subroutines, you must create one or more subroutine groups. You can use subroutine
groups to separate subroutines by purpose.

1 Right-click HMI - Global Subroutines in the Multiview Explorer and select Add -Group from
the menu.

> [ Data
& Global Events

Bz

';'3 Data Gro

B, Rec

[i= Custom Keypads
- [ Data

& Global Events
vE

Gl € ety E
L &) Subrou

2 Double-click the new subroutine group. A tab page for the Code Editor is displayed in the Edit
Pane.

1| 'Add global subroutines
2| u
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I Deleting, Copying, and Pasting Subroutine Groups

You can delete, copy, and paste subroutine groups using the same procedures as those that you use
for pages.

4-4-9 Setting Up Resources

I Resources

Resources are the text strings, movies, still images, and documents that are displayed for objects and
alarms on user pages.

You can use Resources to manage all of the text strings, images, files, and other resources that you
use in a project.

suonoung 309[qo uowwon Bues v

For multi-language projects, you can set resources for each project language.

I Setting Up Resources

To set up a resource, select the resource to set up and then make the settings.

1 Right-click HMI - Resources - Root in the Multiview Explorer and select Edit from the menu.
Or, double-click HMI - Resources - Root.

seoinosey dn bumes 6-v-

2 A tab page to make settings for resources is displayed in the Edit Pane. You can select the
resource to set and make the settings.

Name Resource ID ‘ English (United States) |
String0d String0 Button

NA-series Programmable Terminal Software User’s Manual (V118) 4-45



4 Creating the HMI Application

@ Additional Information

* You can import or export resource settings using the Excel workbook format. Refer to 77-5
Import/Export Resources on page 11-13.

» To save the selected file, right-click on the grid and select Save file from the menu.

4-4-10 Setting Up IAG Resources

I IAG Resources

IAG resources are used within IAGs on user pages. When you place an IAG on a page, the resources
for the IAG are automatically registered.

The languages that are displayed by the IAG resources are determined by the project languages. The
resources that are set in advance for the IAGs are displayed for the IAG resources. If a language that is
not included in an IAG is set as a project language, the resources will be blank by default.

I Setting Up Resources

To set up an IAG resource, select the IAG resource to set up and then make the settings.

1 Right-click the IAG resource to edit under HMI - Imported IAGs in the Multiview Explorer and
select Edit from the menu. Or, double-click the resource.

» [ Data

¥ @3 IAGD
L Data Types
L3

If:',r,I Scale Transformations
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2 A tab page to make settings for IAG resources is displayed in the Edit Pane. The procedures
are the same as for other resources, but you can change only the contents of the resources that
are in the IAGs.

_Iksnurcts X -
D L
Name | Resource 1D | English (United States) |
4

String0 String0 Button

iz

[on|

m

@ Additional Information

» To delete all Imported IAGs not used in the project, right-click [Imported IAGs] and select
[Delete not used IAG] from the menu.

» To save the selected file, right-click on the grid and select Save file from the menu.

suonoung 309[qo uowwon Bues v

4-4-11 Registering Scaling

I Scaling
Scaling is used to transform displayed numeric values by specifying a multiplier and offset value.

To perform the settings for each object, open the object properties and set the parameters for scaling
under Behavior.

You can perform the settings for individual variables on the Global Variables Table.

Buieos Buuelsibey |-

Example:In this example, a multiplier of 100 and an offset of 50 are specified for an integer variable (int-

Sample):
Value of intSample Calculation formula Displayed value
0 50+0%100 50
1 50+1x100 150
2 50+2x100 250
100 50+100%100 10050
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I Registering a New Scaling
You can register a maximum of 1,000 scaling settings.

1 Right-click HMI - Scale Transformations in the Multiview Explorer, and select Edit from the
menu. Or, double-click HMI - Scale Transformations.

Offset Comment

Scale Name Multiplier

Multiplier Comment

mm
bem

Scale Name Multiplier Offset Comment
MToCM 100
GramToKG 2

SpeedAdjust 10

Cm conversion
Kg conversion

'Speed offset
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I Deleting, Copying, and Pasting Scalings

To delete all of the settings for scaling, select all the items and then right-click and select Delete from
the menu.

To delete an individual scaling, click the ﬁ button at the bottom left of the setting pane.

II Precautions for Correct Use

When rounding values to the nearest integer, ".5" is rounded to the nearest even-number inte-
ger, as shown in the following examples.

suoljaun 303lqo uowwos Bbues -

Value before rounding Value after rounding
1.2 1
1.5 2
1.8 2
25 2 (not 3)

Buieog Bunieysibay |-y
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4-5 Subroutines

I Subroutines

Subroutines are Visual Basic programs that the user can create. You create subroutines under Subrou-
tines in the HMI project.

|E| Precautions for Correct Use

This manual describes only aspects that are different from the specifications standardized by
Microsoft Corporation. For any specifications not given in this manual, refer to commercially
available reference materials.

I Subroutines

There are global subroutines and page subroutines, as described below.

® Global Subroutines

Global subroutines are shared by the entire project.

You create global subroutines under Global Subroutines in the HMI project. You set CallSubroutine
as the action in a global event, object event, or user alarms event to call a global subroutine.

You can also call a global subroutine from a page subroutine or from another global subroutine.

® Page Subroutines
Page subroutines are specific to one page.
You create page subroutines with the Code Editor for a page in the HMI project.

You can directly create the subroutines to execute in the events for individual objects on pages.
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4-5-1 Subroutine Execution

You can execute subroutines in the following ways.
» Execution from Global Events
You can execute a global subroutine from a global event.
» Execution from Page and Object Events
You can execute a page subroutine or global subroutine from a page or object event.
» Execution from User Alarm Events
You can execute a global subroutine from a user alarm event.

I Execution from Global Events

The following example shows how to use a global event to execute a global subroutine.

saupnoiqns G-

In this example, settings are made to execute the global subroutine when the F1 Key is pressed.

1 Display the global events and select F1KeyPress as the event.

< Select Event to Add >

Condition
F1KeyClick
F1KeyRelease
F2KeyPress
F2KeyClick
F2KeyRelease
F3KeyPress
F3KeyClick
F3KeyRelease
Interval
Projectlnitialization

2 Select CallSubroutine as the action.

uonnoexg sunnoIgNs L-G-

b

¥ Events < Select Event to Add >

¥ [0] FlKeyPress a

AsyncExecution =]

< Select Action to Add > -

BuzzerOff
BuzzerOn
BuzzerOneShot

3 For the subroutine name, specify the name of a previously created subroutine in the following
format: Subroutine_group.Subroutine_name

¥

¥ Events < Select Event to Add >

¥ [0] FlKeyPress ]

AsyncExecution o

4

¥ Actions < Select Action to Add >

=

v [0] CallSubroutine

ol

SubroutineGroup0.

Sub SampleSubroutine
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I Execution from Objects

The following example shows how to use an object event to execute a subroutine.

In this example, settings are made to execute the subroutine when a Button object is pressed.

1 Select the Button object and display the events and actions.

2| Events and Actions

Button(

Events < Select Event to Add >

2 Select Click as the event.

L[| Events and Actions
ButtonD
< Select Event to Add >
Click

Press

Release
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4 Creating the HMI Application

3 Select CallSubroutine as the action.

-PagEO X L4l Events and Actions >3 x

Button0

¥ Events < Select Event to Add > v

¥ [0] Click a

< Select Action to Add >  ~

BuzzerOff
BuzzerOn
BuzzerOneShot
CallSubroutine
ClearUserAlarmLog
ClosePage
DecreaseVariable
EjectSDMemory
EnableInputOperation
IncreaseVariable
InvertVariable
Login

Logout
ResetVariable

Output

SaveScreenshot
SaveUserAlarmLogToFile
SetIMEType
SetInputFocus

saupnoiqns G-

SetLanguage

SetVariable

ShowAlarmPage
ShowDocument (FullScreen)
ShowDocument (Window)

ShowPage

Events and Actions
ShowPrevicusPage

4 Specify the subroutine to execute in the following format: Subroutine_group.Subroutine_name

-Pageo X “f| Events and Actions

Button0

¥ Events < Select Event to Add >

¥ [0] Click a

¥ Actions < Sefect Action to Add > v

¥ [0] CallSubroutine o

SubroutineName I SubruutineGmupD.‘ [E]
Sub SampleSubroutine |4 [SampleSubrautine

uonNoexg sunnNoIgNs -G
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I Execution from User Alarms

The following example shows how to use a user alarm event to execute a subroutine.

In this example, settings are made to execute the subroutine when the user alarm occurs.

1 Select the user alarm and display the events and actions.

Name Alarm ID Alarm Code Expression Priority < Select Evenit to Add > ~

Samplel Group0_Samplel

binSampleAlm User Fault Level 4

2 Select Raised as the event.

i

Samplel

Name Alarm ID Alarm Code Expressio Priority < Select Event to Add >~

Samplel Group0_Samplel

binSampleAl User Fault Level 4 Acknowledged
Cleared

3 Select CallSubroutine as the action.

Samplel Group0_Samplel

Name Al D Alarm Code

Samplel

¥ Events < Select Event to Add >

Expression Priority
binSampleAlm User Fault Level 4 v [0

< Select Action to Add >
BuzzerOff

BuzzerCn

BuzzerOneShot

ClearUserAlarmLog
ClosePage
DecreaseVariable

EjectSDMemory
EnablelnputOperation
IncreaseVariable
InvertVariable

Login

Logout

ResetVariable
SaveScreenshot
SaveUserAlarmLogToFile
SetIMEType
SetInputFocus
SetlLanguage
Setvariable
ShowAlarmPage
ShowDocument (FullScreen)
ShowDocument (Window)
ShowPage
ShowPreviousPage
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4 Creating the HMI Application

4 Specify the subroutine to execute in the following format: Subroutine_group.Subroutine_name

m L4l Events and Actions

Name | Alarm ID | Alarm Code | Expression Priority | | ¥ Events

-E-an'upnlil GroupQ_Samplel binSampleAlm User Fault Level 4 v [0]

¥ Actions
¥ [0]

saupnoiqns G-

4-5-2 Precautions on Internal Processing

® Handling of Variables

If the value of an external variable is changed in a subroutine, the change is immediately updated at
the connected device. Therefore, if you frequently change the value of an external variable inside a
subroutine, the performance of that subroutine will be reduced.

® Processing during Subroutine Execution

The touch panel and function keys will not respond during execution of a page subroutine. If you
execute processing that requires time, the HMI will not perform other operations until the processing
is completed. Consider the execution time when you create subroutines. However, processing will
continue for background operations, such as communications, and for page refreshing.

® Simultaneous Execution of Subroutines

It is possible that a subroutine for a global event and a page subroutine will be executed simultane-
ously. If both subroutines manipulate the same variable, implement exclusive control or other suit-
able measures.

Bulssa001d [BUJSIU| UO Suonnedald Z-G-i

I Background Processing of Subroutines for Global Events

If you select the AsyncExecution Check Box, a subroutine process and a drawing update process
for that global event are asynchronously executed. Up to five subroutines can be executed simulta-
neously. If you attempt to execute more than that, the processes enter standby for execution. If the
number of subroutines waiting for execution exceeds 100, a warning dialog box appears on the
screen.

When you asynchronously execute subroutines, the execution timing is controlled by the OS. There-
fore, if you do not synchronize subroutines, you may get unexpected results.

Start actual system application only after sufficiently checking the timing of the execution of the oper-
ations of the programs.

NA-series Programmable Terminal Software User’s Manual (V118) 4 -55



4 Creating the HMI Application

4-5-3 Code Editor

Subroutines are edited with the Code Editor.

I Starting the Code Editor

® Global Subroutines

Double-click a previously registered subroutine under HMI - Global Subroutines in the Multiview
Explorer. Or, right-click the subroutine and select Edit from the menu.

® Page Subroutines

Right-click a previously registered page name under HMI - Pages in the Multiview Explorer and
select View Code Editor from the menu.

I Code Editor Features

The Code Editor provides functions equivalent to those of a standard text editor. It also provides func-
tions that are optimized for Visual Basic, such as keyword highlighting, entry assistance, and collapsing
Sub statements.

4-5-4 Differences in Language Specifications

Although subroutines are used in Visual Basic, some of the functions are restricted for HMIs. There are
also extensions that are provided for use with HMIs. Refer to the NA-series Subroutine Reference for

details.
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4-6 Search and Replace

|
You can search and replace strings in the data of an HMI project. The basic Sysmac Studio operations

for searching and replacing generally apply to HMIs. Refer to the Sysmac Studio Version 1 Operation
Manual (Cat. No. W504) for details.

I Differences When an HMI Is Selected

The following differences apply when an HMI is selected.
* You can select only All for the Look at Box.

El Precautions for Correct Use

You can use an action name as a search string, but you cannot replace it with another action
name.

Example: You can search for the objects that specify the Login action. However, you cannot
replace the Login action settings with the Logout action settings using the replacement func-
tion.

aoe|doy pue yoieasg 9-p
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4-7 Cross References

4-7-1

Cross References

Cross references allow you to confirm in a list format where an element ! that is part of a project is used

with

in the project.

On the list that shows the locations where an element is used, you can access the locations where the
element is used.

*1. You can cross-reference the following elements.

The

Variables
Data types
Pages
Resources
Data groups
Data sets
Recipes

basic operating procedures are the same as for the rest of the Sysmac Studio. Refer to the Sysmac

Studio Version 1 Operation Manual (Cat. No. W504) for details.

I Displaying and Manipulating Cross References

1 From the main menu, select View - Cross Reference Tab Page.

The Cross Reference Tab Page is displayed. You can check a list of the locations where the
selected element is used.
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4-8 Building

4-8-1 Building
The project must be built to convert it into a form that the HMI can execute.

During the building process, subroutines and variables are checked.

If there are any errors, the build operation is not performed and 0 is displayed next to the program or
variable where the error occurred in the Multiview Explorer.

You can confirm the errors on the Build Tab Page.

Buipiing g-¢

4-8-2 Build Operation

Use the main menu to execute the build operation. HMI projects are not built automatically even if no
operations are performed for 5 seconds.

I Executing a Build Operation

1 Select Build HMI from the Project Menu.

Buipiing L-8-v

I Aborting a Build Operation

No functions can be executed while building the project is in progress. If necessary, you can abort build-
ing to check the project.

1 Select Abort Build from the Project Menu.
Project HML Simulation Tools Help
A

AhmtBlﬂd Shift+F8
Resource usage

IAG Collections Manager Ctrl+8

2 The build operation is aborted and a message that says it was aborted is displayed in the Out-
put Tab Page.

% Additional Information

You can execute IncrementalBuild HMI to build only parts that were changed since the last
build. This shortens the build time, but dependency relations or other conditions may some-
times prevent the build from completing normally. In this case, repeat Build HMI.
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4-9 Offline Comparison

HMI projects are not included in offline comparisons. Even if you perform an offline comparison for a
project that contains an HMI as a device, information on the HMI is not included in the comparison
results.
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This section describes the objects that are provided as standard features.
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5 Objects

5-1 Objects

Basic objects are provided in the Sysmac Studio as standard features. You can use these objects to
easily create pages.

5-1-1 Object List

The following objects are provided.

I Functional Objects

A functional object provides some sort of function by itself.

Classification Object name Description

Buttons’ ! Button object Used to execute an action without writing a value to a variable.
Momentary Button Used to change the value of the specified variable to True only while
object the object is being touched.
Set Button object Used to change the value of the specified variable to True when the

object is touched.

Reset Button object Used to change the value of the specified variable to False when the
object is touched.

Toggle Button object | Used to toggle the value of the specified variable between True and
False when the object is touched.

Lamps Bit Lamp object Lit while the result of the condition expression is True.

Data Lamp object Used to change the color of the lamp according to the value of a condi-
tion expression.
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5 Objects

Classification

Object name

Description

Standard con-
trols

CheckBox object

Used to change a variable to True or False depending on whether the
check box is selected. Also, the check box can be displayed when the
value of the specified variable changes.

Data Display object

Used to display numeric values or text strings.

Data Edit object

Used to display and enter numeric values or text strings.

DateTime object

Used to display the value of a variable as a date and time.

DropDown object

Used to store the value that corresponds to the item selected in a
drop-down list in a variable. Also, the item that corresponds to the
specified variable value is displayed.

Image object

Used to display an image. Refer to A-2 Supported Formats on page
A-5 for the supported formats.

Label object

Used to display a fixed text string. Also, if you use DisplayValue for the
animation property, you can display the value of the variable.

ListBox object

Used to store the value that corresponds to the item selected in a listin
a variable. Also, if the value of the specified variable is changed, you
can move the focus to an item that corresponds to the new value of the
variable.

Radio Button object

Used to set the specified variable to the value that was set for the
selected button. Only one of the specified group of buttons can be
selected. Also, the option button can be displayed when the value of
the specified variable changes.

s303lqo L-§

Slider object

Used to set the specified variable to the value that corresponds to the
position of the slider. Also, if the value of the specified variable is
changed, you can move the slider to the position that corresponds to
the new value.

Tab Control object

Used to partially change pages within the screen. Several tab pages
are used to change the displayed contents by changing the tab page.
You can create a maximum of 64 tab pages for a Tab Control object,
and up to 10 Tab Control objects on a screen.

TextBox object

1817108[Q0 L-L-G

Used to display a fixed text string. A TextBox object differs from a Label
object in that the text string in a TextBox object will wrap.

Gauges*z Gauge Object There are several types of gauges provided, such as one with a needle
that rotates in a circle and one with a needle that moves in a straight
line.

HMI controls | Broken-line Graph Used to display broken-line graphs.™

object

Media Player object

Used to create an object that plays video. Refer to A-2 Supported For-
mats on page A-5 for the supported formats.

Recipe Viewer object

Used to display the contents of a recipe.

Trend Graph object

Used to display data from data logging as a graph.3™

User Alarms Viewer
object

Used to display a user alarm.

*1. You can change the object type with the Properties setting.

*2. The size of the font of the gauge object scale may vary between Windows 10 and other operating systems.

*3. The color Alpha is disregarded for these objects. For this reason, if a transparent color is set, it will be drawn
as a non-transparent color. A combined total of up to 8 Broken-line Graph objects and Trend Graph objects
can be placed in one project.

*4. A maximum of 25,000 points can be drawn in Trend Graph objects. Any part that exceeds 25,000 points will

not be drawn.

EI Precautions for Correct Use

Do not switch input control while operating a slider object or the scroll bar of an object.

The object may not be operated from then onward.
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I Graphic Objects

A graphic object does not provide any specific function by itself. You must add functions by using
events and actions. Many different graphic objects are available. Some typical ones are described in
the following table.

Classification

Object name

Description

Shapes

Curve object

Used to draw a curved line. You can double-click the graphic object to
edit it.

Ellipse object

Used to draw a circle or ellipse.

Line object

Used to draw a straight line. You can double-click the graphic object to
edit it.

Polygon object

Used to draw a polygon. You can double-click the graphic object to edit
it.

Polyline object

Used to draw connected straight lines. You can double-click the
graphic object to edit it.

Rectangle object

Used to draw a rectangle.

Triangle object

Used to draw a triangle. You can double-click the graphic object to edit
it.

5-1-2 Object Attributes

There are the following three types of attributes for objects.

* Properties
* Animations

« Events and actions

Objects

D —+— Animations

—— Events and actions

— Properties

---- These are static attributes.

--- These attributes control object animations when the specified

condition expressions are met.

---- You can specify events and the actions to perform

when the events occur.
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5 Objects

® Properties

Properties are the static attributes of an object.

These include settings for the names and other general properties, colors, positioning, and other
display properties, and assigned condition expressions or variables, as described in the following

table.
Properties
Properties Description
General You can set the name of the object and check the object type.
Appearance You can set the object color, shape, label, etc.
Behavior You can set condition expressions, variables, and delay times to assign to
the object.
Expression You can specify a condition expression that uses variables.
Variable You can specify a variable.

IsEnabled, DoubleTouch-
Time, OnDelayTime, etc.

You can make settings to enable the object, determine the double-touch
interval, set the ON-delay time, etc.

Layout You can set the position and size of the object.
Security You can set security for the object.

Pointer Marker You can set the needle marker for a gauge.

Ranges You can set the range for a gauge.

Scale Bar You can set the scale bars for a gauge.

Tick Label You can set scale labels for a gauge.

Tick Major You can set the major scale division labels for a gauge.
Tick Minor You can set the minor scale division labels for a gauge.
Needle You can set the needle for a gauge.

Needle Cap You can set the needle cap for a gauge.

Data You can set the display target of a Trend Graph or Broken-line Graph.
Left Axis You can set the left axis for a graph.

Right Axis You can set the right axis for a graph.

Time Scale You can set the time axis for a graph.
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® Notation for Expression

If you specify a BOOL variable, e.g., for a Lamp object, you can specify an expression for the
Behavior property.

Examples of the expression notations are given below.

Example 1: Executing a Function when a Boolean Variable (biInSample in this Example) Is True

biInSample=True

Example 2: Executing a Function when an Integer Variable (intSample in this Example) Is Less
Than 20

intSample<20

Example 3: Executing a Function when a Boolean Variable (b/nSample in this Example) Is True and
an Integer Variable (intSample in this Example) Is Less Than 20.

(bInSample=True) AND (intSample<20)

Example 4: Setting a Value by Adding 100 to an Integer Variable (intSample in this Example)
intSample+100

Notation for CustomDisplayFormat

If you set ValueFormat to Custom for a Data Display object, you must set the custom display format
(CustomDisplayFormat). The basic format is 0:*****, where ***** is replaced with the result of
Expression.

This format follows the specifications of custom numeric format strings in Visual Basic. For details,
refer to the Microsoft website or to commercially available reference materials.

Example 1: Display When Result of Expression is 1.234 and {0:00.0000} Is Specified
01.2340

Example 2: Display When Result of Expression is 1.234 and {0:##.####} |s Specified
1.234

Example 3: Display When Result of Expression is 1.234 and X={0:##.####} Is Specified
X=1.234
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5 Objects

® Animations

You can use animations to change the status of the object according to Expression (condition

expression).

As described below, you can specify the status when the condition expression is met, such as flash-
ing, enabling/disabling operation, size/coordinate changes, and displaying/hiding the object.

Animation List

Animation name

Description

Blink

When the condition expression is met, the object flashes in the specified color.

ColorChange(Analog) Changes the color of the object according to a value.

ColorChange(Boolean) Changes the color of the object according to True/False status.

DisplayValue Displays a value based on a condition expression.

Enable Enables operating the object when the condition expression is met.

Move Changes the coordinates of the object according to specified condition expres-
sions.

PercentageFill Fills a graphic figure based on a condition expression and a percentage
between the upper and lower limits.

ResizeHeight Changes the height of the object according to a specified condition expression.

ResizeWidth Changes the width of the object according to a specified condition expression.

Rotate Rotates a graphic object based on a condition expression.

Visibility Displays the object when a condition expression is met.

I Events and Actions

® Events and Actions
You can make settings for object events and corresponding actions.

You can specify events and the actions to perform when the events occur.

You can specify the required conditions and operations, such as executing a specified subroutine
when a function key is touched.

The events and actions are listed in A-1 Events and Actions on page A-2.
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5-1-3 Using Objects

The objects are provided in the Toolbox on the right side of the window.

You can create them on pages and set the properties and animations and also the events and actions.

B[ Mew Project - HMI_NAS 0 - Sysmac Studio

=N =<

File Edit Miew Insert Project HMI Simulation Tools Help
[]
|

Multiview Explorer -1 -Pagt() X ~ Toolbox
=

» Configurations and Setup

¥ [ Pages

HMI_NA5 0

B Button

Momentary Button
i) User Alarms

m
Data Logging [@  Reset Bution
£ Recipes ED  SetButton
» 7 Data
4 Global Events
» & Global Subroutines fr—
sources
7 IAG Resources

Toggle Button

Shapes
Standard Controls
[
HMI Controls
Custom

Output Arrows

Blowers

Convevors

H Filter

I Creating Objects

1 Drag the objects from the Toolbox and drop them on the page.

B[ Mew Project - HMI_NAS 0 - Sysmac Studio

[

File Edit View Insert Project HML Simulation Tools Help
[]
1

Multiview Explorer

= =
HMLNAS_0 - ]

: -
» Configurations and Setup

¥ Buttons

Momentary Button
Reset Button

Set Button
% Global Events

Toggle Button
» & Global Subroutines

Standard Controls
Gauges
HMI Controls
Custom

Output O
Blowers
Convevors

Button
A Button object.

= I & i

NA-series Programmable Terminal Software User’s Manual (V118)



5 Objects

@ Additional Information

* You can drag and drop a variable registered in the controller's global variable table or a con-
tact or coil placed in the ladder editor onto the page editor to automatically register the con-
troller variable as an HMI-mapped global variable, and create an object corresponding to the
variable type.

* When pasting an array variable to such as an HMI property variable, brackets are automati-
cally converted to "()" which are used in HMI. Same conversion is performed when pasting in
the opposite way.

I Setting Properties

1 Double-click the object.

@ Additional Information

You can also use the following methods to display the properties.
» Select Properties from the View Menu.
+ Right-click the object and select Properties from menu.

syoalqo -G

2 The properties are the static attributes of the objects.

B8] Mew Project - HMI_NAS 0 - Sysmac Studio [
File Edit View Insert Project HMI Simulation Tools Help

a|:nm3m 4 A

Multiview Explorer e Page0 x

HMINASO | v |n|

3 ¥ General
» Configurations and Setup N Euttond

Type Button

spelqo Buisn ¢-1-G

¥ Appearance
Desion i

PZ Data Logging Lg| Text (Defay

E. Ee(mes > Font Segos UL 12,N
» ata

5 Global Events [RELEELIS Center

VERET Center
Margins (L, [ERERRIP
WordWrap

TextColord || LRSS

TexiColor || [EESNS
Backgroun: [[INLEIR
Backgroun [[INLELR
BorderColc [[ ] ERS TSRS
BorderColc || [N
BorderThic
» ComerRad
IsVisible
¥ Behavior
IsEnabled
DoubleTou

B Filter Build = oo rties
P
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Make the following settings as required.

I Setting Animations

1 Select Animations from the View Menu.

New Project - HMI_NAS5_0 - Sysmac Studio

FEile Edit Wiew Insert Project HMI Simulation Tools Help

Multiview Explorer Alt+1
Toolbox Alt+2
Output Tab Page Alt+3
Watch Tab Page Alt+4
Cross Reference Tab Page Alt+5
Build Tab Page Alt+6

Search and Replace Results Tab Page  Alt+7

Page Explorer Ctri+Shift+1
Code Explorer Ctr+5hift+2
Properties Ctri+Shift+3
Animations Ctri+Shift+4
Events and Actions Ctri+5hift+5
Smart Project Search Ctri+5Shift+F
Recently Closed Windows Ctri+Shift+H

Clear Recently Closed Windows History
Zoom 3

Reset Window Layout

2 You can set the animations of the objects in the Animations Window.

B New Project - HMI_NAS_0 - Sysmac Studio

o]

File Edit WView Insert Project HMI Simulation Tools Help

-
i = al

HMLNAS 0 v

(3 Configurations and Setup
v

Output

Reference Data

utton0

Animations

< Selact Animat]
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I Setting Events and Actions

1 Select Events and Actions from the View Menu.

MNew Project - HMI_NA5_0 - Sysmac Studio
File Edit Wiew Insert Project HMI Simulation Tools Help

Multiview Explorer Alt+1
Toolbox Alt+2
Output Tab Page Alt+3
Watch Tab Page Alt+4
Cross Reference Tab Page Alt+5
Build Tab Page Alt+6

Search and Replace Results Tab Page  AlE+7

Page Explorer Ctrl+Shift+1
Code Explorer Ctrl+5Shift+2
Properties Ctrl+Shift+3
Animations Ctrl+Shift+4
Events and Actions Ctrl+Shift+5
Smart Project Search Ctrl+Shift+F
Recently Closed Windows Ctrl+Shift+H

Clear Recently Closed Windows History

Zoom 3

syoalqo -G

Reset Window Layout

2 You can set the actions for events in the Events and Actions Window.
[ New Project - HMI_NAS_0 - Sysmac Studio =R ECR |

Elle Edit view Insert Project HMI Simulation Toals Help

E 14

= e '@ E 1 8

-Pageﬂ x Events and Actions ~ %
“ Button0

Events < Select Event to Add >~

spelqo Buisn ¢-1-G

output
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5-2 Examples of Using Objects

This section provides examples of using objects.

5-2-1 Displaying a PDF File
The following example shows how to display a PDF file full screen when a button is touched.
1 Place a button on the page.

S| New Project - HMI_NAS_0 - Sysmac Studio =35 =<
Fille Edit View Insert Project HMI Simulation Tools Help

1 =
|8 G @
Multiview Explorer

T 3 (=l
HMI_NA5_0 ‘.___ J‘

[} Configurations and Setup. .

¥ Buttons

Momentary Button

m
@  Reset Button
E3  SetButton

Toggle Button
Lamps
Shapes
Standard Controls
Gauges
HMI Controls.
Custom
Arrows
Blowers.

Output « > Conveyors
Flags

Flow Maters
Button
A Button object.

A Filter

2 Select Events and Actions from the View Menu.

New Project - HMI_NA5_0 - Sysmac Studio
File Edit View Insert Project HMI Simulation Tools Help

Multiview Explorer Alt+1
Toolbox Alt+2
Cutput Tab Page Alt+3
Watch Tab Page Alt+4
Cross Reference Tab Page Alt+5
Build Tab Page Alt+6

Search and Replace Results Tab Page  Alt+7

Page Explorer Ctrl+Shift+1
Code Explorer Ctrl+Shift+2
Properties Ctri+Shift+3
Animations Ctri+Shift+4
Events and Actions Ctrl+Shift+5
Smart Project Search Ctri+5Shift+F
Recently Closed Windows Ctri+Shift+H

Clear Recently Closed Windows History
Zoom 3

Resat Window Layout

Button(
Events

< Select Fvent t *

Press

Release
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4 Select ShowDocument (FullScreen) from Actions.

Button0
¥ Events < Select Event to Add > ~
v [0] L]
< Selact Action to Add > ~
BuzzerOff
BuzzerOn
BuzzerOneShot
CallSubroutine
ClearUserAlarmLog
ClosePage
DecreaseVariable
EjectSDMemory
EnableInputOperation
IncreaseVariable
InvertVariable
Login
Logout
Resetvariable
SaveScreenshot
SaveUserAlarmLogToFile
SetIMEType
SetInputFocus
Saetlanguage
SetVariable

ShowAlarmPage

ShowDocument (Window)
ShowPage
ShowPrevicusPage
ShowSystemMenu
ShowTroubleshooter
StartDatalogging

StopDatalogging

5 Set DocumentFileName to the name of the file to display.
Events and Actions
Button
¥ Events < Select Event to Add =
¥ [0] Click ]
¥ Actions < Select Action to Add > A

¥ [0] ShowDocument [ ]
» sample.pdf A IEI

Transfer the project to the HMI and confirm the operation.

The PDF file should be displayed when the button is touched.
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5 Objects

5-2-2 Displaying a User Alarm
The following example shows how to register a user alarm and display a message when the user alarm

occurs.

This example creates a user alarm that displays the message Alarm1 in a confirmation dialog box when
the binAlarm1 variable changes to True.

1 Double-click Group0 under HMI — User Alarms in the Multiview Explorer.

.
8| New Project - HMI_NAS_0 - Sysmac Studio ==

1

Y @ @@
1 I |
Multiview Explorer

HMLNAS_O - ‘ Ii “
o Alarm ID Alarm Code

[ Configurations and Setup

v

v

2 Right-click in the user alarm table for the new group and select Add from the menu.

3 A row is added. Make the following settings in the new row. Use the default values for settings
that are not specified.

Name: UserAlarm1
Expression: binAlarm1=True
Message: Alarm1

Popup: Selected
Acknowledge: Selected

=

Name | AarmID  |Alarm Code| Expression Priarity | Message | Popup | Acknowledge |  Page | Details
Useralarm1 Group0_ BinAlarm1=True User Fault Level 4 | alarm1 M ™

@ Additional Information

If you set a page name for the Page parameter, the screen is switched to the specified page
when an alarm occurs. Select an alarm displayed on the User Alarms Viewer, and execute the
ShowAlarmPage action/function. The screen is changed to the specified page.
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4 Double-click HMI - Pages - PageO0 in the Multiview Explorer. Drag a User Alarms Viewer object

from HMI Controls in the Toolbox to the page.

Bl New Project - HMI_NA5_0 - Sysmac Studie

Lollo =

File Edit View Insert Project HMI Simulation Tools Help

|* aae

Multiview Explorer

HMINASO v ‘E‘

[3 Configurations and Setup

Output

A Filter (5] Output PREEE]

Generating ference Data

» Buttons

» Lamps

» Shapes

» Standard Controls
» Gauges

v HMI Controls
|/ Broken-line Graph
IO Media Player
B Recipe Viewer
[oh  Trend Graph

» Custom
b Arrows

» EBlowers

« B Conveyors

» Flags
» Flow Meters

User Alarms Viewer
A User Alarms viewer object.

=3

@ Additional Information

With Runtime Ver. 1.14 or later, the elapsed time since an alarm occurred can be displayed.
Select Elapsed Time in the property column. The elapsed time is displayed in units of minutes.

Transfer the project to the HMI and confirm the operation.

When the bInAlarm1 variable changes to True, the contents that was set for the User Alarms

Viewer object are displayed in a confirmation dialog box.

Oceured At [121334PM on [972m¢

@ Additional Information

You can sort the displayed items by touching a column of the User Alarms Viewer.
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5-2-3 Displaying a Trend Graph

The following example shows how to register a data set for data logging and display a trend graph that
accesses it.

This example records log data continuously every 5 seconds and saves it in a separate file for each
24-hour period.

1
2

Register an integer variable called intDatalog1 in the global variable table.

Right-click HMI - Data Logging in the Multiview Explorer and select Add - Data Set from the
menu.

¥ [if] Pages
L BA Pagel
» wi) User Alarms

o

Fi2 Data Groups
» B Reci

Double-click the new data set.

E] New Project - HMI_NA5_O - Sysmac Studio

Start New Database File
Storage Type @ Daily (from 00:00
Target Device SD Memory Card v @ After specific time pes

Target Folder ¥Data Logging¥Log Files

Update Type Regular Interval = © After specific number of logs

Number of logs TSR

Update Rate 5 Seconds v

K Automatically Start on HMI Device

Variable Data Type Comment

Right-click in the new data set grid and select Add from the menu.

A row is added. Set intDatalog1 in the Variable column of the new row. Use the default values
for other settings.

Start New Database File
Storage Type

Q Daily (from 00:00 - 23:59)
Device |

Target Device SD Memery Card v @ After specific time period
Target Folder ‘\Data Logging\Log Files

Update Type Regular Interval —

@ After specific number of logs
Update Rate 5 Seconds v Number of logs

Ei Automatically Start on HMI Device

Variable Data Type Comment
intDatalog Integer
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6 Double-click Page0 under HMI - Pages in the Multiview Explorer. Drag a Trend Graph object
from HMI Controls in the Toolbox to the page.

New Project - HMI_NAS_0 - Sysmac Studio o J[@
Fle Edit View Insert Project HMI Simulation Tools Help

sjoalqQ Buisn jo sajdwexy z-g

AnalogTraces RE
DigitalTraces QU +

8 Click the for Analog Traces and set the variable to display on the graph.

Set intDatalog1 as the variable.
¥ Data
DataSet DataSetl

¥ Analoglraces gl +
¥ [0] analoglracel: @

WETLT analogTracel

intDatalog

el Left Scale -
. DarkOrchic

ydeus) pual] e Buihe|dsiq ¢-z-

Color

EENC AR MNone -

DigitalTraces R +

Insert an SD Memory Card into the HMI, transfer the project to the HMI, and confirm the opera-
tion.
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Every 5 seconds, the value of intDatalog1 should be sampled and displayed on the graph.

Trend Graph

5-2-4 Displaying a Broken-line Graph

The following example shows how to use a broken-line graph.
1 Register an integer array variable called intData(10) in the global variable table.

2 Right-click HMI - Data Groups in the Multiview Explorer and select Add - Data Group from the
menu.

- [ Pages
) User Alarms
» [ Controller Events
Bz Data Logging

om Keypads

3 Double-click the new data group.

New Project - HMI_NAS_0 - Sysmac Studio

File Edit View Insert Project HMI Simulation Tools Help

[] i y I. = — —
l'!l': & GO 2] = N A @ gt g B e

——muw -

Data Series | Type | Data Type Comment

Tt
HMI_NAS_ 0 v H--H

Variable Data Type Comment

4 Register a data series in the new DataGroup0.

Right-click in the grid and select Add from the menu.
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_[hlaﬁlmqﬂ b4 -

Data Series | Type | Data Type | Comment [

Variable Data Type Comment

5 A row is added. Perform the following settings in the new row. Use the default values for all
other settings.

_DalaGruq)ﬂ b4 -

Data Series | Type | Data Type | Comment |

Array Integer -

6 Set an array variable called intData in the added data series. Use the default values for all other
settings.

_DalaGuuq)Dx -

Data Series | Type | Data Type | Comment
TestDataSeries1 Array Integer

o
S
N
m
x
)
3
=2
o
)
o
S
[
o
5
@
o
I
)
o
-
7]

Data Type Comment
IntData ege )

Target Dimension

Target Index

Target Member

Targeted Data IntData(*)

7 Go back to the Page Edit Pane. Double-click Page0 under HMI - Pages in the Multiview
Explorer. Drag a Broken-line Graph object to the page from HMI Controls in the Toolbox.

B New Project - HMI_NAS_0 - Sysmac Studio =&

File Edit View Insert Project HMI Simulation Tools Help

ydeio aui-usyolg e bulkeidsiq -z-G

N

» Buttons

» Lamps

» Custom
> Arrows
» Blowers

» Conveyors

» Hoppers
» Motors
» Pipes
» Pumps
» Tanks
b Valves

» Waning Signs

Description Location
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8 Set the name of the data group that you created as the data group in the properties.

¥ Data
DataGroup DataGroup0
Offset 0
Traces 0 +

9 Click the for Traces and set the variable to display on the graph.
Set TestDataSeries1 in DataSeries.
¥ Data
DataGroup DataGroup0
Offset 0

¥ Traces 1 +

¥ [0] traceD : TestDataSe &

Mame tracel

TestDataSeries1

Els | SRt Left Scale -
Color B Red v

MarkerType MNone -

Transfer the project to the HMI, and confirm the operation.

The value of each element of intData(10) should be displayed on the broken-line graph.

Broken Line Graph
100.00 100.00

50.00 50.00

0.00 0.00
0.00 10.00 20.00 30.00 40.00 50.00
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5-2-5 Using a Recipe
The following example shows how to use a recipe.

1 Register integer variables called intRecipe1 and intRecipe2 in the global variable table.

2 Right-click HMI - Recipes in the Multiview Explorer and select Add - Recipe Template from the

menu.

V¥ [ Pages
B Pagel

b [ Data
& Global B

3 Double-click the new recipe template.

B New Project - HMI_NA5_0 - Sysmac Studio
FEile Edit View Insert Project HMI Jools Help

1 -
Y & @ @
B

Multiview Explorer -1
Ingredient Name Default Value Min Value Max Value | Visible |Editable|
HMILNAS_0 v “.“‘

¥ Configurations and Setup

4 Register ingredients in the recipe template for the new recipe, Recipe0.
Right-click in the grid and select Add from the menu.

Show Recipes

@ Additional Information

A recipe template is a defined data structure for a recipe.
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5 A row is added. Make the following settings in the new row. Use the default values for other set-
tings.

Ingredient Name: Recipe1
Variable: intRecipe1
Default Value: 10

Min Value: 0

Max Value: 100

Set Recipe?2 as follows:
Ingredient Name: Recipe2
Variable: intRecipe2
Default Value: 20

Min Value: 0

Max Value: 100

Ingredient Name VELFL Default Value Min Value Max Value Visible | Editable

Recipel intRecipel 10 0 100 ¥ ]
Recipe? intRecipe? 20 0 100 ] [+]

6 Right-click in the grid and select Show Recipes from the menu.

Add
Delete

Move Up

7 Right-click in the grid and select Add from the menu.

Show Ingredients

@ Additional Information

Recipes make settings in advance that are actually set according to the data structure.
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8 A row is added. Make the following settings in the new row. Use the default values for other set-
tings.

Recipe Name: RecipeSample1
Recipe1: 30
Recipe2: 40

Recipe Name: RecipeSample2
Recipe1: 50
Recipe2: 60

Recipe Name

RecipeSamplel
RecipeSample2

9 Create a button to transfer the recipe.

Right-click HMI - Pages- Page0 in the Multiview Explorer and select View Code Editor from the
menu.

sjoalqQ Buisn jo sajdwexy z-g

View Page Editor

Delete

Cut

N
>
)]
1 &
0 Create the following subroutine. E
[V
&
1 'Code behind Page - Add local subroutines for the page. | Q.
2[H5ub WriteSubroutine 8

3{| WriteRecipeToController("Recipe(”,"RecipeSamplel”)

4{| End Sub
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11 Double-click HMI - Pages - Page0 in the Multiview Explorer. Drag a Recipe Viewer object from
HMI Controls in the Toolbox to the page.

New Project - HMI_NAS_ - Sysmac Studio [o )& =]
File Edit View Insert Project HMI Simulation Tools Help

gl (Uit Stted) +

EE

» Buttons
> Lamps
» Shapes
> Standard Controls
» Gauges
¥ HMI Controls

*+ Brok

O Med

> Custom
> Amows

> Blowers

» Conveyors
» Flags

> Flow Meters
> Hoppers

» Motors

> Pipes

> pumps

> Tanks

» Valves

_—————————————— b WomnaSans |
Gutpat
A

= B

12 Then drag a Button object from Buttons in the Toolbox to the page and set the following event
and action.

Events and Actions
Button0

¥ Events < Select Event to Add =

¥ [ Click o

¥ Actions < Select Action to Add > v

¥ [0 CallSubroutine ]

SubroutineMame| WriteSubroutine

Transfer the project to the HMI and confirm the operation.

When the button is touched, the values that are set for the specified recipe should be written to
the connected device.

| Name

Recipel
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5-2-6 Setting the Order of Automatic Move of Input Focus

The following example shows how to consecutively enter numeric values in the multiple data input
objects placed on a page.

1 Register an integer variable called intData1 in the global variable table.
2 Place a data input object on the page.

B New Project - HMI_NAS_0 - Sysmac Studio == |men ]

File Edit View Insert Project HMI Simulation Tools Help

R

[ ]
I
'w Standard Controls

[] CheckBox

TabControl
TextBox
» Gauges

> HMI Controls

sjoalqQ Buisn jo sajdwexy z-g

» Custom
» Amows

» Blowers
» Conveyors
» Flags

Location ! '» Flow Meters

3 Set intData1 in Variable of the properties for the data input object.
¥ Behavior
IsEnabled

DataType Mumeric

intDatal

4 Place the multiple data input objects on the page by copying and pasting one.
(S New Project - HMI_NAS_O - Sysmac Studic [E=RE )

File Edit View Insert Project HMI Simulation Tools Help
|+ ane E & o 1
Multiview Explorer - q _Pug:O x % ‘Properties x
— B o e B ¢ - I

HMINASO v ‘ =l

[3 Configurations and Setup

v
¥ [ Pages

$N204 Indu| JO BAOI dieWOINY JO JOpIO 8y} Bumes 9-z-G

Build

k9 0 Eros i+ 0 Warning: ]
Description (B

H Filter
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5 Click the Data Input Order Setting Button on the Toolbar to switch to the mode for setting data
input order.

‘English (United States) v

6 Click the data input objects in the order in which to move the input focus.

5] New Project - HMI_NAS_0 - Sysmac Studio BN

4 aa o
Multiview Explorer - < Toolbox
= Engish United Sated) +
s v [ E = [ e ]

» FEE——

» Buttons
> Lamps

» Shapes

» Standard Controls
> Gauges

> HMI Controls

» Custom

> Arrows

I BFRE

vy

» Blowers

» Conveyors

» Flags

> Flow Meters

» Hoppers

> G

> Motors

» Pipes

> Pumps

> Tanks
> valves

» Waning Signs
Description Program Location

7 When you complete the settings, the following dialog box appears.

Data Input Order

All objects have now been assigned a data input order value.

I 0K
8 Select the AutoNavigateKeypads Check Box under Behavior in the properties of the page.

¥ Behavior
Pagelype

BackgroundPage

Transfer the project to the HMI, and confirm the operation.

When you press a data input object, a keypad is displayed. After you complete an input, the
input focus is automatically moved from one data input object to the next.
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5-2-7 Displaying Text Strings by Indirect Addressing

You can dynamically change text strings that are displayed on label objects or text box objects. The fol-
lowing example shows how to switch a text string displayed on an object by using a value specified in a
variable.

1 Register an integer variable called intData1 in the global variable table.

2 Register a new resource group in a Resources table.

¥ [if Pages
L A Pagel
P di) User Alarms
» [ Controller Events
Bz Data Logging

¢ [ Data
& Global Events

sjoalqQ Buisn jo sajdwexy z-g

L 55 Root

L &
[l Inn F-E:-r‘tEd 1AGs

I._"T_I Scale Transformations
:

Name Resource ID English (United States)
String0 Group0_5String0 ABC

Buissalppy 108.ipu] Aq sbug 1xal Buikeldsiq /-z-
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4 Open the Page Editor and create a Label object.
Ii‘ New Project - HMI_NAS_0 - Sysmac Studio E@

Eile Edit View [Insert Project HMI Simulation Tools Help
(| 1 -

|* asescal|smami

i i B 4,
Multiview Explorer -1 -PagEO X ~ Toolbox
HMLNASO v |n| Sl = [ . S E=
B Cortiguratns na s .

v EL B Data Edit
¥ [i) Pages € 5. DateTime

&8 DropDown

(27 Image

£l ListBox
7 RadioButton
Slider
TabControl
TextBox
» Gauges
» HMI Controls
» Custom
P> Armows
» Blowers
» Conveyors

- X

kU Erosf » Flags

(I Description Location 13 Fow Meters

Hoppers

Pipes

>
>
[
>
| 3

Pumos

H Filter # Output

5 Open the properties of the Label object, and set Resource Link Type to Dynamic under
Appearance - Text (Default).

¥ Appearance

¥ Text (Default)

Resource Link Type | Dynamic

Expression

Set “Group0_String” & intData1 in Expression.

N O

On the page, create the data input object that inputs values to intData1.
Transfer the project to the HMI and confirm the operation.

When the value in intData1 is O, the Label object displays “ABC”.
When the intData1 value is changed to 1, the object displays “XYZ".

@ Additional Information

In Expression, set the text string that is displayed for the Resource ID on the Resources table.
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5-2-8 Creating Buttons with the Lamp Function

The following example shows how to create a Button that, when touched, allows the entire color to be
changed as Variable 1 changes between TRUE and FALSE, and the inside indicator color changes as
Variable 2 changes between TRUE and FALSE.

1 Register Boolean variables called binSample1 and binSampleZ2 in the global variable table.

2 Place a Set Button object on the page.

New Project - HMI_NAS_O - Sysmac Studio [E=5(ECR =

File Edit View Insert Project HMI Simulation Tools Help
ly
|

dGad

Multiview Explorer

&
HMI_NAS5_0 v

- "
O Conigraions anc e T
M M — ! ¥ Buttons

¥ [5] Pages Set Button =

Button
[@ Momentary Button
[  ResetButton

o
Y
m
x
)
3
=2
®
o
o
=3
[
o,
5
Q@
o
k=
®
o
-
73

K3 Toggle Button
Lamps
Shapes
Standard Controls
Gauges

[ Impo

m
s

HMI Cont

ormations
Custom
AITOwWs

Blowers
Output

4
=

Conveyars

"WYY Y YYTTYMYYMYMYMMMY

Flags

» Flow Meters

Set Button
Omron.ButtonControls.SetButton
A SetButton object.

H Filter @ A, Build

3 Open the Properties Window for the Set Button object. Set binSample1 in the Variable Box,
and select Touch (Button) + Feedback (Indicator) in the VisualFeedback Box.

uonouny dweT sy} ypm suopng bunesiy §-z-g

v Behavior

Variable binSamplel

IsEnabled
DoubleTouchTime _
OnDelayTime _
OffDelayTime _
VisualFeedback Touch (Button) =

L A EI Touch (Button)

Variable (Button)

Feedback (Button)

Touch (Button) + Feedback (Button)

> Positiy

M Variable (Button) + Feedback (Indicator)
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4 Set bInSample2 in the FeedbackExpression Box.

¥ Behavior
Variable binSamplel

IsEnabled

DoubleTouchTime

OnDelayTime

OffDelayTime

VisualFeedback + Feedback (Indicatc ~

binSample2

+

IndicatorPosition Top Left

-

IndicatorColorOff M Red

-

IndicatorColorOn M Green

-

With the above settings, pressing the Set Button object changes biInSample1 to TRUE, which changes

the entire button color.

The inside indicator color is changed as biInSample2 changes between TRUE and FALSE.

@ Additional Information

The position, size, and color of the indicators can be changed as required.
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5-2-9 Creating Buttons to Output Operation Log Files

The following example shows how to create buttons to output operation log files to a SD memory card.
1 Click Configuration and Setup - Operation Log Settings in the Multiview Explorer.
2 Select the Start Operation Log Check Box.

Openontogsetrss x I

K4 Start Operation Log New operation log file generation interval

Target Device 5D Memory Card v © Daily (from 00:00 - 22:59)

Target Folder ‘\Operationlog
__ @ After specific number of logs
Operation when logging limit reached [Delete the old log file and continue to log v Number of logs 1000

Logging limit

3 Place a button object on the page.

E New Project - HMI_NA5_0 - Sysmac Studio (32bit) - a X

file Edit View Insert Project HMI| Simulation Iools Window Help

<Search> v

¥ Buttons

sjoalqQ Buisn jo sajdwexy z-g

Set Button
0 Toggle Button

Lamps

Shapes
Standard Controls

Gauges

Custom
Arrows
Blowers

Conveyors

>
>
>
»
P HMI Controls
>
>
>
»
>

Flags

Description Location
=sne > Flow Meters

Button
A Button object.

4 Select the Operation Log Check Box.
¥ Security

sa|i4 607 uonesadQ INdiNO 03 suopng Bunesty 6-z-G

Accesslevel

VisibilityLevel
Operation Log

NA-series Programmable Terminal Software User’s Manual (V118) 5-31



5 Obijects

Place a button object on the page.

New Project - HMI_NA5_0 - Sysmac Studic (32bit) - a X

Eile Edit View Insert Project HMI| Simulation Iocls Window Help

~ Toolbox

¥ Covguatonsandseup— | + Bions

Y [ P [0 Momentary Button
ED  ResctButton
E3  SetButton
Toggle Button
Lamps
Shapes

Standard Controls

Gauges

Custom
Arrows
Blowers
Conveyors

>
»
>
>
> HMI Controls
>
>
>
>
>

Flags

Descripti Locatior
escription L) > Flow Meters

Button
A Button object.

Set the following event and action and click [Z].

¥ Events < Sefect Event fo Add » -
¥ [0] Click (]

¥ Actions < Select Action to Add > -
¥ [0] CallSubroutine ]
SubroutineMame ISaveOperatianLag [=

Create the following subroutine.

regeoy> [ —
l}) SaveOperationlog
1; 'Code behind Page - Add local subroutines for the page.

{ f <

-1Sub SaveOperationLog

2
3
4
5 SaveOperationLogToFile( "\SDCard\Operationdata.csv”, _

3 Date.Parse("2020-04-01 13:30:00"), _
7 Date.Parse("2020-04-10 07:00:00"))
B

g

End Sub

1@

Transfer To HMI.
Operation logging starts when the HMI starts.
Tap the button to record logs created in 2 to start leaving records in the Operation Log.

Tap the button created in 4 to save the operation log from 13:30:00 on April 1 2020 to 7:00:00 on
April 10 2020 in the SD memory card under the file name Operationdata.csv. Refer to A-3 Spec-
ifications of Operation Log Files on page A-7 for the specifications of the files to be saved.
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Connecting to the HMI

This section describes how to go online with an HMI.

6-1 Introduction . ........... ...ttt i 6-2
6-2 Going OnlinewithanHMI .............. . ... it 6-3
6-2-1  Methods for Going Online withan HMI .. ......... .. .. ... ... .. ... .... 6-3
6-2-2  Setting the Connection Method . ......... ... ... ... .. ... ... ... .. ... 6-4
6-2-3 Online Connection . ... ... .. 6-5
6-2-4  Going Online after Checking the ConnectionMethod . ... ................ 6-6
6-2-5 Going Offline . . ... ... .. e 6-6
6-2-6 Confirming Serial IDs . . ... ... . e 6-7
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6 Connecting to the HMI

6-1

Introduction

I Connecting to the HMI

You must go online with the HMI or connect to the Simulator to communicate with it from the Sysmac

Studio.

The Sysmac Studio supports the following online connections for different applications.

Online connection

Connection made to

Application

Online connection

The actual HMI

To perform debugging, startup, or normal maintenance, the
same project as in the actual HMI is opened on the Sysmac
Studio and then an online connection is made. An online con-
nection is made based on the Communications Setup in the
project.

Simulator connection

HMI Simulator

The Simulator is used to debug the program offline. The Com-
munications Setup in the project is not used.

@ Additional Information

Refer to 7-1-5 Offline Debugging with Only the HMI Simulator on page 7-9 for information on
connecting to the Simulator and debugging operations.
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6-2 Going Online with an HMI

You can simultaneously go online with more than one HMI in a project from the Sysmac Studio. The
operations that are described in this section apply to the currently selected HMI. If there is more than
one HMI registered in the project, confirm the HMI to operate before connecting to it.

M Precautions for Correct Use

Do not reconnect the USB cable for at least 10 seconds after you disconnect it. After you con-
nect the USB cable, do not disconnect it until Windows detects the connection.

It may become impossible for Windows to detect when the cable is connected or disconnected,
which would effectively disable the USB port. If that occurs, restart the computer. Otherwise,
you will not be able to use the USB device until Windows recovers from the suspended status.

6-2-1 Methods for Going Online with an HMI

To go online with an HMI, there are three connection methods that can be used. These are described in

the following table.

Connection method

Connection diagram

Description

Direct connection via
UsSB

-

The USB port on the computer is
connected directly to the USB slave
port on the HMI.

This is the default connection con-
figuration.

Direct connection via
Ethernet

The Ethernet port on the computer
is connected directly to Ethernet
port 2 on the HMI.

Ethernet connection
via hub

The Ethernet port on the computer
is connected through the Ethernet
network to an Ethernet port on the
HMI.

NA-series Programmable Terminal Software User’s Manual (V118)

INH ue ypm auluo Buies z-9

IINH UB ym suluo Buiog 1oy SpOyIeN L-z-9




6 Connecting to the HMI

6-2-2 Setting the Connection Method

You must set the connection method, IP address to connect to, and other parameters for communica-
tions between the computer and HMI.

1 Select Communications Setup from the HMI Menu.
The Communications Setup Dialog Box is displayed.

ications Setup {E=8EcR x|

2 Select the connection method for the connection configuration in the Connection Type Field.

For an Ethernet connection via a hub, enter the IP address of the HMI to which you need to con-
nect in the Remote IP Address Area. Select any required options and enter the communications
time-out time if required.

Note Refer to Communications Setup Dialog Box Settings on page 6-5 on the next page for information on
the settings.

3  Click the OK Button.

This concludes the settings.
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® Communications Setup Dialog Box Settings

Item Description
Connection Type Select the connection port to use to go online.

The selected method is normally used to go online.
Remote IP Address If you specify an Ethernet hub connection, set the IP address of the HMI that you will
connect to. Also, you can click a test button to perform a communications test.

Test USB Connec- Click the test button to perform a USB communications test.

tions

Options Confirm serial ID when If you select this option, the names and serial IDs are

going online. compared between the project and the HMI when you

go online to make sure that a connection is made to the
intended HMI.

Communications You can set the response monitoring time for communications with the HMI.

time-out An error is displayed if a response is not received before this time expires.

*1. The time can be set to between 1 and 3,600 s.

6-2-3 Online Connection

Use the following procedure to place the Sysmac Studio online with the HMI.

1 Select Online from the HMI Menu. Or, click the Go Online Button () in the Toolbar.

The following message is displayed the first time you go online. After you write the project
name, this message is not displayed.

INH ue ypm auluo Buies z-9

Warning

The HMI device has no name.
Do you want to write the project name[HMIL_NA5_0] to the HMI device name? (Y/IN)

Yes No

@ Additional Information

The same message will be displayed the next time you connect if the HMI device name that is
set in the project is different from the HMI device name that is set in the HMI.

UoIPBUUO) BUIUQ €-Z-9
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6 Connecting to the HMI

2 Click the Yes Button.

The Sysmac Studio goes online and the color of the bar under the Toolbar changes to yellow.

B New Project - HMI_NAS_0 - Sysmac Studio

File Edit
I ol en
| T

|E=E| I~
View Insert Project HMI Simulation Tools Help
B A A @ E «
Multiview Explorer

-~ -Pageo X ~| Toolbox
HMLNAS_0 v ||. 3 ‘|

» Configurations and Setup

[ Pa:

.
‘¥ Buttons

[B@ Mom

Set Button
B % Data
% Global Events
» & Global Subroutines

[ Toggle Button
£ Resources

» Lamps
Button
A Button object.
Output b3 Device Status >

ONLINE Direct [USB]

H Filter

) I 4

6-2-4 Going Online after Checking the Connection Method

Use the following procedure to go online if you selected the option to select the connection method
whenever you connect the computer with the HMI in the Communications Setup Dialog Box.

1 Select Online from the HMI Menu. Or, click the Go Online Button () in the Toolbar.
The Communications Setup Dialog Box is displayed.

Communication Settings
Connection Type

O Direct connection via USB

. Direct connection wvia Ethernet

@ Ethemet connection via a hub

192.168.250.1

Cancel

The IP address that is set in the Communications Setup Dialog Box is displayed below the
Ethernet connection via a hub Option.

Select the connection method and then click the OK Button.
The Sysmac Studio goes online.

6-2-5 Going Offline

Use the following procedure to go offline.

Select Offline from the HMI Menu. Or, click the Go Offline Button () in the Toolbar.
The Sysmac Studio goes offline.
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6 Connecting to the HMI

6-2-6 Confirming Serial IDs

The serial ID is verified when going online if the option to do so was selected in the Communications
Setup Dialog Box. If the serial ID of the project on the Sysmac Studio is different from that of the HMI,
the following confirmation dialog box is displayed when you attempt to go online.

Warning

Name / Serial ID does not match.

Project:
Name: [HMLNAS 1]
Serial ID: [[NL-DB-19112013-0000]]

HMI device:
Name: [HMIL_NAS_0]
Serial ID: [[NL-DBE-19112013-0003]]

Do you want to change the Name / Serial ID in the project to match the HMI device's Name £ Serial ID? (Y/N)
(It will be used for the HMI device name [ ID check at the next online connection.)
Press the Cancel button if you want to go offline.

Yes No Cancel

1 Click the Yes Button.

The serial ID of the project on the Sysmac Studio is rewritten to the same value as that of the
HMI.

INH ue ypm auluo Buies z-9

M Precautions for Correct Use

+ If a USB connection is used, an Ethernet IP address of 192.168.255.xxx is used internally.
When using a USB connection, do not use an IP address of 192.168.255.xxx for the Ethernet
interface card in the computer.

» Socket ports 9600 and 2224 are used for Ethernet UDP/IP communications. When using
Ethernet UDP/IP communications, do not use these ports for any other application.

* When using a direct Ethernet connection and there is more than one Ethernet interface card
mounted in the computer, you must select the Ethernet interface card to use. Refer to the
Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for specific selection proce-
dures.

sq| [eWss Bulwiyuo) 9-z-9
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Debugging
I

This section describes offline debugging using the HMI Simulator.

7-1 HMI Debugging Functions . . ............. . . 7-2
7-1-1 Watch TabPage . ....... . e 7-3
7-1-2  Breakpoints . ... ... e 7-3
7-1-3  Step Execution . ........ ... e 7-5
7-1-4  Simulator Functions . .......... .. 7-8
7-1-5  Offline Debugging with Only the HMI Simulator .. ...................... 7-9
7-1-6  Offline Debugging with the Controller Simulator .. ..................... 7-10
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7 Debugging

7-1  HMI Debugging Functions

The operations you can use for debugging on the Sysmac Studio are listed below. The HMI Simulator is
used for offline debugging. You can use the HMI Simulator by itself, or you can connect it to the Control-
ler Simulator to debug the entire system.

Although the Simulator simulates the operation of the HMI, there are differences from the

HMI in operation and timing. After you debug operation with the Simulator, always check

operation on the actual Controller and HMI before you use them in the actual system. Acci-

dents may occur if the controlled system performs unexpected operation. Refer to A-4 Dif-

ferences between the Physical HMI and Simulator on page A-10 for details on differences

in operation.

Although offline debugging simulates the integrated operation of the HMI and Controller,

there are differences in operation and timing in comparison with combining the actual HMI

and Controller. After you debug operation with the simulation, always check operation on 0

the actual Controller and HMI before you use them in the actual system. Accidents may

occur if the controlled system performs unexpected operation. Refer to A-4 Differences

between the Physical HMI and Simulator on page A-10 for details on differences in opera-

tion.

To run the simulator, administrator rights are required. 0

The following three functions are provided for debugging during HMI simulations. These functions are
the same regardless of whether they are used in offline debugging.

» Watch Tab Page
* Breakpoints
» Step execution

@ Additional Information

The following functions are disabled while the HMI simulator is running.

Changes made while the simulator is running will not be applied until the simulator is turned off.
* Build

» Online and functions that require online (synchronization, etc.)

 Editing subroutines

» Editing devices

 Editing variables and data types
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7 Debugging

7-1-1  Watch Tab Page

The basic Sysmac Studio operations of the Watch Tab Page apply to HMIs.

Refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for details.
However, the following differences exist for HMI projects.

* You can monitor the following variables on the Watch (Project) Tab Page.

Standard projects:  Only global variables can be registered. You can continuously monitor any of
the global variables. Register the variable names as they are.
IAG projects: You cannot monitor variables in the IAG project.

» The Watch Tab Page functions only for the Simulator. Even if you are online with the physical HMI,
you cannot monitor the variables in the physical HMI.

7-1-2 Breakpoints

You can set breakpoints in the source code of a subroutine. You can use breakpoints to pause the exe-
cution of a subroutine at any desired point.

I Setting and Clearing Breakpoints

@ Setting Breakpoints

You can set breakpoints to pause execution of a simulation, e.g., to see the status after a subroutine
is executed.

suopoung buibbngaq INH L-2

® Procedure

To set a breakpoint, move the cursor to the line in the subroutine where you want to set the break-
point and select Set/Clear Breakpoint from the Simulation Menu.

N

If you repeat this operation, the breakpoint will be cleared.

~
: Edit WView Insert Project HMI Simulation Tools Help N
Start NA Simulation F5 =
g
)
(o
N
Lzl @ WriteSubroutine <
1} 'Code behind Page - Add lo
2{=Sub WriteSubroutine
3 WriteRecipeToController(
a End Sub
Set/Clear Breakpoint Fa
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7 Debugging

I Enabling and Disabling Breakpoints

® Disabling a Breakpoint

If you do not need a breakpoint temporarily during debugging, you can disable the breakpoint but

still leave it in the program.

® Procedure for Disabling Breakpoints

To disable a breakpoint, move the cursor to the line of the subroutine that has the breakpoint that
you want to disable, and select Enable/Disable Breakpoint from the Simulation menu. If you per-
form the same steps for a breakpoint that is disabled, the breakpoint will be enabled.

: Edit Wiew Insert Project HMI  Simulation Tools Help
Start NA Simulation

izl @ WriteSubroutine

1} 'Code behind Page - Add lo
2{=15ub WriteSubroutine

Q el WriiteRecipeToController(
4| EndSub

Set/Clear Breakpoint

Clear All Breakpoints

Enable/Disable Breakpoint

=5

Fg
Ctrl+Fg
Ctrl+Shift+F9

I Clearing All Breakpoints

You can clear all of the breakpoints at the same time.

Select Clear All Breakpoints from the Simulation Menu to clear all of the breakpoints.

: Edit WView Insert Project HMI Simulation Tools Help
Start NA Simulation

izl @ WriteSubroutine
1] 'Code behind Page - Add lo
2{=5ub WriteSubroutine

o 3 WriteRecipeToController(

4 End Sub

Set/Clear Breakpoint
Enable/Disable Breakpoint
Clear All Breakpoints

F5

Fa
Ctrl+Fg
Ctrl+Shift+F9
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7 Debugging

7-1-3 Step Execution

You can use step execution when subroutine execution is paused at a breakpoint to trace operation one
line of the source code at a time.

I Step Execution

You can use step execution to execute the source code of a subroutine one line at a time.

If you select Step In and other commands from the Simulation Menu while paused at a breakpoint dur-
ing a simulation, you can control execution one line or one function at a time.

I Step Execution

The Step Execution command executes one function at a time.

Select Step Execution from the Simulation Menu when subroutine execution is paused during step-in

N
execution. =
=
: Edit View Insert Project HMI  Simulation Tools Help o
| &
=
: i ) Q
Stop NA Simulation Shift+F5 Q
=]
Step Execution F10 <
c
[zl @ WriteSubroutine Step In F11 ‘3.
1] 'Code behind Page - Add lo  Step Out Shift+F11 %
2{15ub WriteSubroutine Continue Fo
o 3 WriteRecipeToController( Jump te Current Position
4 End Sub 7
Set/Clear Breakpoint Fa
Enable/Disable Breakpoint Ctrl+Fg
Clear All Breakpoints Ctrl+Shift+F9 N
do
»
(0]
©
o
. . &
I Step-in Execution 8
=
]

Step-in execution performs step execution for the source code of a subroutine.

When you execute a program through the Simulator, select Simulation - Step In when the subroutine
is stopped at a breakpoint, paused, or stopped during step execution.

: Edit View Insert Project HMI Simulation Tools Help

|
Stop NA Simulation Shift+F3
Step Execution F10
Step In F11
1] 'Code behind Page - Add o Step Out Shift+F11
2{=5ub WriteSubroutine Continue F&
(@] 3 WriteRecipeToController(  jymp to current Position
L! End Sub
Set/Clear Breakpoint Fo
Enable/Disable Breakpoint Ctrl+Fg
Clear All Breakpoints Ctrl+5Shift+F9
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7 Debugging

I Step-out Execution

Use the Step Out command to exit a subroutine during step-in execution.

Select Step Out from the Simulation Menu during step-in execution.

=15ub WriteSubroutine
| WriteRecipeTeController(
End Sub

I Continue

Stop NA Simulation

F5

Shift+F5

Step Execution F10
Step In F11
1] Code behind Page - Add Io | step OuE I shifts Rt T
Continue F6
Jump to Current Position
Set/Clear Breakpoint Fa
Enable/Disable Breakpoint Ctrl+F9
Clear All Breakpoints Ctrl+Shift+F2

Run with Controller Simulator...

The Continue command executes the subroutine to the next breakpoint.

Select Continue from the Simulation Menu when subroutine execution is paused during step-in execu-

tion.

1; 'Code behind Page - Add lo
=5Sub WriteSubroutine

riteRecipeToController
WriteRecipeToC ller(
End Sub

=
C

Stop MA Simulation Shift+F5

Step Execution F10

Step In F11

Step Out Shift+F11
Jump to Current Position

Set/Clear Breakpoint F9
Enable/Disable Breakpoint Ctrl+Fg
Clear All Breakpoints Ctrl+Shift+F2

Run with Controller Simulator...

NA-series Programmable Terminal Software User’s Manual (V118)




I Jump to Current Position

7 Debugging

Use this command to jump to the breakpoint at which the program is currently paused in the code edi-

tor.

Select Jump to Current Position from the Simulation menu when subroutine execution is paused dur-

ing step-in execution.

: Edit View Insert Project HMI  Simulation Tools Help

Stop MA Simulation

Step Execution

:::l @ WriteSubroutine Step In
1] 'Code behind Page - Add lo]  Step Out
2|=15ub WriteSubroutine Continue

Q 3 WriteRecipeToController( Jump to Current Position
4 End Sub

Set/Clear Breakpeint
Enable/Disable Breakpoint
Clear All Breakpoints

Shift+F3

F10

F11
Shift+F11
F&

Fa
Ctrl+Fg
Ctrl+Shift+F2
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7 Debugging

7-1-4 Simulator Functions

You can use functions such as page changing in Simulator if the Runtime version is 1.08 or higher.

(@) (b) () (d)
\ | / /

A\ H!\\I_NAS_D

EH -1 [English (United States) I

Templates
Recipe0

Recipe0
RecipeSamplel
RecipeSample2

Name
Recipel
Resipe2

OMmRON

Symbol Item Description

(a) You can select a page to be displayed in Simulator.

(b) E You can output the currently displayed page to the clipboard.
(c) Language Selection You can select the project language to be displayed.

(d) D

Exit Simulator
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7 Debugging

7-1-5 Offline Debugging with Only the HMI Simulator

Before you check the entire system, you can perform debugging with the HMI Simulator alone.

When you create a project and want to debug it, always check operation with only the HMI Simulator
first. The Sysmac Studio comes with a Simulator that simulates HMI functions.

I Procedure

Use the following procedure to start the Sysmac Studio and perform debugging.
Start the Sysmac Studio and create a project.

Create the HMI application.

Select Build HMI from the Project Menu to build the project.

A WN=

Select Start NA Simulation from the Simulation Menu.
MNew Praject - HMI_NAS_O - Sysmac Studio == =n ==

File Edit View Insert Project HMI Simulation Tools Help

[} Start NA Simulation

Clear All Breakpoints Ctrl+Shift+F9

suopoung buibbngaq INH L-2

i HMI_NAS_0

5 2 e orved ) | |

N

Templates Name

Recipe0 Recipel
Resipe2

Recipe0
RecipeSamplel
RecipeSample2

Joeinwis [IAIH 8y} Aluo yum Buibbngeq sunygo G-1-2

% Additional Information

If the project is not yet built, it is built automatically.
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7 Debugging

5 To stop the simulation, click Stop NA Simulation from the Simulation Menu. The HMI Simulator

is ended.

B New Project - HMINAS 0 - Sysmac Studic

o]

HMLNASOD |~ ‘ J=i

'w Configurations and Setup
e

>

A, Language Settings

File Edit View Insert Project HMI Simulation Tools Help

Stop NA Simulation

Clear All Breakpoints

Ctrl+Shift+F9

7-1-6  Offline Debugging with the Controller Simulator

You can perform debugging with the HMI Simulator connected online to the Controller Simulator. This
allows you to debug the project while the Controller program is actually running.

After you complete checking operation with the HMI Simulator alone, check operation that includes the
Controller program. The Sysmac Studio enables integrated debugging of the Controller program and
the HMI application by connecting the Controller Simulator to the HMI Simulator.
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I Procedure

Use the following procedure to start the Sysmac Studio and perform debugging.
Start the Sysmac Studio and create a project.

Create the Controller program.

Create the HMI application.

Select Build HMI from the Project Menu to build the project.

A WN =

Select Run with Controller Simulator from the Simulation Menu.
B New Project - HMI_NAS 0 - Sysmac Studio =R Eon =

File Edit View Insert Project HMI Simulation Teools Help

I - M Start NA Simulation o 3 a a IA Ib

Multiview Explorer 3 Toolbox
HMLNASO  ~ ‘1 '|

» ] Device References
& Variable Mapping Clear All Breakpaints Cirl=Shift=F3
LT HMI Settings
B\ Security Settings
A, Language Settings

Run with Controller Simulator...

@ Additional Information

If there is more than one Controller in the project, the window will be displayed for the Controller
that is currently connected. If you select a Controller for which variables are not mapped, an
error will occur and starting the Simulator will be canceled.

This procedure does not support offline debugging with the NX-series Safety Network Controller.

suopoung buibbngaq INH L-2

The Controller Simulator is started and the HMI Simulator is displayed.
5 (3 [Englsh (Unies tates) | |

N

Templates Name
Recipe0 Recipel
Resipe2?

Recipe0
RecipeSamplel
Recipesample2

JOJEINWIS J9I0AU0D BY} Yim BuiBBngsq suIO 9-1-2

% Additional Information

If the project is not yet built, the entire project including the Controller is built automatically. If a
building error occurs for the Controller, a dialog box is displayed to notify you of the error.
Change the device to the relevant Controller, build the project, and check the error.
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6 To stop the simulation, click Stop NA Simulation from the Simulation Menu. The Controller
Simulator and the HMI Simulator are stopped.

(B8] Mew Project - HMINAS 0 - Sysmac Studic

[ESREeR

File Edit View Insert Project HMI Simulation Tools Help

Stop NA Simulation

Multiview Explorer

HML!

» il Device References
& Variable Mapping
I HMI Settings
&, Security ings.
A, Language Settings

Clear All Breakpoints

@ Additional Information

Ctrl+Shift+F9

w Events and Actions.
Paged

Events

You can also start online debugging when the Controller is selected in the project. Refer to the
Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for details.
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Synchronizing Projects
I

This section describes how to synchronize the projects between the HMI and the Sys-
mac Studio.

8-1 Synchronizing Projects ............... i iiiiinaeneens 8-2
8-2 Downloading . .......co ittt i e e e 8-6
8-2-1 Downloading While Online . ..... ... . .. . . .. . . . . . .. 8-6
8-2-2  Using Storage Media for Downloading . ........... ... ... ... .. ... .. .... 8-7
8-3 Uploading ...t i i s it e 8-10
8-3-1 Uploading Projects Online . ....... ... ... . . i 8-10
8-3-3 Uploading with Storage Media .......... ... ... ... . ... .. . ... 8-13
8-3-4 Relinking Internal Devices .......... ... .. i 8-17
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8 Synchronizing Projects

8-1 Synchronizing Projects

Synchronization is used to transfer the project from the Sysmac Studio to the HMI.

The basic Sysmac Studio operations for synchronization generally apply to HMIs. Refer to the Sysmac
Studio Version 1 Operation Manual (Cat. No. W504) for details.

This section describes differences in synchronization when an HMI is selected.

/A WARNING

Sufficiently check the operation of any project that you create before you start actual system 0
operation.

Precautions for Safe Use

Unexpected operation may result if you set inappropriate network configuration settings. Even
if appropriate network configuration settings are set, confirm that the controlled system will not
be adversely affected before you transfer the data.

m Precautions for Correct Use

Do not perform any other operations on the Sysmac Studio while the Synchronization Window
is active. An error will occur and synchronization will fail.
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8 Synchronizing Projects

I Functional Differences When an HMI Is Selected

The following differences exist in synchronization when an HMI is selected.
» Detailed comparison is not supported.
+ Algorithm checking is not supported. Therefore, there is no way to prevent mismatches in build dates
that result from rebuilding.
« If the project version specified in the project is different from the version of the project in the HMI, the
runtime files will always be transferred.

» The following synchronization options are provided.

) When trans- o
Option Default fer is enabled Description

Transfer source code to | Selected. Values written | Select this check box to transfer the source code.

the NA device. to HMI

Relink internal devices in | Selected. Values written | If this check box is selected, global variables are

the project (valid for from HMI automatically mapped to the Controller that is regis-

Transfer From Device) tered in the project when the project is uploaded.

Clear the present values | Selected. Values written | If this check box is selected, the present values of

of variables with Retain to HMI Retain variables are cleared after the data is down-

attribute. loaded.

Clear alarm log data from | Selected. Values written | If this check box is selected, the alarm log in

memory to HMI non-volatile memory is cleared. If you have changed
the user alarm settings, you cannot clear the selec-
tion of this check box.

Clear Data log data from | Selected. Values written | If this check box is selected, the data log data in

memory to HMI non-volatile memory is cleared. If you have changed
the data logging settings, you cannot clear the
selection of this check box.

Clear the operation log Selected. Values written | If this check box is selected, the operation log in

buffer memory. to HMI non-volatile memory is cleared. If you have changed
the operation logging settings, you cannot clear the
selection of this check box.

Apply default values to Selected. Values written | Overwrite the default values of the NA unit project

the project. (Upload) from HMI with the default values of the currently open project
when the project is uploaded.

Forcibly transfer Runtime | Not Values written | Downloads the Runtime files forcibly.

files. (Downloading) selected. to HMI

» The following dialog box is displayed when you connect to the HMI if the version of the system pro-
gram in the HMI is older than the version of the system program in the Sysmac Studio. You must
update the system program before you can perform synchronization. Update the system program
according to the displayed instructions.

Operating System Version Mismatch
Project Operating System Version = 1.1.0
Device Operating System Version = 1.0.0

The versions are incompatible.

Would you like to update the device to match the project?
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8 Synchronizing Projects

m Precautions for Correct Use

* Projects that are downloaded with Sysmac Studio version 1.10 cannot be uploaded.

» Projects that are downloaded when the Transfer source code to the NA device Check Box is
not selected cannot be uploaded.

« If a project with a different system version from the HMI is downloaded, the values of Retain
variables, the user alarm log, and the data log buffer memory will be initialized.

» Changing the settings with the HMI may result in a discrepancy at the comparison result,
even if the settings are the same.

* When version 1.10 or earlier of IAG is used in a project with Runtime Ver. 1.11 or later, the
page in which IAG is used may be different. When using Runtime Ver. 1.11 or later, use ver-
sion 1.11 or later of IAG in order to eliminate the differences.

* When using the Safety Monitor, perform safety validation on the safety controller before exe-
cuting synchronization.

» For a project downloaded to the NA unit with Sysmac Studio Ver. 1.31 or earlier, differences
may occur if synchronization is performed using Sysmac Studio Ver. 1.40 or later. This is
caused by a difference in the internal data structure and thus there is no problem on the proj-
ect itself. To eliminate the differences, download with Sysmac Studio Ver. 1.40 or later.

* When a custom keypad is used, the language setting and custom keypad may become
inconsistent.
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I Differences in Comparison Results

The following differences apply to the comparison results.

@ Verification Results Example

The verification results are displayed as shown in the following example.

Column Item
Source Project name on the Sysmac Studio
Source Modified Date The last time that the project was built on the Sysmac Studio
Target Modified Date The last time that the HMI project was built on the Sysmac Studio
Target HMI project name
Detailed Comparison This column is not used when an HMI is selected.

® Verification Units

The units for comparison that are shown in the Synchronization Window are listed in the following

table.
Synchronization data name | Level Qty Deta"?d Remarks
comparison

HMI name 1 1 None

Project 2 1 None -
Pages 3 1 None a
Page* 4 N None &
Subroutines 3 1 None ‘:}
SubroutineGroup* 4 N None g_
Variables 3 1 None =
Global Events 3 1 None ‘%
Alarms 3 1 None ‘?39'
Data Groups 3 1 None &
Data logging 3 1 None

Recipe Template 3 1 None

Project Security 3 1 None

Troubleshooter 3 1 None

Languages 3 1 None

* 4 N None

Operation Log Settings 3 1 None

Settings 3 1 None

HMI Settings 4 1 None

User Data 3 1 None

User Accounts 4 1 None

Recipe Instances 4 N None

Resource Files 3 1 None

Documents 4 1 None

*x 5 N None

Images 4 1 None

Videos 4 1 None

*x 5 N None

Safety Data 3 1 None

* 4 N None
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8 Synchronizing Projects

8-2 Downloading

To execute a project that you created in the HMI, you must use synchronization to download the proj-
ect. This section describes how to download the project.

8-2-1 Downloading While Online

You can use the following procedure to download the project while the Sysmac Studio is online.

1
2

Place the Sysmac Studio online with the HMI. Refer to Section 6 Connecting to the HMI for
details.

Click L-} on the Toolbar. Or, select Synchronization — NA Device from the HMI Menu.

The project on the Sysmac Studio is compared with the project in the HMI and the Synchroniza-
tion Window is displayed.

odified DatdTarget Modified Date| [Detailed Comparisor|

¥ Subroutines ¥ Subroutines
SubroutineGroup 2020/07/29 11:00:46 2020/07/29 10:58:00 SubroutineGroupl

Global E 0046 2020/07/20 10:58:02
Alarms 2020/07/29 11:00:46 2020/07/29 10:58:01
Data Groups 2020/07/29 11:00:46 2020/07/29 10:58:01

Recipe Templates 00- Recipe Templates
Project Security. 4 2 Project Security.
Tr

¥ Languages
English (United Statc

=}
M
m
M
m
M
u
L
L
u
L
u
L}
L]

2020/07/29 11:0046 2020/07/29 10:58:01
Safety Data Safety Data

Legend: | Synchronized Exists onl side ||

Kl Store the HMI Project source code o or uploading the project)
Kl Relink intemal devices in the project (valid for Transfer From Device)
[Z] Clear the present value of variables with the ‘Retain’ attribute
M Clear Alarm log data from memory
[ Clear Data log data from memory
M Clear the operation log buffer memory

fault values to the project (Upload)

sfer Runtime files (Downloading)

]

Transfer To Device Transfer From Device  Recompare

Select the items to download and select the options as required.

Click the Transfer to Device Button. The data is downloaded and the HMI is restarted.
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8 Synchronizing Projects

M Precautions for Correct Use

If you download a project simultaneously with PUT processing of a file from a client device
using the FTP server, the FTP-transferred file may be lost or downloading may fail.

8-2-2 Using Storage Media for Downloading

With an HMI, you can perform product downloads with storage media.
1 Insert an SD Memory Card or USB memory device to use for the download into the computer.

2 Select Synchronization — Media Device from the HMI Menu.
New Project - HMI_NAS5_0 - Sysmac Studio (64bit)
[ F

Communications Setup...

I G D

Change Device

Multiview Explorer -0 Online

=1
HMINAS O v ||...J|
b4 Configurations and Setup
» MediDeice.

Transfer

Security

3 Select the file to use for the download and click the OK Button.
Synchronize with Media Device

veca ot [ e

Awvailable Files | yMINA_ 2014 10 01.nabin
HMINAS_0.nabin

Filename HMI_NAS_0.nabin

NA-series Programmable Terminal Software User’s Manual (V118) 8-7

Buipeojumoq z-8

Buipeojumo( Jo} eipay abeloys Buisn z-z-8




8 Synchronizing Projects

o O

4 The project on the Sysmac Studio is compared with the project in the storage media and the

Synchronization Window is displayed.

Synchronisation

| Source [source Madified DateTarget Modified Date| Target Detailed Comparison]

< 4

Rl

¥ Subroutines ¥ Subroutil
SubroutineGroup0  2020/07/29 11:15:52 2020/07/29 11:14:07 SubroutineGroupd

Global Events 2020/07/29 11 14 Global Events
Alarms 2020/07/29 11 3 2020/07/29 11 Alarms
Data Groups 2020/07/29 11:15:53 2020/07/29 11:14:07 Data Groups

Recipe Templates  2020/07/29 11 14 Recipe Templates
Project Security 2020/07/29 11: Project Security
Troubleshoater 2020/07/29 11:15:53 2020/07,/29 11:14: Troubleshoater

¥ Languages ¥ Languages.
English (United Stat 2020/07/29 11 )7 2020/07/29 11:14: English (United Stat:
Operation Log Setting 2020/07/29 11:15:52 2020/07/29 11 Operation Log Settine
¥ Settings ¥ Settings
HMI Settings 2020/07/29 11:15:54 2020/07/29 11:14:08 HMI Settings

¥ User Data ¥ User Data
User Accounts. 2020/07/29 11:15:52 2020/07/29 11:14:07 User Accounts.

Recipe Instances Recipe Instances
¥ Resource Files ¥ Resource Files
Images 2020/07/29 11:15:53 2020/07/29 11:14:07 Images

(m]
t
]
|
1]
|
il
u
m

Legend: | Synchronized

i Store the HMI Praject source code on the NA Device (required for uploading the project)
| Ei Relink internal devices in the project (valid for Transfer From Device)

B Apply default values to the project, (Upload)

B Forcibly transfer Runtime files. (Downloading)

Transfer To Media Device  Transfer From Media Device 'Recompare

Click the Transfer to Media Device Button to transfer the project to the storage media.

Insert the storage media into the HMI, display the Device System Menu, and touch the Transfer
Operations Button.

fi Device System Menu

i A N N
_G Aﬁ o0 -r?\-

Date & Time Settings Language Settings Interface Settings Brightness Settings

&N

Transfer Operations Hardware Diagnostics Production Information
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8 Synchronizing Projects

7 Touch the Transfer User Program To HMI Button.

Transfer Operations

s . =i i

| = | =l

Transfer User Transfer User Transfer Data To  Transfer Data From
Program To HMI ~ Program From HMI HMI HMI

8 Select the project to transfer and touch the Transfer to HMI Button to download the selected
project to the HMI.

Transfer User Program To HMI

Source Media USB Storage

\USBDisk

Name
HMI_NAS5 0.nabin

Buipeojumoq z-8

Compare with HMI

Transfer to HMI

Buipeojumo( Joj eipa|y abelols Buisn z-z-8
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8 Synchronizing Projects

8-3 Uploading

To edit the project in an HMI on the Sysmac Studio, you must use synchronization to upload the project.
This section describes how to upload the project.

8-3-1 Uploading Projects Online

You can use the following procedure to upload a project while the Sysmac Studio is online.

1
2

Place the Sysmac Studio online with the HMI. Refer to Section 6 Connecting to the HMI for
details.

Click the (Synchronize) Button on the Toolbar. Or, select Synchronization — NA Device
from the HMI Menu.

The project on the Sysmac Studio is compared with the project in the HMI and the Synchroniza-
tion Window is displayed.

Synchronisation

Source [Source Modiified DateTarget Modified Date| Target Detailed Comparison
v

v

¥ Subrouti ¥ Subrouti
SubroutineGroup0  2020/07/29 11:15:52 2020/07/29 11:09:19 SubroutineGroupd.

Global Events 2020/07/29 11:15:53 2020/07/29 11:09: Global Events
Alarms. 2020/07/29 11:15:53 2020/07/2 11:09: Alarms
Data Groups 2020/07/29 11:15:53 2020/07/29 11:09: Data Groups

Recipe Templates  2020/07/29 11:15:53 2020/07/29 11:0%: Recipe Templates
Project Security  2020/07/29 11 2020/07/29 11 Project Security
Troubleshooter 2020/07/2911:15:53 2020/07/29 11 Troubleshooter

es
{United Stat: 2020/07/29 11:16:07 2020/07/29 11
Operation Log Setting 2020/07/29 11:15:52 2020/07/29 11
¥ Settings
HMI Settings 2020/07/2911:15:54 20 i HMI Settings
¥ User Data ¥ User Data
User Accounts. 2020/07/29 1151552 20: 09:19 Accounts
Redipe Instances Redipe Instances
¥ Resource Files ¥ Resource Files
Images. 2020/07/2911:15:53 2020/07/29 10:58:01 Images.
Safety Data Safety Data

Legend: | Synchronized

uploading the praject)
€)

default values to the project. (Upload)
y transfer Runtime files. (Downloading)

Transfer To Device  Transfer From Recompare

Source [Source Modiified DateTarget Modified Date| Target Detailed Comparison
v

v

¥ Subroutines ¥ Subrouti
SubroutineGroup0  2020/07/29 11:15:52 2020/07/29 11:09:19 SubroutineGroupd.

Global Events 2020/07/29 11:15:53 2020/07/29 11:09: Global Events
Alarms. 2020/07/29 11:15:53 2020/07/29 11 Alarms
Data Groups 2020/07/29 11:15:53 2020/07/29 11:09: Data Groups

Recipe Templates  2020/07/29 11:15:53 2020/07/29 11 Recipe Templates
Project Security  2020/07/29 11 2020/07/29 11 Project Security
Troubleshooter  2020/07/29 11:15:53 2020/07/29 11 Troubleshooter

¥ Languages ¥ Languages

English (United Stat: 2020/07/29 11:16:07 2020/07/29 11 English (United Staty
Operation Log Setting 2020/07/29 11:15:52 |2020/07/28 11:08: Operation Log Setting

2020/07/29 11:15:54 2020/07/29 10:56:02

User Accounts 2020/07/29 11:15:52 2020/07/29 11:08:19
Redipe Instances Redipe Instances
¥ Resource Files ¥ Resource Files
Images 2020/07/29 11:15:53 2020/07/29 10:58:01 Images
Safety Data Safety Data

Legend: | Synchronized

uploading the praject)
€)

default values to the project. (Upload)
fer Runtime files. (Downloading)

Transfer To Device  Transfer From Device  Recompare
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8 Synchronizing Projects

m Precautions for Correct Use

When a project is uploaded, the internal devices are not linked. In this condition, you will not be
able to perform offline debugging with the Controller Simulator, or variable mapping.

Refer to 8-3-4 Relinking Internal Devices on page 8-17 for information on how to relink internal
devices.

5 Click the Transfer From Device Button. The following confirmation message for overwriting is
displayed. Click the Yes Button.

Sysmac Studio

The project will be overwnitten. Do you want to continue?

| W]

The project is uploaded and the changes are applied to the open project.

Buipeojdn ¢-8
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8 Synchronizing Projects

8-3-2 Uploading with the Upload Function
The upload function is a specialized uploading function that makes uploading easier.
1 Click [B§ on the Toolbar. Or, select Transfer — Transfer From Device from the HMI Menu.

2 Select the options and click Execute.

Transfer From Device X
Transfer all data.

Option

Relink internal devices in the project.

Apply default values to the project.

3 The following confirmation message for overwriting is displayed. Click the Yes Button.

Transfer From Device

Project data is owerwritten. Do you continue the process?

Yes Mo

@ Additional Information

The upload function differs from online uploading in the following ways:
» Cannot be run when online.
» System program updating is not run.
 Building is not performed before the upload.
» Uploading is run even if errors remain.

» The Synchronization Window is not displayed. Therefore, the upload always applies to all
upload items.
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8 Synchronizing Projects

8-3-3 Uploading with Storage Media
With an HMI, you can perform project synchronization with storage media.

1 Insert the SD Memory Card or USB memory device to use for the upload into the computer.

2 Display the Device System Menu and touch the Transfer Operations Button.

i Device System Menu

s Aﬁ oo

Date & Time Settings Language Settings Interface Settings Brightness Settings

P

Transfer Operations Hardware Diagnostics Production Information

3 Touch the Transfer User Program From HMI Button.

Transfer Operations

Buipeojdn ¢-8

=i = =

et
4
e =
] — ] g
Transfer User Transfer User Transfer Data To  Transfer Data From
Program To HMI  Program From HMI HMI HMI

eips|\ abeiois yim Buipeoidn ¢-¢-8
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8 Synchronizing Projects

4 Specify the destination media and file name and touch the Transfer From HMI Button. The proj-
ect is uploaded to the specified media.

Transfer User Program From HMI

Destination Media

| Last modified

File Name HMI_NA_2014_10_01.nabin

5 Insert an SD Memory Card or USB memory device into the computer and select Synchroniza-
tion - Media Device from the HMI Menu.
MNew Project - HMI_NAS_0 - Sysmac Studio (32bit)
File Edit View Insert Project HMI Simulation Tools Window Help

ly a & = o
v @ B @ Communications Setup.
L Change Device
Multiview Explorer -~ Online
=1
Laud
Synchronization

Transfer

Security

P Langu
2, Opera

6 Specify the file name on the media specified for the upload and click the OK Button.
Synchronize with Media Device

M=t el R -

Available Files | yMINA 2014 10 01.nabin
HMIMAS _0.nabin

Filename HMI_MAS_0.nabin
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8 Synchronizing Projects

7 The project on the Sysmac Studio is compared with the project in the storage media and the
Synchronization Window is displayed.

Source [Source Modified DatdTarget Modified Date| Target |Detailed Comparison|
t|w v
v v
¥ Pages ¥ Pages
Page0 2020/07/29 11:34:34 2020/07/29 11:14:07 Page0
¥ Subroutines ¥ Subroutines
SubroutineGroupd | 2020/07/29 11:34:34 2020/07/29 11:14:07 SubroutineGroupd

Global Events 2020/07/29 11:34:35 2020/07/29 11:141 Global Events
Alarms 2020/07/29 11:34:34 2020/07/29 1 Alarms
Data Groups 2020/07/29 11:34:34 2020/07/29 1 Data Groups
Data Logging 120207077 34 2020/07/29 11:14:07 Data Logging
Recipe Templates |2020/07/20 11:34:34 [2020/07/29 11:14:07 Recipe Templates
Project Security  |2020/07/20 11:3435 [2020/07/29 11:14:08 Project Security
Troubleshooter 2020/07/29 11:24:35 2020/07/29 11:14:08 Troubleshooter
¥ Languages ¥ Languages
English (United Statc2020/07/20 11:34:50 (2020/07/20 11:14:2 English (Units
Operation Log Setting 2020/07/29 11:24:34 2020/07/29 1 Operation Log
¥ Settings ¥ Settings
HMil Settings 2020/07/29 144 HMiI Settings
¥ User Data ¥ User Data
User Accoun 2020/07/29 11:34: 14 User Accounts
Recipe Instances Recipe Instances
¥ Resource Files ¥ Resource Files
Images 2020/07/29 11:34:34 | 2020/07/29 11:14:07 Images

Legend: | Synchronized

Store the HMI Project saurce code on the NA Device (required for uploading the project)
salid for Transfer From D

efault values to the project (Upload)
bly transfer Runtime files (Downloading)

Transfer To Media Device  Transfer From Media Device ~ Recompare

M Precautions for Correct Use

When a project is uploaded, the internal devices are not linked. In this condition, you will not be
able to perform offline debugging with the Controller Simulator or variable mapping.

Refer to 8-3-4 Relinking Internal Devices on page 8-17 for information on how to relink internal
devices

Buipeojdn ¢-8
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8 Synchronizing Projects

8 Click the Transfer From Media Device Button. The following confirmation message for over-
writing is displayed. Click the Yes Button.

Sysmac Studic

The project will be overwntten. Do you want to continue?

The project is uploaded and the changes are applied to the open project.
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8 Synchronizing Projects

8-3-4 Relinking Internal Devices

When a project is uploaded, the internal devices will not be linked and there will be restrictions on oper-
ations related to the Controller, such as variable mapping. This section describes how to relink a Con-
troller in the project.

] Relinking while Uploading

If you select the Relinking to Internal Devices Check Box and upload the project, the internal devices in
the project that was uploaded are automatically relinked to the Controller of the same name. If there is
no Controller of the same name in the project, the Controller is registered as an unlinked Controller.

During relinking, the variables that are registered in the Controller in the project are compared with the
variables that are not registered in the Controller in the project. If no errors are detected, relinking is
completed.

I Relinking after Uploading

If you do not select the Relinking to Internal Devices Check Box and upload the project, the internal
devices in the project that was uploaded will not be linked to the Controller’s project.

“Multiview Explorer -

HMI_MAS O - II II
¥ Configurations and Setup

¥ @ Device References
¥ # Internal Devices
"B new_Controller_0 (Unlinked)
 new_Controller_0
Use the following procedure to link the unlinked Controller with the Controller in the project.

Buipeojdn ¢-8

1 Place the Sysmac Studio offline from the HMI. Refer to Section 6 Connecting to the HMI for
details.
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8 Synchronizing Projects

2 Open Device References under Configurations and Setup in the Multiview Explorer and dou-
ble-click the unlinked Controller.

D New Project - HMI_NA5_0 - Sysmac Studio

[E=SSEeR

Multiview Explorer
HMLNAS_0 -
] ¥ @ Device References
] ¥ ] Internal Devices

@ new_Controller 0
«# Variable Mapping

A Filter

=l

=

w Configuraticns and Setup

Device Vendor

Device Series

' . new_Cantroller_0 (Unlinked)

‘Communication Driver

new_Controller 0

Build

Description

~Communications Configuration

1P Adk 192 .168.250. _ 1

Ei Communication Error Indication

| Program | Location

3 Select the Controller to link in the Internal Devices Area and click the Link to Internal Device

Button.

¥ Device Configuration
- Device Configuration
Device Name

Device Vendor
Device Senes

Communication Driver

~Internal Device

4\ This device reference i

Link to Internal Device

new_Controller_0

s not linked to an internal d

new_Controller_0

—~Communications Configuration

IP Address

Timeout

4 The variables that are registered to the specified Controller are compared with the variables that
are registered to the unlinked Controller. If no errors are detected, relinking is completed.
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8 Synchronizing Projects

@ Additional Information

If any variables that are registered to the destination Controller do not agree with the variables
that are registered to the unlinked Controller when relinking is executed, the following dialog
box is displayed.

Modify the global variables in the Controller and in the HMI according to the information pro-
vided in the dialog box.

B Relink Conflicts =1

some variable mappings will be invalid after the relinking has completed. The mappings will still be applied, but it will not be build the project until the (a)
Issues are resolved. Please review the mappings in the list below and click either Continue to proceed, or Cancel to abort the oper

Data Type Variable | Reason |
_bin- The port does not exist
r_0_intS--- The port does not exist

2invalid mappings have been found Continue Cancel

() (b
e
Letter Item Description Remarks Z
(a) Conflict list Lists all of the conflicts. 'g—
(b) Cancel Cancels relinking. 2
(c) Continue Leaves the conflicts and completes relinking. @

$80IA8( [BuJalU| Bupjulisy p-£-8
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This section describes how to reuse objects.
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9 Reusing Objects

9-1 Reusing Objects

The Sysmac Studio provides the following two functions to simplify and increase the speed of the devel-
opment of HMI applications.

* Intelligent application gadgets (IAGs)
» Custom objects

IAGs and custom objects are different in the following ways.
* You can distribute IAGs to other parties. You can use custom objects only on the Sysmac Studio.

* You must treat IAGs as IAGs even after you place them on pages. You treat custom objects like any
other objects after you place them on pages.

» After you place an IAG on a page, you can change only the properties of the IAG objects. You can
change any of the attributes of custom objects.

* You can hide the contents of subroutines in IAGs. Therefore, you can provide IAGs to other parties
without disclosing technology.

You can customize objects yourself and create reusable objects that combine other objects.
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9 Reusing Objects

9-2 IAGs

An IAG is a library object that you can distribute to other parties. To create a new IAG, you must create
it in an IAG project. This section describes the procedures to create and use IAGs.

9-2-1 Differences when an IAG Project Is Selected

Even when an IAG project is selected, basic operations are generally the same as for a standard proj-
ect. However, the following items are different.

I Items in the Multiview Explorer

The structure of the Multiview Explorer when you select an IAG project is shown below. You can edit the
user-defined variables, subroutines, and other resources in an IAG from the menu that is displayed
when you right-click the IAG.

Multiview Explorer

LA Configurations and Setup
Py

B IAG Collection Settings

- [ Data
P 77 Resources
Configurations and Setup HMI
Language Settings IAGs
IAG Collection Settings Data
Resources

NA-series Programmable Terminal Software User’s Manual (V118) 9-3
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9 Reusing Objects

I Toolbar

This section describes the differences in the Toolbar compared with a standard project.

® Insert Menu

Sample Project [IAG] - IAG_Device 0 - Sysmac Studic

File Edit View Insert Project Simulation Tools Help

Item

Des

cription Remarks

IAG

Inserts a new IAG in IAGs.

® Project Menu

Sample Project [IAG] - IAG_Device_0 - Sysmac Studio

File Edit View Insert Project Simulation Tools Help

Build IAGs F8
Publish IAG Collection...

Item

Description Remarks

Build IAGs

Builds all of the IAGs.

Publish IAG Collection

Saves an IAG collection in a file format that you can use in a standard project.

I Language Settings

You can set the languages to use in the IAG.

Language Settings X

Language List

: Project Languages FontFamily
Default language  :English (United States)

Segoe UL

FontSize FontStyle
Normal

(e)

(a)/ (b) (\C) \(d)
Symbol Item Description
(a) n Adds a language to the language list.
(b) Deletes the selected language from the language list.
(c) Moves the selected language one position up in the language list.
(d) Moves the selected language one position down in the language list.
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9 Reusing Objects

Symbol Item Description
(e) Language List Displays a list of the languages. The language at the top of the list is
treated as the default language.
Project Languages Sets the project language.
FontFamily ™ Sets the font that is set by default when an object is created.
FontSize ™ Sets the font size that is set by default when an object is created.
FontStyle ! Sets the font style that is set by default when an object is created.

*1. Only appears when the Runtime version is 1.11 or higher.

I IAG Collection Settings

You can make the following settings for an IAG collection.

-
New Project [IAG] - IAG_Device_0 - Sysmac Studio

File Edit View Insert Project Simulation Tools Help

|* » @&

Multiview Explorer

L4 Configurations and -
5. Language Settings New Project (a)
h, e s
g Wersion 1.00 (b)
v ecrpion ST
» () IAGs (c)

» [ Data

P ;7 Resources Publisher (d)
Visible By Default ll (e)
Symbol Item Description Remarks
(a) Name Sets the name.
(b) Version Sets the version.
(c) Description Sets a description.
(d) Publisher Sets the publisher.
Select this check box to display the IAG collection ©
(e) Visible By Default | in the Toolbox when the IAG collection is imported Y
into the Sysmac Studio. :é_’;
(7]

pajos|eg s| 108loid DY| Ue usym ssoustayld L-Z-6
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9 Reusing Objects

| 1aGs

The following tab page is used to create an IAG. The procedures are generally the same as for standard
projects, except for the following differences.

There are no global variables. Only the user variables for each IAG can be used.

You cannot set page animations.

You cannot use functions that cannot be placed on a page, such as global events and recipes.
You cannot use Trend Graph or Broken-line Graph objects and user-created IAGs.

B New Project [1AG] - IAG_Device_0 - Sysmac Studio =lE
Eile Edit View Insert Project Simulation Tools Help

|* am s

Multiview Explorer ) m | Toolbox
B m English (U =

» Buttons
> Lamps

» Shapes

b Standard Controls
» Gauges

> HMI Controls

» Custom

» Ammows

» Blowers

» Conveyors

b Flags

» Flow Meters

» Hoppers

» Motors

» Pipes

» Pumps

» Tanks

b Valves

Output .1 x » WemingSigns

= IR 4 e

@ Additional Information

You cannot use names that are reserved by the system for user event names.
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9 Reusing Objects

For IAG, only the variables for each IAG can be used. The variables that are defined for each IAG are

called user variables.

You can create user variables that are internal variables and user variables that are In/Out variables.

® Editing User Variables

To edit user variables, right-click IAG and select View User Variables from the menu.

=1
LAl

Ll Configurations and Setup

P Languag

g IAG s
v
¥ (@ [AGs
L
» [ Data
> ;7 Resources

Rename
Delete
Cut

Copy

® Internal Variables

The internal variables are used only within the IAG. The internal variables are displayed in the user
variable table, but you cannot access them when you use the IAG.

(@) (b)

() (e)

Letter Item Description Remarks

a Internals or In/Out Changes the display between internal variables
and In/Out variables.

b Name Sets the variable name.

[ Data Type Sets the data type.

d Initial Value Sets the initial value.

e Comment Sets a comment.

NA-series Programmable Terminal Software User’s Manual (V118) 9.7
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9 Reusing Objects

® In/Out Variables

In/Out variables are exposed externally. You can access the In/Out variables when you use the IAG.

(@)

(b)

blnInSample

(c) (d) (e) (f)

Initial Value

Integer

intInoutSample

Letter Item Description Remarks
a Internals or In/Out Changes the display between internal variables
and In/Out variables.
Name Sets the variable name.
Data Type Sets the data type.”!
In/Out If you set an In/Out variable, you can read and
write the variable when you use the IAG.
If you set an input variable, you can only write
the variable when you use the IAG.
e Initial Value Sets the initial value.
f Comment Sets a comment.

*1. Enumeration type is not supported.

I Data Types

You can set the data types to use in the IAG. The procedures are the same as for a standard project.

Enumerated

Base Type Comment

Boolean

Boolean

Boolean
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9 Reusing Objects

I Resources

You can set the resources to use in the IAG. The procedures are the same as for a standard project.

£

Nare Resource ID English {(United States)

String0 String0 Set Button
String1 Stringl Set Button On

F_ |

SOVI 2-6
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9 Reusing Objects

9-2-2 Creating an IAG

This section describes how to create an IAG.

The size of the IAG will be the size of the page when the IAG is created. Any objects that are positioned

outside of the page are ignored.

1 Create a new project and set the project type to IAG Project.

B sysmac Studio

[ Open Project
& Import...

Online

4 Connect to Device
Version Control

fa Version Control Explorer
License

=3 License

fo o=

B Project Properties

Select IAG Project.

Project name

Author

Comment

Type Standard Project
Standard Project

Loary Froject
"3y Select [».Lt =

Category Controller -
Device U501 A

Version v

2 Click the Create Button.

An IAG project is created and the following window is displayed.

B sample Project [IAG] - [AG_Device 0 - Sysmac Studio

[E=8Een )

File Edit Miew Insert Project Si

Tools  Help

=
» Configurations and Setup
» HMI

B Filter

3 Right-click the IAG, select View User Variables from the menu, and then register the required

user variables.

Description

Toolbox

<Search> v

Buttons
Lamps

Shapes

Standard Controls
Gauges

HMI Controls

Custom

Blowers

[

Flags

Flow Meters

Hoppers
Location

I Progam |

>

>

>

>

»>

>

>

P Arrows
>

>

»

>

>

P Motors
>

Pipes
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9 Reusing Objects

4 Create the IAG with the same methods as for a normal page.
B New Project [TAG] - IAG_Devica_0 - Sysmac Studio ==

Fle Edit View Insett Project

Jation  Tools ~ Help

» Buttons

»> Lamps

» Shapes

P HMI Controls
— ~ %X [ Custom

> Arrows

» Blovers

Data Edit
A Data Edit object.

] oo P

5 Select Build IAGs from the Project Menu.

Sample Project [IAG] - IAG_Device_0 - Sysmac Studio

File Edit View Insert Project Simulation Tools Help

Build IAGs F8
Publish IAG Collection...

6 Select Publish IAG Collection from the Project Menu.

Sample Project [IAG] - IAG_Device_0 - Sysmac Studic

File Edit View Insert Project Simulation Tools Help
Build IAGs F8
Publish IAG Callection...

7 Click the Browse Button (...) and specify where to save the collection.

Publish IAG Collection

Pubishing To [

SOVI 2-6

Build IAG Project  Not Started
Publish IAGD Mot Started
PublishIAG File  Not Started

oV| ue buneasd z-z-6
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8 Click the Publish Button. The IAG collection is created.

Publish IAG Collection (23]

T REY C\Users\hmit\Documents\Sample.iag L=

Build IAG Project  Not Started
Publish IAGD Mot Started
Publish IAG File Mot Started

Publish Close
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9-2-3 Using IAGs

This section describes how to use the IAGs that you create when you edit a standard project.

To use IAGs, you must first register them in the Toolbox. After you register them in the Toolbox, you can
drag them to the page to use them in the same way as for other objects.

I Registering IAGs

1 Select IAG Collections Manager from the Project Menu.
B 1AG Collections Manager =8 [E=n =)

+

2 Click the + Button. Select the IAG file and click the Open Button.

Add IAG Collection
{ | v|@ v Libraries » Documents » - |$,| | Search Documents L2 |
Organize * New folder =~ 0l @ ©
N
7 Favorites = Documents_ library B oty Fokder - s
Ml Desktop Includes: 2 locations @)
(7]
-
# Downloads Name Date modified Type
=l Recent Places
|| sample.iag 6/5/2014 506 PM  1AG File
& Libraries
@ Documents L
J’ Music 1
[E5] Pictures ©
0
B8 Videos N
w
% Computer g
£L Local Disk (C) 3
4 >
€ Network o
- 4 i ] r o
File name: Sample.iag - [IAG Collection Files (*.iag) v]
[ Open Iv] l Cancel ]
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9 Reusing Objects

3 Select the Show in Toolbox Check Boxes for the IAG collections that you want to display in the

Toolbox.

[B/14G Collections Manager
B ¥ Sample Project

n Sample Project

Name

Sample

Category

Version Description

100

|E=E He )

K Show in Toolbox

Sample

4 The IAGs for the selected check boxes are displayed in the Toolbox.

<Search>

P Hags

P Flow Meters
Hoppers
Motors
Pipes
Pumps
Sample

—— IAGO

P Tanks

> Valves

P Waming Signs
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5 Drag the IAG to the page.

B New Project - HMI_NAS5_0 - Sysmac Studio

File Edit View Insert Project HMI Simulation Tools Help
[]
1

Multiview Explorer
HMLNA5 0

[<Searcn> |
¥ Configurations and Setup ——
¥ Device References

+ Variable Mapping » Blowers

T HMI Settin
Conveyors
Flags
Flow Meters
Hoppers
Motors
Pipes
Pumps

SamplelAG

output

> Valves
IAGD
Sample

H Filter

6 Double-click the IAG and set the properties.

Set global variables or constants for the variables that are set as In/Out variables.

B8] New Project - HMI_NAS_0 - Sysmac Studio =l e ==
File Edit View Insert Project HMI Simulation Tools Help

Multiview Explorer i R

HMI_NA5_0 v n l zi
¥ General
¥ Configurations and Setup

» i Device References z
& Variable May W=

Name

Version
Publisher  [KSIEIo
¥ Appearance
Bactgroun
¥ Layout
» Position (Le

> U] 500, 480

¥ Behavior

% Global Events
» & Global Subroutines

s

9 1AGO Resources ~ OUtPUE

H Filter
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9 Reusing Objects

9-3 Custom Objects

You can register the objects that you use most frequently to increase your productivity. This section
describes the procedures to create and use custom objects.

9-3-1 Objects That You Can Register as Custom Objects

An object must meet the following conditions before you can register it as a custom object.

* You can register only individual objects.

You cannot register more than one object as a custom object. If you want to register more than one
object as a custom object, group the objects into one object first.

» The object cannot be a user-defined IAG.

You cannot register a user-defined IAG or a group that contains a user-defined IAG as a custom
object.

9-3-2 Creating Custom Objects

Use the following procedure to create a custom object.

1 Create a standard project and place the objects to register as a custom object on the page.
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9 Reusing Objects

2 Group the objects to register the group as a custom object.

Lr=s=0 - I ——

English (United States) v

syoalqO wolsn) ¢-6

Add to Toolbox

sjoelqo woysng Bunessy z-¢-6
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4 The group is added as a custom object under Custom in the Toolbox. The displayed name is
the name of the registered group or object.

Toolbox

<Search>

P HMI Controls

¥ Custom

e Groupl

P Arrows
Blowers
Conveyors
Flags
Flow Meters
Hoppers

Motors

Pipes
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9-3-3 Deleting Custom Objects

Use the following procedure to delete a registered custom object.

1 Right-click the custom object to delete from the Toolbox. Select Delete from the menu.

<Search>

P HMI Controls

¥ Custom

@ orow

Edit Properties

Arrows
Blowers
Conveyors
Flags

Flow Meters
Hoppers

Motors

Y YA Yl VYA YA YA WMaAaw

Pipes

Group0

2 A confirmation dialog box is displayed. Click the Yes Button.

Celete Item

syoalqO wolsn) ¢-6

Are you sure you wish to delete the item? Groupl

sjoelgo woysng Bunejeq €-¢-6
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9-3-4 Using Custom Objects

Itis very easy to use a custom object. Just select the desired custom object in the Toolbox and drag it to
the page. You can handle the custom objects on pages in the same ways as you handle normal objects.

[Bi| sample Project [IAG] - IAG_Device_0 - Sysmac Studio

oS

File Edit View Insert Project Simulation Tools Help
1
|

Multview Explorer

‘l_mr.

v
¥ Configuratiens and Setup

P, Language Settings

718G Coection et -

v 3 1AGs i

P Standard Controls
&7 Resources

P Buttons

¥ Gauges

1 _
Black Half Gauge
Black Horizontal Gauge

Blue Full Gauge
e —————————————————

Build .4 x — BleHalfGauge
x

k3 U o=

[ Description | Progam | L=t Blue Horizontal Gauge

Plain Full Gauge
Black Full Gauge
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10

Connecting to HMIs from External

Devices
]

This section describes how to connect to an HMI from an external device.

10-1 Accessing an HMI from an External Device ....................... 10-2
10-1-1 VNC L 10-2
10-1-2 FTP L 10-3
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10 Connecting to HMIs from External Devices

10-1 Accessing an HMI from an External
Device

You can use the following two methods to access an NA-series Programmable Terminal from an exter-
nal device.

* Remote monitoring and control with VNC

 File operations with FTP

M Precautions for Correct Use

» Only password security is provided for using VNC and FTP. Sufficiently consider the network
configuration in terms of security and implement any required measures to prevent unauthor-
ized access.

» Use the same keyboard layout settings for the VNC client computer and the HMI. If the set-
tings are not the same, different characters may results from the characters input from the
VNC client.

10-1-1 VNC

You can enable VNC to use a VNC client to monitor and control HMI pages. You can also use a mode
setting to prohibit controlling operation from a VNC client and allow only monitoring.

I Setting Method

Double-click HMI Settings under Configurations and Setup. Click the VNC Settings Button.

WNC Server ) Do notuse @ Use
Port No. [Sjslili]

wode (D

password |
Enable VNC multiple login () Disable @ Enable
Enable registered client login () Disable @ Enable

1P Address MAC Address Comment

Select the Use Option for Enable VNC and change the setting of the Mode Box as required. Set a text
string in the Password Box.
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10 Connecting to HMIs from External Devices

After you complete the settings, select Build HMI from the Project Menu. When building the project is
completed, download the project to the HMI.

After the download is completed, you can access the HMI from a VNC client.

@ Additional Information

Refer to the relevant software manuals for the operating procedures of the VNC client.

ue wouy [INH ue Buissadoy L-0L

991A9( [eulaIxXg

10-1-2 FTP

You can enable the FTP server to use an FTP client to access files in the HMI. However, you can
access only specific folder.

dld ¢-l-0l

I Setting Method

Double-click HMI Settings under Configurations and Setup. Click the FTP Settings Button.
_\ HMI Settings x =

FTP

FTP server @ Do notuse Q) Use

Select the Use Option. Set text strings for the login name and password.

After you complete the settings, select Build HMI from the Project Menu. When building the project is
completed, download the project to the HMI.

After the download is completed, you can access the HMI from an FTP client.

@ Additional Information

Refer to the relevant software manuals for the operating procedures of the FTP client.
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Other Functions
]

This section describes other functions that the Sysmac Studio provides for HMIs.

11-1 Sysmac Studio Option Settings ................. ... .. 11-2
-2 Printing ....... i e it e 11-5
11-2-1 Printable Items . ... ... . 11-5
1M-3ImageFileOutput .. ...........c i i e e 11-6
11-4 Import/Export User Alarm . .......... ..ottt iniiiinnneenns 1-7
11-4-1 Importing User Alarms . . ... . ... e 11-7
11-4-2 Exporting User Alarms . . ... ... . 11-9
11-4-3 File Format . ... .. 11-11
11-5 Import/Export Resources .............ciiiiiiiinnnnnnennnnnns 1113
11-5-1 Importing Resources . . ... . 11-13
11-5-2 EXporting RESOUICEeS ... ... .ot 11-16
11-6-3 File Format . ... .. ... 11-19
11-6 Import/Export Object Properties . . ............... ... ... 11-20
11-6-1 Importing Object Properties . .......... ... ... ... . . . ... 11-20
11-6-2 Exporting Object Properties ........... ... ... . .. 11-21
11-6-3 File Format . ... ... 11-22
11-7 Importing/ExportingPages .. ...t 11-24
11-7-1 Importing Pages ... ... . 11-24
11-7-2 Exporting Pages . . ... 11-25
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11 Other Functions

11-1 Sysmac Studio Option Settings

The following Sysmac Studio option settings are related to HMIs.
« HMI

« HMI Code Editor

+ HMI Page Editor

| Hmi

In HMI, you can configure settings for all operation of the HMI.

Option - O *

Color Theme
Project Settings
Window
Ladder Editor Mapping

Resource

HMI Page Editor
Program Check/Build
Variables

Comments for Variables a
Parameter Editor
Synchronization

Safety

V+ Programs

Cancel

Symbol Item Description Remarks
(a) Resource Select the priority if the same resource
exists when copying and pasting.

Character String Priority: If the charac-
ter string is the same, you can change
the resource ID before pasting.

Resource ID Priority: If the same
resource ID exists, pasting overwrites
the resource.

When the check box in [Always over-
write existing resources] is selected, if
the resource ID is the same, the existing
resource is overwritten when the text is
changed in the object properties.

(b) Mapping Select Auto to automatically map a
variable when added in an internal
device.

This setting is only valid for an internal
device.
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11 Other Functions

Symbol Item Description Remarks
(c) The name of variable when the | Set whether or not the device name is
variable was generated added to the name of a device vari-

able when variables are mapped
automatically.

This setting is only valid when there is
only one controller in the project.

(d) Reset to default settings You can reset the settings to the
default settings.

sBunjes uondQ oipmg sewsAg -1

@ Additional Information

+ Even when variable mapping is set to auto, variable mapping will not be executed when the
following functions are executed.

+ Uploading by Going Online with an HMI
* Uploading Using HMI Media
* Importing an HMI Device

* When variable mapping is set to auto, variable mapping is executed when the device is
changed, so changing takes longer.

| HMI Code Editor

You can make settings to highlight text in the HMI Code Editor.

Option

Color Theme

Project Settings Color Selection Global variables W A:255 RAB0 GO B30 ~

o' Keywords CE
Ladder Editor

ST Editor IR

sl FH0TE W Maroon -
HMI Code Editor e _

Variables

Comments for Variable oregroun M Biack M

Parameter Editor Background

SYI'IEh ronization
Safety Reset to default settmge—morn+——————

Cancel

Symbol Item Description Remarks
(a) Color Selections Select the color for each item.
(b) Reset to default settings This button resets the colors to the
default settings.
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1-4

| HMI Page Editor

You can make settings for the HMI Page Editor.

Ei| option

Color Theme

Project Settings Grid Setts
Window

Ladder Editor

ST Editor

Program Check/!
Variables

Comments for Variable
Parameter Editor
Synchronization

Safety

ings Grid Size

Snap to Grid

Show Grid
Thickness
Color
Style
Opacity

|| DarkGray

Reset to default settingsc

Symbol Item Description Remarks
(a) Grid Settings Make the settings for the grid.
(b) Multiview Explorer Settings Make the settings for Multiview
Explorer.
(c) Reset to Defaults This button restores the default set-
tings.
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11-2 Printing

This section describes the printing feature.

11-2-1 Printable Items

The following items can be printed. You can select the items to print.

Category of project
Standard IAG

Items

Device References

Variable Mapping

Pages

Page Subroutines

User Alarms
HMI Settings
Controller Events

Data Logging

Security Settings

Troubleshooter

Language Settings

Recipes

Data

Global Events
Global Subroutines

NENENENENENENENENENENENENENENEN

Resources
IAG Collection Settings 4
IAGs v

% Additional Information

For printing features that are unique to devices other than the HMI, refer to the relevant manu-
als.

For details on the settings and the procedure for printing, refer to the Sysmac Studio Version 1
Operation Manual (Cat. No. W504).
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11 Other Functions

11-3 Image File Output

This section explains the image file output function.

You can output any page in a project as an image file. Supported file types are BMP, JPEG, and PNG.
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11-4 Import/Export User Alarm

This section describes importing and exporting of user alarms.

11-4-1 Importing User Alarms

You can either import all user alarms at once, or import only a specific group of user alarms.

wuely Jasn podx3guodwy p-LL

When the same user alarms already exist, they are overwritten. Event and Action settings retain the
state they had before importing.

I Importing All User Alarms at Once

1 Right-click User Alarms. Select Import from the menu.

P ] Pages
¥ «i)

L :udi Group0 Add

swuey Josn Buodw| L--1L

L roupl

» | Controller E
Bz Data Loggir

E’E Data Grou P

Export

2 Select the file and click Open.

.
=l Recent Places

9 Libraries
@ Documents
J? Music
[E5] Pictures

E Videos

1% Computer
&, Local Disk (C)

B mpor
[ |uv|@ » Libraries » Documents » - |¢f|| Search Documents P|
Organize New folder =~ 0 @
7't Favorites - Documents_ library B by Folder -

Bl Desktop Includes: 2 locations
% Downloads Name - Date modified Type

L UserAlarm xlsx

m

1/28/20199:03 PM  XLSX File

- | 4| n

| 3

File name:  UserAlarm xlsx

~ | Excel Files (“ls) -

[ Open Iv] [ Cancel l
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I Importing a Specific Group

1 Open the group you want to import.

Name Alarm 1D Alarm Code Expression Priority Message Popup | Acknowledge |  Page
Alarm1 Group0_Alarm1 Varl User Fault Level 4 Messagel Ei

Details
Detaill

Click .

WN

Select the file and click Open.

B tmport =
OOVl@ » Libraries » Documents » - | 3 || Search Documents e |

Organize v Mew folder B== ~ i @

s

3 Favorites — Documents library -
Bl Desktop Includes: 2 locations

." Downloads Mame Date madified Type
“E:‘..' Recent Places

| UserAlarm.xlsx 1/28/2019 9:03 PM XLSX File

m

9 Libraries
@ Documents
J) Music
[ Pictures m

E Videos

18 Computer
E Local Disk (C:) -, | T | 4

File name: UserAlarm.adsx ~ | Excel Files (dsy) -|

I Open Ivl [ Cancel ]
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11-4-2 Exporting User Alarms
You can either export all user alarms at once, or export only a specific group of user alarms.

Event and Action settings are not exported.

I Exporting All User Alarms at Once

wuely Jasn podx3guodwy p-LL

1 Right-click User Alarms. Select Export from the menu.

b= i Pages
¥ «i)

L fwi GroupQ Add -
L. -
—— N
L e GGroupl \
= P Import o
Controller Ev 2
> i - g
= Data Loggint 3
: — [
o
2 Set a file name and click Save. >
o
Export 3
®v| @ v Libraries » Documents » - |$, | | Search Documents pel |
Organize » Mew folder 4= v @
3¢ Favorites — Documents library B by Folder +
Bl Desktop Includes: 2 locations
% Downloads MName : Date modified Type

v
1= Recent Places

m

Mo items match your search.
4 Libraries
@ Documents
Ji Music
[E] Pictures i

B8 Videos

L= Computer
&, Local Disk (C3)

L )

< T b

File name: | RS EITBIE -
Save as type: [E(cel Files (*.xlsx) v]
“ Hide Folders Save | [ Cancel ]
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I Exporting a Specific Group

1 Open the group you want to export.

Name Alarm 1D Alarm Code Expression Priority

Popup | Acknowledge |  Page
Alarm1 Group0_Alarml Varl User Fault Level 4 Ei

Click .

WnN

Set a file name and click Save.

Bxport [l
%v|@ » Libraries » Documents » - | 3 || Search Documents pe |

Organize v Mew folder 4= v (7]
¢ Favorites  Documents library P by Folder -
Bl Desktop Includes: 2 locations
% Downloads Marme ° Date modified Type

[
=l Recent Places
Mo items match your search.

m

4 Libraries
@ Documents
Ji Music
[E] Pictures m

B videos

il Computer
&, Local Disk (C)
- 4 T 3

REs e e T

File name: | [RERENENG T

Save as type: [El(cei Files (*.xlsx) vl

(«) Hide Folders Save |[ Eaocel ]
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11-4-3 File Format

An Excel workbook is used to import or export user alarms.
The workbook contains the following sheets. Do not change the sheet name.

Sheet name Editing Description
UserAlarm Yes Set the user alarm description.
AlarmStrings Yes Set the alarm strings used in the UserAlarm sheet.
Information No Used by the system. Do not edit.

waely 19sn Modxguodwy -1

I UserAlarm sheet

Set the user alarm information in the UserAlarm sheet. The first line is a header, and the 2nd and fol-
lowing lines contain the user alarm information. Do not edit the header line.

Line Setting Item Description 3
A Group Name 1 1st group name. %
B Group Name 2 2nd group name. o
C Group Name 3 3rd group name. g
D Alarm ID ID. -
E Alarm Code Alarm code.
F Expression Expression.
G Priority Order of priority. The levels indicated in Sysmac Studio correspond to the
levels indicated on the sheet as follows.
Sysmac Studio Sheet
User Alarm Level 1 UserFaultLevel1
User Alarm Level 2 UserFaultLevel2
User Alarm Level 3 UserFaultLevel3
User Alarm Level 4 UserFaultLevel4
User Alarm Level 5 UserFaultLevel5
User Alarm Level 6 UserFaultLevel6
User Alarm Level 7 UserFaultLevel7
User Alarm Level 8 UserFaultLevel8
User Information UserInformation
H Message Message. Set the resource ID of the set alarm string in the message.
| Popup Popup. The levels indicated in Sysmac Studio correspond to the status
indicated on the sheet as follows.
Sysmac Studio Sheet
Selected True
Not selected False
J Acknowledge Check. The levels indicated in Sysmac Studio correspond to the status
indicated on the sheet as follows.
If anything other than False is set in the popup, this setting will be disre-
garded and always treated as if True were set.
Sysmac Studio Sheet
Selected True
Not selected False
K Page Page.
L Datails Details. Set the resource ID of the alarm string set in Details.
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I AlarmsStrings sheet

In the AlarmStrings sheet, enter the alarm strings used in the UserAlarm sheet. The first line is a
header, and the 2nd and following lines contain the alarm string. Do not edit the header line. The Alarm-
Strings sheet is output based on the UserAlarm sheet, so some of the content may duplicate previous
content. When imported, the lowest duplicate content on the sheet is given priority.

The information entered in each line is described below. Lines A and B are for the purpose of identifying
where a string is used during editing. These are disregarded when imported.

Line Setting Item Description
A Alarm ID Alarm ID on UserAlarm sheet.
B Type Indicates whether an alarm is used in Message or Details on the User-
Alarm sheet.

C Resource Group | Group name of resource. For the root that exists by default, enter [root].
Name

D Resource ID Resource ID of alarm string.

E and following | Language name | Alarm string of each language.
Culture

I Information sheet

The information sheet is used by the system. Do not edit.
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11-5 Import/Export Resources

This section describes importing and exporting of resources. Only general strings and alarm strings can
be imported and exported.

11-5-1 Importing Resources

You can import all resources at once, or import only a specific group of resources.

$994n0say Jodxgodw| G-LL

I Importing All Resources at Once

1 Right click a resource. Select Import from the menu.

v o

L £ Root

L &3 Groupd

il Imported IAGs Export

I'.-"r,I Scale Transform
:

s8ounosay Buuodw| |L-G-|

2 Click Browse.
Import

- Object

General Strings

Alarm Strings
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3 Select the file and click Open.

impor
%v|@ v Libraries » Documents » v | 3 || Search Documents L2 |
Organize Mew folder =~ 0 @
¢ Favorites - Documents library P by Folder -
Bl Desktop Includes: 2 locations
% Downloads Marme : Date modified Type
5 Recent Places
= || Translations.xlsx 1/28/2019 9:21 PM  XLSK File
4 Libraries
@ Documents
Ji Music
[E] Pictures m
B videos
L=l Computer
& Local Disk (C)  _ | o | :
File name: Translations.xdsxk - [Excel Files (*adsi) v]
i Open Ivi [ Cancel ]

4 Select the resources you want to import, and click OK.

Import

ObjectFile C:¥Users¥User00001¥Documents¥Translal Browse

~Object
General Strings

Alarm Strings

Cancel

NA-series Programmable Terminal Software User’s Manual (V118)

1-14



11 Other Functions

I Importing a Specific Group

1 Open the group you want to import.

L

Resource ID Japanese (lapan) English (United States)

String0 String0 Button0
Stringl Stringl b Buttonl
String2 String2 7 Button2

$994n0say Jodxgodw| G-LL

String3 String3

+
2 cic Bl

3 Select the file and click Open.
8 mpor
O_()v|@ » Libraries » Documents » - |‘7~ || Search Documents pe |

Organize New folder =~ 0 @

s8ounosay Buuodw| |L-G-|

-

3¢ Favorites — Documents library
Bl Desktop Includes: 2 locations

Arrange by:  Folder >

& Downloads Name Date modified Type

.
1= Recent Places

| Translations.xlsx 1/28/20199:21 PM  XLSX File

m

4 Libraries
@ Documents
J’ Music
[E] Pictures b
B videos

L] Computer
&, Local Disk (C)

LA 1 | r

File name: Translations.dsx - lExcel Files (*adsx) VI

I Open Iv] [ Cancel l
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11-5-2 Exporting Resources

You can export all resources at once, or export only a specific group of resources.

I Exporting All Resources at Once

1 Right click a resource. Select Export from the menu.

iz Add
L £ Root
Import

L &7 Groupd

[l Imported LAG:

I._"T,I Scale Transfor
L

2 Click Browse.
Export 5]

- Object
General Strings

Alarm Strings

Cancel
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3 Set a file name and click Save.

-

-

Gpor E
%v|@ » Libraries » Documents » - |$4-| | Search Documents D | 'g
2

Organize Mew folder g== - (7] o

: - §

7t Favorites - Documents library B L Folder - e
Bl Desktop Includes: 2 locations 2
Download - <

& Lownloads Mame Date modified Type 2

”

=l Recent Places
=
Me items match your search.

il Libraries
@ Documents

J{! Music

[E5] Pictures =
: o

B videos N
m

LA 11 b 5

- o)
=

File name: - a

: Py

Save as type: [El(cel. Files (*xlsx) v] e

2

8

= Hide Folders | Save | [ Cancel ] »

4 Select the resources you want to export, and click OK.

Export

- Object
General Strings

Alarm Strings

Cancel
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I Exporting a Specific Group

1

Open the group you want to export.

Resource ID
String0
Stringl
String2

String0
Stringl
String2

String3 String3

+
Click [l .

Set a file name and click Save.

WN

Japanese (lapan) English (United States)
AQ Button(
1 Buttonl
Button2

Button3

Export

%vl@ » Libraries » Documents »

- | 3 | | Search Documents

Organize New folder 4= = (7]
7t Favorites Documents library - Folder
Ml Desktop Includes: 2 locations
B MName B Date modified Type
| Recent Places
Mo items match your search.
4 Libraries
@ Documents
Jl Music
(& Pictures
B videos
- 4 T 3
File name: -
Save as type: [El(cei Files (*.xlsx) vl
+ Hide Folders Save | [ Cancel ]

11 -18
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11-5-3 File Format

An Excel workbook is used to import or export resources.

The workbook contains the following sheets. Do not change the sheet name.

11 Other Functions

Sheet name Editing Description
GeneralStrings Yes Set general strings.
AlarmStrings Yes Set alarm strings.
Information No Used by the system. Do not edit.

I GeneralStrings sheet

Set general strings in the GeneralStrings sheet. The first line is a header, and the 2nd and following
lines contain the general strings. Do not edit the header line.

Line Setting Item Description
A Group Name Group name. For the root that exists by default, enter [root].
B Resource ID Resource ID.

C and following | Language name

[Culture]

General strings of each language.

I AlarmsStrings sheet

Set alarm strings in the AlarmStrings sheet. The first line is a header, and the 2nd and following lines
contain the user alarm information. Do not edit the header line.

Line Setting Item Description
A Group Name Group name. For the root that exists by default, enter [root].
B Resource ID Resource ID.

C and following

Language name
[Culture]

Alarm string of each language.

I Information

sheet

The information sheet is used by the system. Do not edit.
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11 Other Functions

11-6 Import/Export Object Properties

This section describes importing and exporting of object properties. Only text, variables, and expres-
sions of some objects can be imported and exported. Use this when using the same project to create a
derivative project, with changes to only the text and variable assignments.

11-6-1 Importing Object Properties

11-20

This section explains how to import object properties.
When the same settings already exist, they are overwritten. Settings that do not exist in the workbook
retain the state they had before importing.

1 Select Tool - Import Object Properties from the menu.

Tools Window Help
Import Object Properties...
Export Object Properties...

Customize Shortcut Keys...
Option...

2 Select the file and click Open.

B import (25l
B & T D |
ot j » Libraries » Documents » vli'v?l Search Docume jol
Organize « Mew folder B== ~ i E@I
't Favorites Documents library L Foldar -
Bl Desktop Includes: 2 locations
-
% Downloads MName Date modified Type
£ Recent Places
= | PageData.xlsx 1/28/2019 9:36 PM XL5X File
= Libraries
3 Documents
J”. Music
[ Pictures
B videos
M Computer
& Local Disk (G} _ -, = -
File name: PageData.xlsx ~ | Excel Files ("ds) -|
[ Open |v] [ Cancel ]
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This section explains how to export object properties.

1 Select Tool - Export Object Properties from the menu.

Import Object Properties...

Customize Shortcut Keys...
Option...

2 Set a file name and click Save.

sansadoud 309lqo podxa/podwy 9-11

_
D)3 » tiris » vocumens [y [ seocndumer: P

Organize « New folder

.

¢ Favorites Documents library
M Desktop Includes: 2 locations

Arrange by:  Folder ~

seluadoud 108lqo Bumiodx3 z-9-11

Li' Downloads MName Date modified Type
(E Recent Places
Mo items match your search.
Libraries
Documents
J' Music
[E] Pictures
B8 Videos

- |l

File name: | Pagelata.ulsy

Save as type: | Excel Files (*adsx)

() Hide Folders
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11-6-3 File Format

An Excel workbook is used to import or export object properties. The workbook contains the following
sheets. Do not change the sheet name.

Sheet name Editing Description
Settings Yes Set the properties of the object.
GeneralStrings Yes Set general strings that are used in the Settings sheet.
Information No Used by the system. Do not edit.

I Settings sheet

In the Setting sheet, set the properties of the object placed on the page. The first line is a header, and
the 2nd and following lines contain the object properties. Do not edit the header line.

Line Setting Item Description

A Page Name Name of the page.

B Object Name Name of the object. Objects included in IAG have the following names:
IAG object name.object name

C Property Name Name of the property.

D Setting Property setting.
For text, set the resource ID. For a variable or an expression, set the vari-
able or expression.

% Additional Information

When editing texts allocated to objects which are included in IAG, note the following.

IAG resources are allocated by default to the texts allocated to the objects included to IAG.
They are displayed in the Setting column as resource IDs like [iag]XXX. To edit text of an object
included in a specific IAG object, select a normal resource which does not have [iag] on its
head. IAG resources of the corresponding IAG and normal resources are applicable to use

within IAG. IAG resources for other IAGs are not applicable.

The correspondences between the property type of the corresponding object and the character string
set in Property Name are described below. Objects included in IAG are excluded.

Object Type Property Name in Sysmac Studio Property Name on sheet
Button General - Type ResourceKey
Appearance - Text (Default) - Resource ID Text
Set Button General - Type ResourceKey
Appearance - TextButtonUp (Default) - Resource 1D Text
Appearance - TextButtonDown (Default) - Resource ID TextOn
Behavior - Variable Variable™
Behavior - Feedback Expression FeedbackExpression !
Toggle Button General - Type ResourceKey
Appearance - TextButtonUp (Default) - Resource 1D Text
Appearance - TextButtonDown (Default) - Resource ID TextOn
Behavior - Variable Variable™?

Behavior - Feedback Expression

FeedbackExpression*1

1 -22
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11 Other Functions

Object Type Property Name in Sysmac Studio Property Name on sheet ;
Momentary General - Type ResourceKey B
Button Appearance - TextButtonUp (Default) - Resource ID Text r%

Appearance - TextButtonDown (Default) - Resource ID TextOn '>§
Behavior - Variable Variable™! g
Behavior - Feedback Expression FeedbackExpression ' T
Reset Button General - Type ResourceKey :-G
Appearance - TextButtonUp (Default) - Resource ID Text -§
Appearance - TextButtonDown (Default) - Resource ID TextOn %-
Behavior - Variable Variable™! @
Behavior - Feedback Expression FeedbackExpression
Bit Lamp General - Type ResourceKey
Appearance - TextOff (Default) - Resource ID Text
Appearance - TextOn (Default) - Resource 1D TextOn =
Behavior - Expression Expression ! g
Data Lamp General - Type ResourceKey o
Appearance - DefaultText (Default) - Resource ID Text %
Behavior - Expression Expression’! §
Behavior - ColorRanges - [*] - Text (Default) colorRange*.Text"" -
Text Box General - Type ResourceKey
Appearance - Text (Default) - Resource ID Text
Appearance - Text (Default) - Expression Expression
Label General - Type ResourceKey
Appearance - Text (Default) - Resource ID Text
Appearance - Text (Default) - Expression Expression
IAG General - Type ResourceKey
Behavior(Input) - User-Defined Input Variable Input.User-Defined Input Variable
Behavior(In/Out) - InOut.User-Defined I/O Variable InOut.User-Defined I/O Variable

*1. Objects included in IAG are not output.

I GeneralStrings sheet

Set general strings in the GeneralStrings sheet. The first line is a header, and the 2nd and following
lines contain the general strings. Do not edit the header line. This is output based on the Settings sheet,
so some of the content may duplicate previous content. When imported, the lowest duplicate content
on the sheet is given priority.

The information entered in each line is described below. Lines A to C are for the purpose of identifying
where a string is used during editing. These are disregarded when imported.

Line Setting Item Description
A Page Name Name of the page.
B Object Name Name of the object.
C Property Name Name of the property.
D Resource Group Name | Name of resource group. For the root that exists by default, enter

[root]. For an IAG resource, the name is [iag] IAG collection
name.lAG name,{GUID}.

E Resource ID Resource ID.

F and following | Language name Culture | General strings of each language.

I Information sheet

The information sheet is used by the system. Do not edit.
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11-7 Importing/Exporting Pages

You can import/export pages often used by specifying each page.

11-7-1 Importing Pages
Use the following procedure to import a page. When Import is executed, variables as well as resources
used in the page are also imported in the same way as Paste.

@ Additional Information

An Import can be only executed when the version of Runtime on the device to execute Import is
later than that of the version of Runtime used when the data to be imported was created.

1 Right-click on Page Group. Select Import from the menu.
»

Multiview Explorer

o
L..d

A Configurations and Setup

Al
_ EH Page Add
- i) User Ala
p [ Controll
B2 Data Logyuiiy
F= Data Groups

2 Select the file to import and click Open.

Bl import

P am ESD-USB(F)
b r Libraries
b o Network

Sysmac Studio HMI Library Page (".lp)

New Folder Filename:

3 The page is imported.
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11 Other Functions

11-7-2 Exporting Pages

Use the following procedure to export pages. When Export is executed, variables as well as resources
used in the page are also exported in the same way as Copy.

1 Right-click on Page. Select Export from the menu.

Multiview Explorer - 1

sabed Bunaodxg/buinodwy -1

ot
HMI_MAS 0 HH

| Configurations and Setup
b4 HMI

¥ [f| Pages
n:::)

Jeer Alarms

View Page Editor
Code Editor

> ﬁ Cor )
Bz Data Lo

ﬁ-a Data |
=3

|'£-|[Z

e [ Data

sabed Buiodx3 z-/-11

Sc ale Transform.......

2 Select the folder to export the page to, specify the file name, and click Save.

B Export X

b 5 Quick access
b @ OneDrive
4 [ This PC
» 3 3D Objects
b [ Deskiop

b & Downloads.

b b Music

b Pictures

b [ Videos

b i Local Disk (C)

b & DVD RW Drive (E)
b ESD-USE F)

b Libraries

b & Network

Fiename: ageacy

Type: Sysmac Studio HMI Library Page (*.elp)

3 The page is exported.
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Appendices
]

The appendices provide information on supported file formats and other information.

A-1 Eventsand Actions ........... ...ttt ittt A-2
A-2 Supported Formats .......... ... ... e A-5
A-3 Specifications of Operation LogFiles ............................. A-7
A-4 Differences between the Physical HMI and Simulator ............... A-10
A-5 VersionUpgrade History .......... ... i A-11
A-5-1  Version Upgrade History for Sysmac Studio and Runtime ............... A-11
A-5-2  Version Upgrade History for Sysmac StudioOnly ..................... A-13
A-5-3  Sysmac Studio Corresponding Versions . . ............ ... ... ........ A-17
A-6 Precautions for VersionUpgrades .............. ..o, A-18
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A-1 Events and Actions

|
I Events
Name Description Global Page | Objects User IAG
events alarms
Acknowledged The event occurs when the user alarm is . . . Yes .
acknowledged.
Checked The event occurs when the check box is . . Yes . .
selected.
Cleared The event occurs when the user alarm is . . i Yes i
cleared.
Click™ The event occurs when the object is tapped. — — Yes — —
Condition The event occurs when the set condition is Yes Yes . . Yes
met.
F1 Key Click ! The event occurs when the F1 Key is tapped. | Yes | Yes? — — —
F1 Key Press The event occurs while the F1 Key is held Yes | Yes? . . .
down.
F1 Kev Rel *1 The event occurs when the F1 Key is Yes | Yes? . . .
ey helease released. es
F2 Key Click’ The event occurs when the F2 Key is tapped. |  Yes | Yes™ — — —
F2 Key Press The event occurs while the F2 Key is held Yes | Yes . . .
down.
F9 Kev Rel * The event occurs when the F2 Key is Yes | Yes® . . .
ey Release released. es
F3 Key Click ! The event occurs when the F3 Key is tapped. | Yes | Yes? — — —
F3 Key Press The event occurs while the F3 Key is held Yes | Yes? . . .
down.
F3 Kev Rel *1 The event occurs when the F3 Key is Yes | Yes? . . .
ey Release released. es
Interval The event occurs at the specified interval. Yes — — — —
Page Displayed The event occurs while the page is displayed. — Yes — — —
Page Hidden The event occurs when the page is hidden. — Yes — — —
The event occurs while the object is held
Press — — Yes — —
down.
) ... x5 | The event occurs when the project is initial-
Project Initialization . Yes — — — —
ized.
Raised The event occurs when the user alarm . . i Yes i
occurs.
Rel * The event occurs when the object is . . Yes . .
elease released.
Selection Changed The _event occurs when the item selected in . . Yes . .
the list changes.
Unchecked The _event occurs when the check box selec- . . Yes . .
tion is cleared.

*1. For both Click and Release, the event occurs when the object is released, but the operation when the page is
changed is different. If the page changes when an object set for Click is touched but not yet released, the event
does not occur. If the page changes when an object set for Release is touched but not yet released, the event
does occur.

*2. These events are ignored for popup pages.

*3. The results of accessing external variables during project initialization immediately after startup are not always
dependable. Do not access external variables during project initialization.
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I Actions
Action Description Global Page | Objects User IAG
events alarms
BuzzerOff Turns OFF the buzzer. Yes Yes Yes Yes Yes
BuzzerOn Turns ON the buzzer. Yes Yes Yes Yes Yes
. Turns ON the buzzer that beeps for
1
BuzzerOneShot only 0.25 second. Yes Yes Yes Yes Yes
Executes a subroutine registered
CallSubroutine as a global subroutine or page sub- | Yes™ Yes Yes Yes? Yes
routine.
ClearUserAlarmLog Clears the user alarm log. Yes Yes Yes Yes Yes
ClosePage Closes the specified page. Yes Yes Yes Yes Yes
DecreaseVariable Subtract.s.the spgmfned value from Yes Yes Yes Yes Yes
the specified variable.
EjectSDMemory E;?;Ies removing the SD Memory Yes Yes Yes Yes Yes
Enabl isables i h
EnablelnputOperation nables or disables inputs on the Yes Yes Yes Yes Yes
touch panel.
EndSyncLock 3 Ends a critical section. Yes —
IncreaseVariable Adds. Fhe spe.cmed value to the Yes Yes Yes Yes Yes
specified variable.
InvertVariable Inverts the V.a lue of the specified Yes Yes Yes Yes Yes
Boolean variable.
Login Displays the login page. Yes Yes Yes Yes Yes
Logout Logs out the user. Yes Yes Yes Yes Yes
ResetVariable Changes th? value of the specified Yes Yes Yes Yes Yes
Boolean variable to False.
Captures the screen displayed on
SaveScreenshot Yes Yes Yes Yes Yes
the HMIL.
_Src?'\:/ielzeUserAlarmLog- Saves the user alarm log to a file. Yes Yes Yes Yes Yes
h the IME | t-
SetIMEType tCi)n:Snges © anguage se Yes Yes Yes Yes Yes
SetlnputFocus Sets the data input focus. - Yes Yes -—- Yes
SetlLanguage ;Z:SSnges the project language set- Yes Yes Yes Yes Yes
SetVariable Sets the value_ gf the specified vari- Yes Yes Yes Yes Yes
able to a specified value.
Displays the page set in a specified
ShowAlarmPage Yes Yes Yes Yes -
User Alarm.
ShowDocu- Displays a PDF or other file full
ment(FULL SCREEN) | screen. Yes Yes Yes Yes Yes
ShowDocument(Win- D!splays a PDF or other file in a Yes Yes Yes Yes Yes
dow) window.
ShowPage ™ Displays a page. Yes Yes Yes Yes Yes
«, | Displays the most recently dis-
; 4
ShowPreviousPage played page. Yes Yes Yes Yes Yes
ShowSystemMenu Displays the System Menu. Yes Yes Yes Yes Yes
ShowTroubleshooter Displays the NJ/NX/NY Trouble- Yes Yes Yes Yes -
shooter.
StartDatal.ogging Starts data logging. Yes Yes Yes Yes Yes
NA-series Programmable Terminal Software User’s Manual (V118) A-3

SUOI)OY pue SJuUsAl |-y




Appendices

Action Description Global Page | Objects User IAG
events alarms
StartSafetyMonitor Displays the Safety Monitor. Yes Yes Yes Yes Yes
StopDatalLogging Stops data logging. Yes Yes Yes Yes Yes
Showpperahon- Displays the Operation Log Viewer. Yes Yes Yes Yes Yes
LogViewer
StartOperationLog Starts operation logging. Yes Yes Yes Yes Yes
StopOperationLog Stops operation logging. Yes Yes Yes Yes Yes
SyncLock 3 Starts a critical section. Yes - - - -
TriggerEvent S(.B'[S the UserEvents for IAG . . . . Yes
objects.

*1. When multiple actions attempt to simultaneously beep buzzers, the last buzzer demand overwrites the previ-
ous demands.

*2. You cannot execute page subroutines for global events or user alarms.
*3. The SyncLock and EndSyncLock actions must be specified as a pair.
*4. If you execute an action with a Momentary Button, use a Click or Release event.

@ Additional Information

If the same variable might be accessed simultaneously from different locations, such as for
simultaneous execution of subroutines, perform exclusive control to prevent simultaneous
access.

For a section where exclusive control is required, specify the start of the section with the Syn-
cLock action and the end of the section with the EndSyncLock action. This defines the section
between these two actions as a critical section. Until the execution of the critical section is com-
pleted, other processing will not be executed, therefore achieving exclusive control.
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A-2 Supported Formats

The HMI objects support the following formats. However, it may not be possible to display some files
even if the file format is supported.

»
N
I Image Files £
T
o
The following formats are supported. i
-
Exten- E
Format name : Specifications 3
sion 7]
Microsoft Windows Bit- BMP 1, 4, 8, 16, 24, or 32-bit
map Image Uncompressed or RLE compression
Graphics Interchange GIF 1, 4, or 8-bit
Format Interlaced GIF is supported.
JFIF or EXIF JPG 8-bit gray scale
24-bit/basic DCT or progressive DCT
Portable Network Graph- | PNG 1, 4, 8, or 24-bit
ics Transparency is supported only when the o channel is saved for each
pixel.
Scalable Vector Graphics | SVG SVG 1.0 is supported.
Extensible Application XAML
Markup Language
Drawing Exchange For- DXF R12 and older are supported.
mat
] video

The following formats are supported. However, only progressive formats are supported. The maximum
size of the file that can be registered in a project in Sysmac Studio is 100 MB.

Exten- e - Maximum
Format name , Specifications .
sion resolution
MPEG-1 mpg The MPEG-1 Video Stream format is not supported. 768%480
MPEG-2 mpg Main Profile Low, Main, and High 1440 1280x720
MPEG-2 TS is not supported.
MPEG-4 Part 21 mp4 Simple Profile LO, L1, L2, and L3 1280x720

Advanced Simple Profile LO, L1, L2, L3, L4, and L5
Global motion compensation is not supported.

MPEG-4 Part 10 mp4 | Baseline Profile L1, L1.2, L1.3, L2, L2.2, and L3 1280720
(H.264) Main Profile L1, L1.2, L1.3, L2, L2.2, L3, L3.1, L3.2, and L4.1

High Profile L1, L1.2, L1.3, L2, L2.2, L3, L3.1, L3.2, and L4.1
Windows Media Video | wmv WMV9 240x%160

*1. Not supported on the NA5-C1OOOOO-VA.
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I Files Supported by Document Viewer

The Document Viewer can display the following files. The maximum size of file that can be registered in
a project in Sysmac Studio is 16 MB.

Format name Ex.ten- Specifications
sion
Adobe Acrobat Document PDF PDF 1.5 and later are not supported.
Microsoft Excel Books xlsx
Microsoft Excel 97-2003 Books xls
Microsoft Word Documents docx
Microsoft Word 97-2003 Docu- doc

ments
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A-3 Specifications of Operation Log Files

Specifications of operation log file are shown below.

I Specifications of files

File format: CSV file

Encoding method: UTF-8

Delimiter character: , (0x2c)

File name: Any file name and extension that can be used as a file name on Windows

so|i4 o uonesadp jo suonesydadg ¢-y

I Recording specifications

Recording specifications are shown below. The first line is a header and the data in the second and fol-
lowing lines are recorded.

Information entered in each column differs according to the recording operation.

Column Item Description

1 Date and Time Outputs the time the operation occurred in UTC. The output format
according to Locale is used.

2 User Outputs the user account that was logged in when the operation was exe-
cuted.

3 Category Outputs the operation category.

4 Operation Outputs the name of the operation.

5 Operation Information1 Outputs detailed information of the operation.

6 Operation Information2

7 Page

8 Action Outputs the action name.

9 Action Information1 Outputs detailed information of the action.

10 Action Information2

11 Value before

12 Value after
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® Output specifications of each operation

Columns 1 to 7 output the description that correspond with each operation. The output specifica-

tions are shown below.

. 2ELD Operation Operation
Rpeates Tairrl:e User (CEIETTR Information1 Information2 Page
Startup Date User System
Exit and Accounts
Start transfer/synchronisation Time Transfer type
Finish transfer/synchronisation
Execute Project
Synchronization
Show System Menu
Exit System Menu
Show Troubleshooter Controller name | Page name
Exit Troubleshooter
Show Safety Monitor
Exit Safety Monitor
Show Operation Log Viewer
Exit Operation Log Viewer
Disable touch input
Enable touch input
Start screensaver
End screensaver
Connect to VNC server IP address
Disconnect VNC server IP address
Connect to FTP server IP address
Disconnect FTP server IP address
Connect with FTP Client Host User name
Disconnect with FTP Client Host User name
Change System settings Setting item
name
Login User User name Login result
Logout
Switch user User name Login result
Set language ™’ Locale
IME change”
Write recipe Recipe Template name Recipe name
Read recipe Template name Recipe name
Start Data logging Data Logging | Data set name
Stop Data logging Data set name
Start Operation logging Operation
Stop Operation logging Log
Object operation User Object name Name Page
Operation name
Function Key operation Function Key Name Page
name name

*1. A value only for Set language and IME change is output to Value before and Value after in columns 11 to

12.
Operation Value before Value after
Set language Languages before change | Languages after change
IME change Type before change Type after change
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Values that correspond to actions associated with the operation are recorded in columns 8 to 12.
The output specifications are shown below.

Action executed Action Actiop Actiop Value Value

Information1 | Information2 | before after

BuzzerOff BuzzerOff

BuzzerOn BuzzerOn

BuzzerOneShot BuzzerOneShot

Subroutines Subroutine name

ClearUserAlarmLog ClearUserAlarmLog

ClosePage ClosePage Page name

DecreaseVariable DecreaseVariable Variable Value Value
name before after

EjectSDMemory EjectSDMemory

EnablelnputOperation EnablelnputOperation

IncreaseVariable IncreaseVariable Variable Value Value
name before after

InvertVariable InvertVariable Variable Value Value
name before after

Login Login

Logout Logout

ResetVariable ResetVariable Variable Value Value
name before after

SaveScreenshot SaveScreenshot

SaveUserAlarmLogToFile SaveUserAlarmLogToFile

SetIMEType SetIMEType

SetInputFocus SetlnputFocus

SetLanguage SetLanguage

SetVariable SetVariable Variable Value Value
name before after

ShowPage (user alarm) ShowPage (user alarm) Page name Viewer name

ShowDocument (FULL ShowDocument (FULL Document

SCREEN) SCREEN) name

ShowDocument (Window) ShowDocument (Window) Document
name

ShowPage ShowPage Page name

ShowPreviousPage ShowPreviousPage

ShowSystemMenu ShowSystemMenu

ShowTroubleshooter ShowTroubleshooter

StartSafetyMonitor StartSafetyMonitor

ShowOperationLogViewer ShowOperationLogViewer

StartDatalLogging StartDatalLogging

StopDatalLogging StopDatalLogging

StartOperationLogging StartOperationLogging

StopOperationLogging StopOperationLogging

Change value using the keypad | EditVariable

Selection changed using the

radio button

Selection changed in a drop

button/list box

Change tab page

State changed in a toggle

button/check box

Value changed using a slider
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A-4 Differences between the Physical HMI
and Simulator

The following major differences exist between the physical HMI and Simulator. In addition, the display
by the simulator is not guaranteed to be completely compatible with the physical HMI.

» Trend Graph and Broken-line Graph Objects
The Simulator does not update graphic displays. Fixed still images are displayed.
» ShowDocument Action and ShowDocument Function

The Simulator ignores parameters that specify the display positions and sizes for documents. To dis-
play documents, there must be a compatible application, such as Adobe Reader. The application
used to display a document will not be exited when the Simulator is exited or the page is changed
after the document is displayed. Exit the application manually.

+ ShowTroubleshooter Action and ShowTroubleshooter Function
The Simulator cannot display the NJ/NX/NY Troubleshooter.
* _HMI_Brightness Variables
The brightness of the screen does not change for the Simulator.
» Media Player Object

There may be some differences in the behavior or timing when a video is replayed. The Simulator
does not execute actions/functions that operate a Media Player object.

» Operation Log

The Simulator cannot run functions related to Operation Log.
» Safety Monitor

The Simulator cannot run functions related to Safety Monitor.
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A-5 Version Upgrade History

This section describes the additions and improvements that were made during version upgrades.

A-5-1 Version Upgrade History for Sysmac Studio and Runtime

Sysmac Studio Version 1.10 and Runtime Version 1.00

Item

Description

First release

Support added for NA-series Programmable Terminals.

Sysmac Studio Version 1.11 and Runtime Version 1.01.

Item

Description

Uploading

Added support for uploading.

Expansion of popup page func-
tionality

Expanded functionality for popup pages, such as the addition of display
position specifications.

Expansion of IAG functionality

Expanded functionality for IAG variables. Also added support for a Condition
event.

Expansion of settings for object
appearance

Expanded settings related to appearance, such as adding vertical text for
some objects.

Addition of data logging

Added Data Log and Trend Graph objects.

Sysmac Studio Version 1.13 and Runtime Version 1.02.

Item

Description

Support for NX7-series Control-
lers and NJ1-series Controllers

Added support for connection to NX7-series Controllers and NJ1-series
Controllers.

Addition of NJ/NX Troubleshooter

Added support for the NJ/NX Troubleshooter.

Addition of system variables for
VNC function

Added _HMI_ConnectedVNCClientCount system variable that represents
the number of clients that are connected to the HMI via VNC.

Sysmac Studio Version 1.14 and Runtime Version 1.03.

Item

Description

Addition of broken-line graph func-
tion

Added support for the broken-line graph function.

Expansion of NJ/NX-series trouble-
shooter functionality

Expanded functionality to display/delete event logs of the EtherCAT slave
units. Also added support that allows the troubleshooter to switch to a user
screen.

Support for union/enumeration vari-
ables

Enabled handling of union and enumeration variables of NJ/NX-series
Controllers, as well as inputting and displaying of them on HMls.

Support for creating new structure
variables

Enabled creating new structure variables in the HMI.

Expanded maximum number of
variables registered in a connected
device

The number of global variables that can be registered in a connected
device was expanded to 30,000.

Expansion of IAG functionality

Enabled settings of user events for IAG.

HMI Main Unit screen capture func-
tionality

Enabled capturing screens displayed on the HMI.

Custom keypad functionality

Enabled creation of system keypads with user-specified sizes. Also added
support for editing then to make a user-specific colored/shaped keypad.

Tabbing order functionality

Enabled settings of order in which to tab around the input focus during
data input.
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Item

Description

Scale conversion functionality for
numeric values

Enabled scale conversion of numeric values.

Indirect addressing of text strings

Enabled indirect addressing of text strings that are displayed on objects.

Buzzer function

Enabled sounding a buzzer from the HMI when a button is pressed, and
when an alarm occurs, or for other events.

Page jump from an alarm message
to a specified screen

Enabled a page jump from an alarm screen specified in the Alarm Viewer
to a specified screen.

Enhanced VNC functionality

Support for accesses control of VNC clients for various conditions.

Addition of tab control objects

Added tab control objects.

Support for background processing
of subroutines

Added support for background processing of subroutines to enable parallel
processing with updating of the display.

Input of Japanese and Asian lan-
guages

Enabled input of Japanese, Chinese (traditional and simplified), and
Korean in data input objects.

Sysmac Studio Version 1.15 and Runtime Version 1.04.

Item

Description

Expansion of button object func-
tionality

Enabled combinations of buttons with lamp functionality using variable val-
ues.

Indirect specification of
upper/lower limit values

The upper/lower limit values for an object such as Data Edit can now be
dynamically changed by using variables.

Function to specify a page number

Numerical values can now be assigned to pages, allowing the pages to be
switched by using the assigned values.

Sorting and filtering of displayed
items in User Alarms Viewer

Enabled setting for sorting displayed items by default.
Enabled filtering of displayed alarms by a keyword for each item.

Improved operability of some
objects

Enabled changing the size of the CheckBox, Slider, and Radio Button
objects.

Sysmac Studio Version 1.16 and Runtime Version 1.05.

Item

Description

Improved operability of User
Alarm Viewer objects

Enabled displaying the filtering state of User Alarm Viewer objects.

Sysmac Studio Ver.1.17 Runtime Ver.1.06

Item

Description

Support for NY-series

Enabled connection to NY-series.

Sysmac Studio Ver.1.17 Runtime Ver.1.07

Item

Description

Support for NX1-series

Enabled connection to NX1-series CPU Unit.

Sysmac Studio Ver.1.18 Runtime Ver.1.08

Item

Description

Improved functionality for Retain
variables

The number of characters can now be set for String-type Retain variables.

Expanded functionality for data
display objects and data input
objects

The character encoding method can now be converted for data display
objects and data input objects.
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Sysmac Studio Ver.1.23, Runtime Ver.1.09

Item Description

Support for NX102 Series Connection to an NX102 Series CPU Unit is now possible.
Sysmac Studio Ver.1.24, Runtime Ver.1.10 >
[3,]
Item Description §
Support for NX-CSG320 Connection to an NX-CSG320 CPU Unit is now possible. é'
c
Sysmac Studio Ver.1.27, Runtime Ver.1.11 @
&
Item Description T
Support for fonts in multiple lan- Object font settings can now be set in each language. g-
<

guages

Sysmac Studio Ver.1.31, Runtime Ver.1.12

Item Description
FTP Client FTP Client functions are now supported.

Sysmac Studio Ver.1.40, Runtime Ver.1.11

Item Description
Support for Soft-NA Soft-NA is now supported.

Sysmac Studio Ver.1.40, Runtime Ver.1.13

Item Description
Support for Operation Log Operation Log is now supported.
Support for Safety Monitor Safety Monitor is now supported.

Sysmac Studio Ver.1.40, Runtime Ver.1.08 to Ver.1.13

Item Description
Support for NAS-OJOWOOOO-V1 | The NAS-OOWOOOO-V1 is now supported.

AluQ olpnis oewsAg Joj AlojsiH epesBbdn uoisisp Z-G-Y

Sysmac Studio Ver.1.42, Runtime Ver.1.13

Item Description
Support for NJ501-RC100 controller | Connection to NJ501-R100 is now possible.

Sysmac Studio Ver.1.43, Runtime Ver.1.14

Item Description
Support for alarm time elapsed Display of the elapsed time after an alarm occurs in the user alarm object is
now supported.

A-5-2  Version Upgrade History for Sysmac Studio Only

Version 1.11

Item Description

Support for copying settings Added support to copy settings for user alarm tables, data sets, and recipe
templates and paste them into external applications.

Improvement to property display Enabled displaying properties by double-clicking objects.
method
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Version 1.13
Item Description
Support to copy CJ/NJ variable Added support to copy and paste variables directly from the Sysmac Studio
settings and CX-Programmer.
Version 1.14
Item Description

Enhanced Search and Replace
functionality

Expanded target for the Search and Replace function to all the texts within a
project.

Support for the simulation mode

Enabled confirmation of indications such as the ON/OFF status of Lamps
and other objects.

Sysmac Studio printing functional-
ity

Enabled printing of information including project settings with HMI selected.

Direct text editing

Enabled direct editing of Labels on the Page Editor.

Importing of vector graphic files

Enabled selecting of vector graphic files (e.g.,.XAML files) for the Image files
of objects.

Improved Watch Tab Page

Enabled constant monitoring of global variables.

Cross reference function

Enabled cross reference when the HMI is selected.

Version 1.15

Item

Description

Function to change Button type

The Button Type such as Set or Momentary can now be changed by the set-
ting of properties.

Improved procedures to add vari-
ables

A variable can now be created and added to the variable table directly from
the variable setting field.

Improved operation of specifying
subroutines

The function has been expanded to open the Code Editor (for editing sub-
routines).

A subroutine can now be created from the Properties Window.

Japanese translation of items in
Properties

The items in the Properties Window are now shown in Japanese under a
Japanese environment.

Serial creation of multiple objects

It is now possible to create more than one object with the same appearance
and settings at the same time.

Version 1.16
Item Description
Version control Enabled version control.
Version 1.18
Item Description
Improved functionality for Retain | Validation is now executed for the total number and total size of Retain vari-
variables ables when a project is built.

Resource usage status

You can now check the usage of Retain variables.
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Version 1.20
Item Description
Enhanced workability between Enhanced workability between devices, such as opening windows of differ-
devices ent devices at the same time.

Improved copy and paste

The global variables and subroutines referenced by objects during object
copy and paste are automatically copied.

Increased cross reference range

Added data groups, recipes, and data sets as cross reference targets.

Image preview

When selecting an image to be pasted on an object, a preview of the image
is displayed.

Incremental build

Added support for incremental build.

Deletion of all Imported IAGs

Added support for a function that deletes all Imported IAGs that are not
used.

Version 1.22
Item Description
Improvement of Code Editor Per- | Performance when editing a large amount of source code has been
formance improved.
Improvement of user alarm opera- | Grid sorting when configuring group settings is supported.
bility
Improvement of resource opera- "Undo" is supported in the resource editing software.
bility

Image file output of pages

A function for saving a page as an image file is supported.

Version 1.24

Item

Description

Support for subroutine searches

Added support for a function that searches for the place where a subroutine
is used from the Code Explorer.

Importing and exporting of devices

Added support for importing and exporting devices.

Support for editing Resource IDs

Added support for editing a Resource ID set for an object.

Version 1.25
Item Description
Set as default Added support for setting initial value of object properties.
Version 1.26
Item Description
Simulator Properties and other items can be edited while the simulator is running.
Version 1.27
Item Description

Import/Export User Alarm

Importing and exporting of user alarms is supported.

Importing and exporting of all

Importing and exporting of all resources at once is supported.

resources
Importing and exporting of object | Importing and exporting of object properties is supported.
properties

Simulator « A function for displaying any page is supported.

+ A function for switching the project language is supported.
* A screen shot function is supported.

Language settings

» The default language can now be changed.
+ Default font settings can now be set.

Variable mapping

A function that automatically executes variable mapping is supported.
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Version 1.40

Item

Description

Support for specifying the size for
the Image File Output

The size can now be specified when outputting image files.

Support for exporting resource
files

Exporting resource files is supported.

Support for importing and export-
ing pages

Importing and exporting pages is supported.

Support for replacing the name of
pages

Replacement is now executed when the name of a page is changed.

Support for displaying property by
default

Property window and other items are now displayed by default when such
as creating a new project.

Version 1.41

Item

Description

Improvement of copy-and-paste
function

Brackets are now automatically replaced with appropriate ones when copy-
ing and pasting array variables between the controller and HMI.

Improvement of text input

Texts and resource IDs are now displayed in the drop-down list which is dis-
played when entering texts and resource Ids from the property.

Version 1.43

Item

Description

Automatic application of variable
comment

Device variable comments are automatically applied to HMI variables.

Support for upload function

A function specializes in uploading is supported.

Improvement of resource editing

A mode to always overwrite existing resources when editing text in proper-
ties is now supported.
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A-5-3  Sysmac Studio Corresponding Versions

NA5-OO00O000 NA5-DOO0OO000-ve ™ Soft-NA
Sysmac Studio >
b Runtime G Runtime VLT Runtime Soft-NA o
program program <
1.10 1.00 1.1.0 - - - - )
11110 1.12 10172 2.0.0 - - - - E
1.13 1.02"3 3.0.3 - - - - :g
1.14 1,03 4.3.3 - - - - g
* % I
1.15 1.0345 441 - - - - &
1.16 105 5.0.3 - - - - S
1.17 107 515 - - - -
1.18 1.08™ 515 - - - -
1.19 1.08"3 522 - - - -
1.20 1.08™ 6.0.2 - - - - >
1.23 1.09" 7.0.5 - - - - o
1.24 110 7.1.2 - - - - K%
(2]
1.24.2 1.10™ 7.2.1 - - - - 3
(¢}
1.26 1.10™ 7.3.0 - - - - g
1.27 11174 7.3.0 - - - - o
(@)
1.31 112 74.0 - - - - S
[0
* (2]
1.40 113 8.0.0 1.08 6.0.2 1.11 1.00 g
1.09 7.05 =
«
1.10 7.4.0 <
1.11 7.4.0 g
1.12 7.4.0 ]
1.13 8.0.0
1.43 1144 8.0.0 1.14 8.0.0 1.11 1.00

*1. NAS-JOOOOO-VA supports only Runtime Ver.1.08 or higher.

*2. The projects created in version 1.00 are converted to version 1.01.

*3. The projects created in either version 1.00 or 1.01 are converted to version 1.02.

*4. Projects created in version 1.00, 1.01, or 1.02 are converted to version 1.03.

*5. The runtime version will be converted to 1.04 if the HMI Extended Option is enabled.
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A-6 Precautions for Version Upgrades

Observe the following precautions for version upgrades.

® Sysmac Studio Version 1.14 and Runtime Version 1.03

+ User-defined enumerations on external devices are not assigned during version upgrades. You
must redefine them.

+ Some data type definition names are reserved for the data definitions of structures, unions, and
numerations on the HMI. An error will occur if a reserved name is used, in which case you must
change the name.

® Sysmac Studio Version 1.18 and Runtime Version 1.08

* The values of Retain variables are cleared when they are downloaded to NA Units with runtime
version 1.07 or lower. When downloading is completed, the NA Unit will be restarted and the
Retain variable area will be rebuilt, so approximately 10 seconds longer than for a normal restart
will be required. Do not turn OFF the power supply to the NA Unit while the Retain variable area is
being rebuilt.

® Sysmac Studio Version 1.27 and Runtime Version 1.11

« If you convert to Runtime Version 1.11, expansion of font settings may cause processing to take
10 minutes or longer, depending on the project size.
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